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Create document in REQEDIT

ReqEdit creates different types of requirement documents.
o New specification (.reqif)
You can create a new specification document withouth attachements.
o New specification with attachements (.reqifz)
You can create a new specification document with attachments, images, file attachments
based on ReqlF format from default or template. This option is recommended to use, vs

the simple reqif documents.

More about ReqlF formats read here.

ReqlF (.reqif) |ReqlF Archive (.reqifz)

No attachments | Can have attachments
CTRL+N CTRL+SHIFT+N

Create a new specification document
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Open specification Import files
Open a specfication in ReqlF or ReqlFz file format - Import specication documents from different file
and continue your work where you left off types (Rf11a, ReqlFs or Word documents)
Help document About

? Get help and read more how to use ReqEdit ] Get more info about ReqEdi this version
" functionalities

Show dashboard at startup

Cache size: 0MB

Dashboard

Create a new specification document:

e Click on the wanted option on the Dashboard or
e Open File menu/New... and choose the option you want to use
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File menu

New Archive

ReqlF Archive supports attaching external images or files to any requirement. Creating a
new archive will show a window asking for a filename.

Choose default template from the Template selector pop-up window.

A new file template appears.
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An overview of the user interface description, read here.

Adding new items

Now you can add rows, add columns (attributes) to your document.

To add rows click File/Edit/Insert new row ... or Insert new child row
To delete rows click File/Edit/Delete row

To add Column go to Settings/Document or use shortcut key F8

In the Document settings table use Attributes tab to add new or edit or delete columns.

Creation tool: ReqgEdit
Source Tool ReqEdit
Number of documents: 1
Conversation ID: Generate ID
Documents: ReqEdit document - 2022-01-21T13_44_20
Display as headina: Display as description: Display as text:
ReqlF ChapterName v~ No selection ~  ReqlF.Text

Attribute Types  Aftributes  Document  Links

Custom Data Type Last Change Is editable Description

! Long Name Type
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& ReqIFText Text XHTML 21.01.2022 &

~ Comment Text XHTML 21.01.2022 &
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& RegEditModifi... Date DATE 21.01.2022 =)

'€ RegEditModifi... String STRING 21.01.2022 & et Yoknk)
@,F{eg,lﬁ@fe,igr}:-,, Boolean BOOLEAN 21.01.2022 &}

New Edit Delete

Save Cancel

Document settings
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@ Attribute editor — O X
|

Referenced Attribute Type

Document ReqgEdit document - 2022-01-21T13_44_20 IDENTIFIER: _a82b6eb-14054927-
3 5 9250-7%e4c0a4604d

{UiSHPEs  Boolean LONG NAME: Boolean
LAST CHANGED: 21.01.2022
DESCRIPTION:

LongName TYPE: Boolean

Description

(] Read Only
= |dentifier:
Default value  TRUE
O
OK Cancel

Attribute editor

Note: You cannot edit a created attribute type after saving it.

More about attributes and attribute types read here.

Attachments

ReqlF Archive .reqifz files support having file attachments for objects.
Only XHTML attributes can have attachments inside .reqifz files
Image attachments: png, bmp, jpg, gif, ico, wmf,

File attachments: any file type is supported: pdf, doc, docx, xIs, xlIsx ...
Inserting file attachments

To add an attachment simply right click the XHTML inline editor area and select Insert
image or Insert file
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ReqEdit displaying attachment previews of an object, contains file icons and preview images

About editing an opened specification file read here.

Opening existing files, read here.
Quick start guide

1. Download RegEdit

Read how to download RegEdit trial and how to install and start it.

For the purchased product you get downloading and installing details by email from the
sales department.

2. Install RegEdit

First check the system requirements for the ReqEdit application.
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Run the Portable-Installer from the directory, you downloaded it. The Portable-Installer
guides you through the installing process.

For trial the activation happens automatically.

Read more on Install ReqEdit.

3. Activate RegEdit for purchased version

The License activator window appears. In the text box enter the Product key and press
the Activate button.

Note: You need to have non-restricted Internet acces, or need to configure the proxy
settings for it.

For overall view for activating methods, read here.

4. Run ReqEdit

For run use the desktop icon or start "reqgedit.exe” directly from the installation directory.

5. Use cases

Create document

Open document

Import IBM Rational DOORS®© RIF Files
Import MS Word to ReqlF

Import MS Excel to ReqlF

Print opened document

ReqlF requirements format

RIF/ReqlF (Requirements Interchange Format) is an XML file format suitable for lossless
exchange of requirements in any industry. The old way of transmitting requirements
were lossy like Office Documents, PDF or Spreadsheets, ReglF offers solutions to keep
the data integrity through the supply-chain.

It is used to exchange requirements, along with its associated metadata, between
software tools from different vendors. ReqlF keeps the data integrity of requirements,
attributes, additional files (e.g. images) through the supply-chain. ReqlF format also
defines a workflow for transmitting the status of requirements between partners. Each
object is uniquely identified by GUID (globally unique identifier inside a RIF / ReqlF file),
ensures unique content across the data exchange processes.

The interchange standard

Main players of the automotive industry in Germany agreed to conform to the RIF/ReqlF
joint standard, initially developed by HIS Group, ProSTEP iViP, now maintained by
OMG. (Object Management Group)
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History

In 2004, HIS (Herstellerinitiative Software) a consortium of German automotive
manufacturers, defined a generic requirements interchange format called RIF.

The format was handed over in 2008 to ProSTEP iViP e.V. for further maintenance. A
project group responsible for international standardization further developed the format
and handed over a revised version to Object Management Group (OMG) as "Request
for Comment" in 2010.

As the acronym RIF had an ambiguous meaning within the OMG, the new name ReqlF
was introduced to separate it from the W3C's Rule Interchange Format.

In April 2011, the version 1.0.1 of ReqlF was adopted by OMG as a formal specification
(OMG Document Number: formal/2011-04-02).

In October 2013, version 1.1 was published (OMG Document Number: formal/2013-10-
01). Changes are restricted to the text of the standard, the XML schema and underlying
model have not changed. Therefore, 1.1 and 1.0.1 .reqif files are equivalent.

In July 2016, version 1.2 was published (OMG Document Number: formal/2016-07-01).
Like with the previous versions, changes are restricted to the text of the standard, the
XML schema and underlying model have not changed. Therefore, 1.2, 1.1 and 1.0.1
.reqif files are equivalent.

Source: wikipedia.org

Naming conventions and structure of ReglF files

The Prostep iViP published a guide how to exchange with ReglF and an implementation
guide for ReqlF, where you can find detailed information how to use this file format and

also about the file structure, naming convention and interchange. To read about it, click

on the link:

Prostep iViP - ReglF Recommendation

We recommend to read the chapter 2, to get an overview about the common use cases
of ReqlF file exchange. Chapter 3 describes the custom attributes used in ReqlF,
and chapter 4 specifies the workflow of the SRC process.

Prostep iViP - ReglF Implementation Guide

For more technical details please look at the Prostep Implementation Guide. We
recommend to study the chapter 2.1-2.3 for an overview.

Install ReqEdit

System Requirements
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Microsoft Windows x64

.Net 4.7.2 runtime package

MS EDGE browser or Chrome (for Compare Add-on HTML report)

Operating systems

Tested

Windows 10 Pro x64

EDGE installed by
update

OS Version . . Limitations
configuration
. .Net 4.8
Windows 11 Pro x64 EDGE included
.Net 4.8/ 21H

Windows 8.1 x64
EOL 2023-01-10

.Net 4.8
EDGE manually
installed

X64
EOL 2023-10-10

IE11 installed by
update

Windows 7 Enterprise .Net 4.8
x64 EDGE installed
EOL 2020-01-14 manually
Windows Server 2022 .Net 4.8
Data Center x64 EDGE included
Windows Server 2019 .Net 4.8 on IE11 - HTML compare report,
Data Center x64 IE11 included some features are missing
Windows Server 2016 .Net 4.8 on IE11 - HTML compare report,
Data Center x64 IE11 included some features are missing
: .Net 4.8
Windows Server 2012 R2 IE10 included on IE11 - HTML compare report,

some features are missing

Windows compatibiltiy of ReqgEdit 2.17 (2021 Nov)

Installation

ReqEdit comes packaged into an installer that guides users through the install
procedure. It will unpack the files into a custom user directory.

Run the Installer




@ Setup - ReqEdit 2.20 Portable Installer — X

Information

Please read the following important information before continuing.

When you are ready to continue with Setup, click Next.
[ReqEdit Installer N ‘
For the license agreement please read

[https://documentcloud.adobe.com/link/track?uri=urn:aaid:scds:US:8f17d00c-
cd02-4934-9ceb-25a821b5d90f]

Our documentation platform
https://documentation.reqteam.com/

If you have trouble installing the software,
submit a support ticket here [https://support.reqteam.com/]

Thank you for using our product,
REQTEAM GmbH

Adsme_l nhmann_Chr CA

Next Cancel

Window Install ReqEdit

Run the provided installer executable and go through the steps, default install path is the
user profile folder in windows.

On the last step of the installer you can choose to activate the license. For that check
the checkbox.



Completing the ReqEdit Setup
Wizard

Setup has finished installing RegEdit on your computer. The
application may be launched by selecting the installed
shortcuts.

Click Finish to exit Setup.

Start LicenseActivation.exe after finishing installation, if
@ license can be activated automatically, ReqEdit will be
started

Window Start Activation Setup

Licensing Models
After installation follow your model of licensing. More about licensing read here.
Downgrade functionality for ReqEdit Premium

More information about downgrading functionality read here.
User Interface

Overview

The look and feel of the application is similar to any classic Windows application. It has a
main menu at the top, function icon groups that can be rearranged, main content area
and a status bar at the bottom.

At first run a quick action dashboard is shown.
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ReqEdit start screen showing the dashboard

After opening a ReqlF file, the contents will be shown in the main user interface. If the
ReqlF contains multiple specifications it will be displayed as color coded tabs.

Q) Kaffeeautomat_2.reqf /Kaffecautomat_Views_exported_jmported.reqifz - ReqEdit Client Premium
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5 - Project Issues requirements process, requirements training, requirements
consultancy, reguirements audits, a variety of downloadable
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provide requirements specification-writing services.

The first edition of the Volere Requirements Speification Template
was released in 1995. Since then, organizations from all over the
world have saved time and money by using the template as the
basis for discovering, organizing, and communicating their
requirements.

The Volere web site www.volere.co.uk contains articles about the
Volere techniques, experiences of Volere users and case studies,
requirements tools
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ReqEdit showing a ReqlF file, from left to right: navigator panel, requirements and auto-backup panel

Specification tabs




Opening a ReqlF file will display all the specifications as tabs. Same color tabs are from
a single ReqlF or ReqlF Archive file. The specification title is displayed as the tab title.

B & | v B O Co | 8l ~ o (=8
® User Requirements - Kaffeeau... x l. Specification Document - Kaff... X ] ® Use Cases - Kaffeeautomat_2... X ]

a .
Main Crlirmn

RegEdit displaying specifications inside a Req|F file in color coded tabs

Keeping the mouse over a tab will display more info of the specification like: file location,
document id, and so on.

Closing opened files

Close any tab by pressing the X of the tab or by pressing CTRL+W , if there are any
unsaved changes a popup will ask to save the specification.

Closing all opened specifications of a ReqlF file by accessing File > Close All or by

pressing CTRL+SHIFT+W, if there are any unsaved changes a popup will ask for
confirmation.

Navigator

Specification headlines are shown as a tree menu on the left panel. Numbering is added
automatically to aid navigation. Clicking on the items will jump to the same requirement
in the content area.

Show / Hide Navigator

Navigator can be toggled by clicking the pin icon.
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RegEdit navigator pane on the left showing requirements hierarchy as a tree menu

Requirement Numbering

Requirements with (ReqglF.ChapterName) headlines are shown in a tree menu structure,
numbered by the position in the hierarchy. The numbering is automatically updated on
each change of the requirements, new additions or deletions will affect this.

The levels of the menu represents sub items in the spec hierarchy. This is visible in the
content as sub numbering of a main headline, all the content remains on a single level in
the table.
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ReqEdit displaying a specification where the same requirement is selected in the navigator and the content area

Content

Requirements are shown in the middle as a table, where the Main Column is a multi
content field and the other columns are the associated metadata.

The Object menu (Right-click)
Right clicking any object (row) in the content area, displays the context menu. Contains
editing functions like: creating, cut-copy-pasting, deleting, restoring, purging objects.

Hierarchical editing si possible by promote / demote menu items.

Manage relations between objects by the lower menu items: Add, Edit, Delete link or Go
to link targets.

Get the object ReqlF ID using the Copy ReqlF ID menu item.
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Main Column

Main Column is the most important content of the specification. It has the default value
of the combination

of headline (ReglF.ChapterName), description (ReqlF.Name), xhtml

content (ReqlF.text). If all there attributes are present it will be displayed together in the
same cell and the headline will have a number assigned to it.

The Main column content can be customized in the Document Settings panel



Main Column ObjectType

based on Volere
Requirements Specification Template Edition 15—March 2010 Info
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consultancy, requirements audits, a variety of downloadable guides and articles, and this requirements template. We also
provide requirements specification-writing services.

The first edition of the Volere Requirements Specification Template was released in 1995. Since then, organizations from all Info
over the world have saved time and money by using the template as the basis for discovering, organizing, and
communicating their requirements.

The Volere web site www.volere.co.uk contains articles about the Volere techniques, experiences of Volere users and case
studies, requirements tools

1 - Project Drivers

Heading

1.1 - The Purpose of the Project

Heading

ReqEdit displaying a ReqlF file, main column is visible, highlighted is the column separator and a row separator

Resizing columns or rows

Drag the column header separator bars or the row separator bars to resize the grid.
Content editing

Double clicking on any object will enable the inline editor and activate the text formatting
icon group. Right clicking the content will show a menu for adding attachments or tables

and formatting the content.

To leave the inline editing click anywhere outside the yellow background.

Re
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RegEdit text content editor, icon group and right click menu

Managing columns

Right clicking the column headers will display a menu, where the selected column or the
other columns can be toggled visible or hidden.

If all the columns are hidden the View manager can reset the visibility back to a
predefined state.
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RegEdit colum management by right clicking the column header row

Views

Views are visible column sets with optional custom sorting and filtering saved as presets.
The view manager is located in the icon groups on the right side. The views are only for
displaying the ReqlF contents in a more human friendly manner for large files with lots of
metadata.

The view presets are not stored in a ReqlF file, they can be exported and later
imported from the local hard drive.
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ReqEdit displaying the view manager popup window



Backups

ReqEdit offers an auto-backup feature which will create a snapshot of the current state
of the opened files. Default setting is to create a backup every 10 minutes and rotating
10 backup files (the last will be deleted to have a max of 10 backups).

The backup settings can be changed in the User Settings panel

Show / Hide Backups

Backups can be toggled by clicking the pin icon in the title of the panel

Q Kaff _2.reqif/Kaff _2.reqifz” - ReqEdit Client Uimate = (a] X

File Edit View Settings Add-ons Help

BB &0> iR e B 8- = 3 &5 5] | Views: [All attributes (System) |7] -9 Fid 9 Fad

]
@ User Reguirements - Kaffeaau...*x |. Specification Document - Kaff.., X | @ Use Cases - Kaffeeautomat_2.., X |

# Main Column %
based on VolereRequirements Spec..
i 3 Backup History
Volere is the result of many yea.. = -
-1 - Project Drivers 3 - Functional Requirements Bockup date: 04012022 10:28:25
- 2 - Project Constraints Fie name: Kaffesautomat_2 ook
= 3 - Functional Requirements Backup date: 04.01.2022 10:18:25
3.1 - The Scope of the Work File name: Kaffeeautomat_2 reqifz
3.2 - Business Data Model Data Dicti... 3- 1 X The scope of the work

Backup date: 04.01.2022 10:08:25

.3-The S f the Pi
3.3 e Scope of the Product File name: Kaffeesutomat _2 reqifz

= 3.4 - Functional Requirements

2 o Backup date: 04.01.2022 10-08:24
3.2 - Business Data Model & Data Dictiona e rame: Kafaom ot 2wz

Backup date: 04.01.2022 10.08:23
File name: Kaffeeautomat _2 reqifz

Backup date: 22.12.2021 12:49:18
3.3 - The Scope of the Product ko otin

Backup date: 22.12.2021 12:49:17
Fiie name: Kaffesautomat _2 reqifz
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# 4 - Non-functional Requirements
= 5 - Project Issues

Backup date: 22.12.2021 12:42:38
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Backup History
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Cache size: 3473MB | HTML Validation: Off

ReqEdit displaying a ReqlF file, highlighted is the auto-backup panel

Menus

File



File | Edit View Settings Add-on:
New » F
= Open... CTRL+ O

Open recent files »

Add » M

v

ave CTRL+ S
Save As.. CTRL+SHIFT+S
Save As Template...

1 5

o

Clone

Import...
Export...

Close CTRL+ W
Close All CTRL + SHIFT+ W

Print »

Print Setup...

@ Connect..
| CheckOut...
Check In...

Exit ALT + F4

ReqEdit File menu

New

Create a new ReglF file .reqif (New File) or an archive with attachments as .reqifz.
(New Archive)

ReqlF Archive supports attaching external images or files to any requirement. Creating a
new archive will show a window asking for a filename.

ReqlF (.reqif)

No attachments
CTRL+N

ReqlF Archive (.reqifz)
Can have attachments

CTRL+SHIFT+N



A template list will popup will ask for a specific template to use for the new file. For more
information on templates, please read the Templates section.

) Template selector x

Please select template:

Mame Type
Default template Simple
prostep ivip - All attributes Simple
prostep ivip - simple Simple
prostep ivip - with Product variant Simple
prostep ivip - with Revision Simple
Scrum - Backlog Simple
Scrum - Buglist Simple
Crrim - Taot Simmnla

Template selector window

Open

By default, only xml, rif, reqif, zip, reqifz and RegEdit encrypted files can be selected

File name: ‘ vl RIF, ReqlF, Zip or ReqlFz files (*.rif, *.reqif, *xml, *.reqifz, *.zip, *.reqenc, *.reqzip)

RIF, ReqlF, Zip or ReqlFz files (*.rif, *.reqif, *.xml, *.reqifz, *.zip, *.reqenc, *.reqzip)
ReqlF files (*.reqif, *xml)

RIF files (*.rif, *xml, *.zip)

Archive ReglF files (*.reqifz, *.zip)

Supported file types by ReqEdit

Add new document to current file

Adds a new specification document to the currently active ReqlF file. Use this to add
more than one specification to a single file.

Save
Any change in the specifications will be displayed with asterisk * in the tab.
Changes to linked documents (e.g. Images or Word, Excel) will not be detected by

the editor, a change needs to be made in the requirements in order to be able to
Save



Save

Save the currently active file to disk
CTRL+S

Save As

Save the active file under a new name
Keep all UUIDs

CTRL+SHIFT+S

Save As for saving encrypted file

To encrypt a file choose ReqEdit Encrypted File (*reqenc, *.reqzip) as file type then
click SAVE.

File name: ‘ Test document Specifications_imported.reqenc v ’

Save as type: |ReqEdit Encrypted File (*.reqenc, *.reqzip) ~

Archive ReglF files (*.reqifz, *.zip)
ReqEdit Encrypted File (*.reqenc, *.reqzip)

~ Hide Folders

More about encryption of a file read here: RegEdit File Encryption/Decryption

Save as template

Single document ReqlF files can be saved as a template and reused later
Close

Opened specifications can be hidden by clicking the X in the tab bar, if there are
unsaved changes a popup will ask for confirmation. This is not removing the
specification from the file.

Close All

Close all opened specifications, any unsaved change will notify the user. It will close all
opened files.

Import
Start an import wizard for Reqlf 1.0.1 files

Export


https://documentation.reqteam.com/?p=3653

Start an export wizard from ReqlF 1.0.1 to ReqlF compatibility mode or RIF 1.1/ RIF
1.1a arhive format.

Print

Print the current specification Main Column or all visible columns.
Connect

Requires RegEdit file server

Will authenticate the current user and create a connection
Check out

Requires RegEdit file server

Lock the file and download for editing (other users that have permission to the same file
cannot download it)

Check in
Requires RegEdit file server

Upload a file to the server. If the file was previously locked by the user it will become
unlocked and can be edited by others as well.

Edit


https://documentation.reqteam.com/?p=2386

Edit | View Settings Add-ons Help

!'._J Copy row Alt+C

# Cutrow Alt+X ‘
Paste row » P
Insert new row »

$&  Insert new childrow Ctrl+Alt+N
Delete row

Restore soft deleted object
Purge selected object
Purge all objects

Insert table...

Insert »
Delete »

Find CTRL+ F
Replace CTRL + H

=]

L

Promote

i

Demote

ReqEdit Edit menu

Editing objects and contents
Object / Requirement level editing
Create before, after

Create child

Promote, demote

Delete (soft delete)

Restore deleted (soft deleted)
Purge (hard delete)
Cut/Copy/Paste

Content level editing

Table editing

Find



Replace

View

View | Settings Add-ons Help
@ Deletesorting CTRL+D

Filter » k
View definitions »

TJ Hide navigator
[=| Hide deleted rows

Show dashboard

ReqEdit View menu

Attributes (columns) related
Filtering

ReqEdit can show a sub-set of the requirements based on special conditions of the
attributes. Filters can be set and reset. Filters will not be saved inside ReqlF files.

Sorting

ReqEdit can sort the requirements based on multiple columns. It can be configured and
then reset. The sorting is not saved inside the ReqlF file.

Show/Hide deleted requirement objects

Soft deleted objects will be marked for deletion but are not removed from a specification
until PURGE is not pressed. The deleted objects can be shown or hidden

View definitions (views)

Views are a sub-set of the attributes that are displayed. The views are not saved
inside the ReqlF. file Views can be exported and later imported.

The views can be imported and used on any specification as long as there are attributes
with similar names.

Settings

Settings | Add-ons Help

1 Document... F8

¢ Server...

User...




ReqEdit settings menu

Expert users can fine tune ReqEdit for their specific use case, and configure lots of
ReglF settings

Document settings

Manage ReqlF file internal settings
Attribute Types

Attributes

Document attributes

Links

Configure Main Column display settings
Server settings

RegEdit file server connection settings
Server user credentials

User settings

ReqEdit internal configuration
Interface language

Auto backup settings

Doors table display settings

Cache size

Dashboard startup

Add-ons



~ Add-ons | Help
ReqEdit License Detach...
ReqEdit XML editor... F6
Excel Add On
Compare/Merge Tool

Direct compare

Weak Word Analysis
ReqEdit Add-ons menu

Displays all available add-ons which are active in the current license. Descriptions
below.

Help

[ Help l
Help contents...  F1
License info... F2
ShortCuts F9

Check for update F3

¢ About ReqEdit... r

o crrrorTeor

RegEdit Help menu

Contains a user guide. Can display Information about the active license. Display
keyboard shortcuts. Check for online updates. Display version information about the
current ReqEdit release.

Add-ons
ReqEdit Ultimate comes with powerful addons that extends the base functionality.
Xml Editor

Look inside ReqlF files and check the xml code. The editor comes with a built in ReqlF
validation function that will debug any invalid code. Read more here.

Excel importer

Turn your excel files into ReqlF files. Data exchange is more realiable and lossless if
ReqlF is used. Read more here.

Compare / Merge tool


https://documentation.reqteam.com/xml-editor-add-on/
https://documentation.reqteam.com/excel-importer-add-on/

Will generate a comparison report that can be handed out as a signle html file. Read
more here.

Weak-word Analysis

Weak words are words that are confusing for readers and should be avoided if possible.
This tool provides a case insensitive whole word search for this purpose, optionally
writing the results back in the ReqlF file. Read more here.

License Detach tool

Take ReqEdit out of the licensing environment. This power feature will enable users not
to depend on the local licensing servers and to be able to work from anywhere. Read
more here.

Expert knowledge
Tab title configuration

ReqEdit exposes some settings that can be configured for the tabs. The configuration
file is located in AppData\Local\REQTEAM\ReqEdit\ReqEditSettings.xml

Setting Values Notes

TabDocumentTextAlign | Left, Right | Alignment of document title in the tab
TabDocumentWidth 250px width of the tabs in pixels

Keyboard shortcuts

Ctrl+O Open file

Ctrl+N New file

Ctrl+S Save file
Ctrl+Shift+S |Save as

Ctrl+W Close file
Ctrl+Shift+W | Close all file

Alt+F4 Close application
Ctrl+D Delete Sorting
Ctrli+F Find text

Ctrl+H Replace text

Ctrl+E Add new or edit filter
Ctrl+A Deactivate filter
Ctrl+Q Delete filter

Alt+N Add new object below



https://documentation.reqteam.com/merge-compare-add-on/
https://documentation.reqteam.com/weak-word-analysis-add-on/
https://documentation.reqteam.com/license-detach-utility/

Alt+Shift+N [ Add new child object

Ctri+Tab Switch between open tabs

Ctrl+C Copy text information inside the cell
Ctrl+X Cut text information inside the cell
Ctrl+Vv Paste text (remove all formatings)

Ctrl+Alt+S | Start link
Ctrl+Alt+E  [End link
Ctrl+Alt+R  [Reset start link
Ctrl+Alt+R  [Reset start link

F1 Open help

F2 Open selected cell in edit mode
F3 Check for update

F5 License information

F6 XML Editor

F8 Document settings

F9 Shortcut window

Open ReglF requirement files

ReqEdit is used to display contents of ReqlF requirement exchange files including
attachments and images in ReqlF Archive files.

These are the key features:

ReqlF requirement objects
hierarchy structure

Internal UUIDS

attribute types

specification attributes

object attributes and relations

For experienced users the XML Editor add-on can display the source code of the ReqlF
file.

Supported RIF/ReqlF file extensions: RIF contents (.xml .rif .zip) or ReglF
content (.reqif .reqifz)

You can open decrypted *.reqgedit files too, if you know the password. More about
encryption / decryption read here.

More about RIF and ReqlF files read here.

Open file


https://documentation.reqteam.com/?p=3653&preview=true
https://documentation.reqteam.com/reqif-requirements-format/

@ RegEdit Client Premium - o X
File Edit View Settings Add-ons Help

gD BRSJUM BN EEE EEE E- STR I EE 8% E|EE| Views B
ReqEdt Dashboard x
New Specification New Specification with attachments
:E You can create a new specification document = Create a new specification with mages or fie
—@ without attachments. @ attachments based on the ReqlF format from
defaut or custom template.
Open specification Import files
B Open a specfication in ReqlF or ReqlFz file fomat _.;_‘: Import specification documents from diferent file
and continue your work where you left off. = types (R€11a, ReqlFs or Word documents).

Help document About
@ Get help and read more how to use ReqEdit @ Get more info sbout ReqEdi this version.
functionaities.

Show dashboard at startup

Cache size: 0MB

Dashboard for ReqEdit

To open a file

e click on the Open Specification on the Dashboard or
o select File > Open on the main menu or
e press CTRL+O and then select the ReqIF file.

Q« :_2.reqif /K t_Views.reqifz - ReqEdit Client Premium o [m] X
File Edit View Settings Add-ons Help
g AR s BOEEEE EEEE- ST HG =) - o | B D @ @ @ Bal |[E [F ) views Allattributes (System) - Cd B
® User Requirements - Kaffeeau... x I. Specification Document - Kaff... X | ® Use Cases - Kaffeeautomat_2... X |
- = Main Column Comment -~ &
- based on VolereRequirements Spec... -
§ P— o Backup History
i Volere is the result of many yea... based on Volere -
&1 - Project Drivers Regquirements Specification Template Edition 15—March 2010 Backup date: 03.08.2021 11:16:03
i@ 2 - Project Constraints File name: Kaffeeattomat_Views reqfz
i ~ < 1D: a5fBd244-caf6-45aa-a493- 5 Icadafad3l
&#- 3 - Functional Requirements Volere is the result of many years of practice, consulting, and
o £ - ; research in requirements engineering and business analysis. We
@ 4 - Non-functional Requirements have packaged our experience in the form of a generic requirements
@5 - Project Issues process, requirements training, requirements consultancy,
requirements audits, a variety of downloadable guides and articles,
and this requirements template. We also provide requirements
specification-writing services.
The first edition of the Volere Requirements Specification Template
was released in 1995. Since then, organizations from all over the
world have saved time and money by using the template as the
basis for discovering, organizing, and communicating their
requirements.
The Volere web site www.volere.co.uk contains articles about the
Volere techniques, experiences of Volere users and case studies,
requirements tools
- -
1 - Project Drivers
1 1 _ Tha Durnnca anf tha
< > < |
Cache size: 4.99 MB

ReqEdit displaying an opened ReqlF file




All containing specification documents are displayed as tabs in the tab bar.

RN A ANEY B [T Ca 8] : 8 - o |1 |1
® User Requirements - Kaffeeau... x l. Specification Docurnent - Kaff... x] ® Use Cases - Kaffeeautormat_2... x]

N Main Calirmn
ReqEdit tab bar showing a ReqlIF with three specifications

Compatible ReqlF files

If the file is not a standard ReqlF file but RegEdit can import it, a popup notifies the user.
Import wizard starts and completes the steps to open file.

Question X

This file was not edited in RegEdit! Please, import the file before you
open it!

Do you want to import the file?

fes Mo

ReqEdit found an invalid ReqlF but asks the user for importing the file

Multi ReqglF Archives

If the opened document contains multiple ReqlF files (is an archive format .reqifz or .zip)
a popup notification allows the user to select the files to open.



€ Document selector >

Please select which files you want to open from the ZIP file:

o File name

B Functional Requirements.reqif

[ ] Legal Requirements.reqgif

Cancel

ReqgEdit showing document selector for .zip or .reqifz files (containing two or more ReqIF files)

In case of any ReglF errors, RegEdit identifies the errors. Use XML Editor Add-on to
correct.

An emor occumed while opening the tanget file!

4 Hide details
ot match the end tag of xhtmlp’. Line 9, position 705.

L4 >

Ej Copy to clipboard

OK

Error message shows ReqEdit detected an invalid ReqlF source code

ReqlF file format



RegEdit follows ReqlF standard on all levels. It will display contents of ReqlIF files from
structural to attribute definitions.

ReqlF format

Attribute Types
atomic data types: boolean, date, enumeration, int, float, string, xhtml

Attributes
uses the basic attribute type definitions with optional restrictions: min, max, length, can
be defined for objects and specifications also

Object types
collection of attribute types that are grouped together

Objects
uses a specific object type and has values for each attribute

Values
value objects for attributes of objects or specifications

Specification Types
a collection of object types and specification attributes

Specifications
uses a single specification type

Hierarchy
requirement object structure inside a specification

Relations
links between the objects

Documents

ReqlF requirements are grouped into specification documents, these are displayed in
the tab bar. Each opened ReqlF file will have its own random color to indicate that the
files are together.

& L ® FLCe ||| 8~ o |12 | 8
® User Requirements - Kaffeeau... x l. Specification Docurmnent - Kaff... X | @ Use Cases - Kaffeeautormat_2... X]

? Main Caliirmn
ReqEdit tab bar showing colored dots in front of specifications that are contained in a single opened file

Hierarchy

Each specification document has its own object structure which is shown in the navigator
tab.


https://documentation.reqteam.com/reqif-requirements-format/

File Edit View Settings Add-ons Help

B & L - i@ OB - ol @ @ Fa |[E Views:
@ User Requirements - Kaffeeau... x I. Specification Document - Kaff... X | @ Use Cases - Kaffeeautomat_2... X l
a

Main Column
based on VolereRequirements Spec...

Volere is the result of many yea...
#-1 - Project Drivers
#- 2 - Project Constraints
=- 3 - Functional Requirements
3.1 - The Scope of the Work

3.2 - Business Data Model Data Dicti...
: 3.3 - The Scope of the Product

3.3 - The Scope of the Product

3.4 - Functional Requirements

-I- 3.4 - Functional Requirements

2 : : ;
This device must accept banknote... & This device must accept banknotes till 10 eur
It shall be possible to bring a ...
~ The system shall be able to spen..
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- File: pinguin.pngThe system shal...
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Thecareesnoulid be reshlydto & The system shall be able to spend fresh milk
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#- 4 - Non-functional Requirements P :
. The systems shall be able to spend H-Milch
#- 5 - Project Issues
< > <

Q Kaffeeautomat_2.reqif/Kaffeeautomat_Views.reqifz - ReqEdit Client - m]

Cache size: 48.17 MB HTML Validation: Off

ReqEdit displaying an opened ReqlF file, navigator on the left side is highlighted

The navigator can be used to quickly jump to a specific section in the specification
document.

Numbering

Automatically generated for each ReglF.ChapterName which are used as headlines.
Depth is determined by child objects.

Objects

Each row in the main content area is an object that has a Main Content and additional
attributes. Objects are displayed as follows




Q Kaffeeautomat_2.reqif/Kaffeeautomat_Views.reqifz* - ReqEdit Client - m]
File Edit View Settings Add-ons Help
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& |2 Views:

&

; Main Column
based on VolereRequirements Spec...
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#- 2 - Project Constraints

= 3 - Functional Requirements

3.1 - The Scope of the Work

3.2 - Business Data Model Data Dicti...

3.3 - The Scope of the Product

3.4 - Functional Requirements

= 3.4 - Functional Requirements
Analysis of MVP and other factors of project
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This device must accept banknote... 62
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Cache size: 51.34 MB HTML Validation: Off

ReqEdit displaying different types of requirement object states from top to bottom:
not changed (white), edited and saved (blue), new not saved (green), deleted (red), with links (link icon, in, out, external)

Status indicator

First column of the grid is a frozen column, which means that the user will always see
the column, even if the document will be scrolled horizontally.

Displays the following states:

e unchanged — marked with white color
o edited — marked with light green
» edited and saved — marked with light blue
e links - marked with link icon
o internal links
o external links
= URI/OSLC
= Inward / Outward
red - soft deleted (can be recovered)

More about Editing objects you can read here.

Attachments


https://documentation.reqteam.com/edit-reqif-requirement-files/#Objects

1 - Project Drivers

Heading

1.1 - The Purpose of the Project
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ReqEdit displaying attachment previews of an object, file icons and preview images

Double-click on the icon. The attached file will be opened by the installed applications on
the machine.

Attributes

Object attributes are displayed as columns inside the data grid. The default column
layout starts with Main Column then the rest of the object attributes defined in the
specification.

By default all attributes are displayed in the specification as texts

Main Column

Displays the the main ReqlF attributes: ReqlF.ChapterName, ReqlF.Name, ReqlF.Text
as a single cell where

ReqlF.ChapterName - is displayed as Headline and will be auto numbered, displayed in
the navigator

ReqlF.Name - displayed in the content area as text

ReqlF.Text - displayed in the content area as text

The main column rendering can be customized in the Settings > Document menu
Attribute columns

All columns can be set hidden / visible by right clicking on the column name row.



- e —— —_—

ification Document - Kaff... X I @® Use Cases - Kaffeeautomat_2... X

Main Column

3.3 - The Scope of the Product

3.4 - Functional Requirements

Analysis of MVP and other factors of project

This device must accept banknotes till 10 eur
It shall be possible to bring a foreign coffee cup (0.251) with

The system shall be able to spend fresh milk

ReqgEdit column management menu displayed by right clicking anywhere on column names

1% Sort Ascending sommere
LE  Sort Descending
Hide
Mass update..
Columns D
&7 Main Column
«” Comment
&/ ObjectType
@« Requirement Type
&’ Rationale
& Fit Criterion

ReqlF.ForeignDeleted

Attributes used in the current specification document can be displayed by opening

Setting > Document and selecting the Attributes tab.
Related topics:

« Filtering and sorting
¢ Views

Edit ReqlF requirement files

https://youtu.be/La-70CBGDno

ReqEdit presentation video

Why ReqlF files?

Requirement Interchange Format is the de facto standard for lossless requirement data

exchange for any industry.

ReqlF simplifies the workflow of requirements exchange between suppliers and

vendors in all industries. Mainly driven by the automotive industry.

ReqgEdit was built from the ground up to aid the participants of the supply-chain to
quickly use ReqlF files without the need for complex ALM/PLM software solutions. This
is becoming more important with the digital transformation in more and more industries.

ReqlF based interchange offers seamless integration of supply chains in all industries

making collaboration more standardized and efficient.



https://documentation.reqteam.com/filtering-searching-and-sorting/
https://documentation.reqteam.com/view-manager/

RegEdit is an easy tool for ReqlF editing. Creating, comparing and merging
requirements and specification documents with powerfull add-ons.

Large companies rely on lossless data exchange
ReqglF format simplifies and streamlines the data exchange of requirements between
companies or departments and also on the management level. ReqEdit has multiple

licensing models to support corporate environments and use cases.

Medium or small size companies needs cost effective solutions to participate in
the supply-chain

ReqEdit is available as a standalone application. No other dependency is required. Cost
effective solution for processing ReqlF requirement files.

ReqlF file structure

ReqEdit follows ReqlF standard on all levels. It will display contents of ReqlF files from
structural to attribute definitions. More details you can find here.

ReqlF format

Attribute Types
atomic data types: boolean, date, enumeration, int, float, string, xhtml

Attributes
uses the basic attribute type definitions with optional restrictions: min, max, length, can
be defined for objects and specifications also

Object types
collection of attribute types that are grouped together

Objects
uses a specific object type and has values for each attribute

Values
value objects for attributes of objects or specifications

Specification Types
a collection of object types and specification attributes

Specifications
uses a single specification type

Hierarchy
requirement object structure inside a specification

Relations
links between the objects

Edit Objects


https://documentation.reqteam.com/reqif-requirements-format/

Double click on a cell to edit the content. An inline editor appears for XHTML attributes.
For other data types appear corresponding checkboxes or date pickers or single inputs.

To close inline editing click on any other cell.

The user can set the height of the main column: check the box in Settings / User ... /
Calculate only main column row height.

Use the quick action icons or the right-click menu for text formatting and XHTML content
editing.
The following shortcuts for editing can be used:

CTRL+B bold

CTRL+I italic

CTRL+U underline
CTRL+SHIFT+U strikethrough

Heading v

<EMPTY>
Reguirement
O

Comment
Info

Single valued enumeration will show a dropdown selector

[] Simple
Complex

[] Multi domain
[] Functional
[] Restriction

Chlmmem

Multivalued enumeration attributes are displayed as a list of checkboxes

[& &/ 3/2021 | @~

4 August 2021 4
Mon Tue Wed Thu Fri Sat Sun
26 27 28 29 30 3 1
2 4. 5. & 7 B8
9 10 11 12 13 14 15
16 17 18 19 20 21 22
23 24 25 26 27 28 29
30 3N 1 2 3 4 5
| Today: 8/3/2021

Dates will show a datepicker



string|

String types editing as simple text

Applicable F

O

Boolean values editing as checkboxes

Test cases I

11110 .

Integer and float types will only store numerical values

Insert rows

New rows can be created on the same level or as children to the current row.

For inserting a new row at the same level of the current row, right-click on a cell and

choose where to insert it. A new generic object is displayed as an empty line or with
default values.



Each spec object in ReqEdit has the same attributes (columns) in a document. Different
object types are not supported in a single document.

Insert child row creates a new row in the table, below the selected line. It is a child in the
tree hierarchy. A new empty line will appear. In case it is edited it will look like this:

EREEE | ¢ | @ [t
ent ReqlIF-WF.Type LastChane
[] Copyrow
o Cutrow
Paste row >

|| CopyReqlFID

Insert row before

Insert row after

Insert child row

=k Mark row as deleted
Restore soft deleted object )7.04.

Purge selected object
Set default value

Promote

il
LU

Demote

Expand IBM DOORS Table

G2 Addlink >
Add external link... 7.04.
Edit external links...
C:? Delete link...
C‘? Go to links
Irormauor” 4.6.04.

ReqgEdit displaying context menu, highlighted are the insert object menu items and the top quick action icons

Delete rows
RegEdit uses soft-deletions, delete will not remove objects from the ReqlF file.

Delete the selected row(s) by



e selecting the row(s) and pressing DEL or
e right-click menu or
o the quick action icons.

ReqIF-WF.Type LastChange

' [[] Copy row
f»  Cutrow
Paste row

(] CopyReqlFID

Insert row before

Insert row after

& Insert child row

Mark row as deleted

Purge selected object
Set default value

|¥2|  Promote

Demote

Fxnand IRM NDOORS Tahle

2022

ReqEdit displaying context menu, highlighted are the delete menu items

To confirm Delete action click Yes in the pop up window which appears next.

This function places the removed row(s) into a deleted state.

FHE Curt view  Jtwings

gl AR fLSE

Auu-uns  nEp

BTEIER Bl - o

B &

User Requirements - Kaffeeau...*x |. Specification Document - Kaff... X I @ Use Cases - Kaffeeautomat_2... X |

Views: All attributes (System)

based on VolereRequirements Spec... ‘

Main Column

~Volere is the result of many yea...
1 - Project Drivers
= 1.1 - The Purpose of the Project

: The coffee machine at the airpor...
(- 1.2 - The Stakeholders

=+ 2 - Project Constraints

£ 2.1 - Mandated Constraints

The water pressure shall be max....
The power connector fits to germ...
The coffee machine is always nex...
The machines are in front and be...
The operating hours of the airpo...
Access to the machine is possibl...

A LAN port can be set

B- The Machine shall be in a room

The temperature is at least 15 °...

ReqEdit displaying deleted rows with red status indicator, highlighted is the Show deleted objects icon in the top bar

The power connector fits to german standards

The coffee machine is always next to a snack bar of the airport operator for electricity and water connection

The machines are in front and behind the Security and in the canteens

The operating hours of the airport are 6-23 clock

Access to the machine is possible only during the operating hours

A LAN port can be set



Restoring deleted rows

To restore a deleted row select it and click on the ,Restore deleted rows” button from the
toolbar or right-click on the object and select the Restore menu item. It is possible to
restore multiple deleted rows.

PURGE (definitive deletion) of deleted objects

Use PURGE to remove objects, marked as deleted, with all attachments from a ReqlF
file. Purge function is on the delete toolbars and right-click menus.

Once purged, objects cannot be recovered. Auto-backup feature will have 10 snapshots
for recovery.

To clean up deleted rows:

e purge asingle deleted row or
e purge all the deleted rows in the entire specification document.

Copy and move rows

Use cut-copy-paste of existing row to create new one. Right-click the desired location
and paste the copied object before / after or as a child row of another row.

If a copied row contains links, on paste, a notification asks what to do with the
existing links.

If the row has child elements, these will also be copied or moved.
Copy-paste in the Navigator
Use right-click menu in the object navigator to copy-paste objects/rows.

If an object contains links to or from other objects, the links are copied too. A pop up
window asks for copying the links or not.

Navigator drag-and-drop

Use drag-and-drop to move objects

Object can be created by CTRL+Drag and release at the desired location
Editing Hierarchy

To change the hierarchy of objects use the promote and demote functions. They are in
the quick action icons, and in right-click context menus.
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Promote / demote objects with right-click menu

Promoting

Will move the object one level up in the hierarchy. If using the drag-and-drop way for
promoting, an object/ row can be moved more levels up or down.

Demoting
Move the object one level down as children in the hierarchy.

Promote or demote a parent object include promote or demote the object together with
its child objects.

Main column

Main column is a combined cell displaying the most important ReqlF attributes:
ReglF.ChapterName, ReqlF.Name, ReqlF.Text

In this cell, the main fields of the document can be edited at once. These fields are
XHTML type attributes.

Double click the main column of an object displays an inline XHML editor with 3 tabs.
One tab for each attribute.
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New features in RegEdit v 2.21
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Copy
t Cut
) Paste
Insert image...
Insert file...

1_3 Insert table...
Insert »

Delete »

Bold

Italic
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Underline

¢t

Strikethrough
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1.1 - Purpose

Superscript

td

Subscript

1.2 - Goals

y 7

HTML Source

2 - Project constrains _

3 - Management

Cell content editor using buttons or mouse right-click

The cell content editing menu Copy/Cut/Paste function refers to copy/cut/paste texts and
pictures from the same document and external documents, too. (word file, excel
spreadsheet cells, screenshots, images). The function converts external data format into
ReqlF supported one. (text formatting doesn't see, image cannot be downloaded). File
format must be ReqlFz to be able to save the images, as attachments.

Note: Depending on corporate internet access, downloading copied images could be
prevented by firewalls. RegEdit will remove some formatings due to limitations of
XHTML inside of the ReqlF format.

Copy-Cut-Paste the text of cells of the same ReqlFz file has no limitations regarding the
possibilities shown in the right click menu. (Bold, underline, italic, strikethrough,
subscript, superscript)



Copy-Cut-Paste of tables is with visible borders of cells. ReqEdit will add automatically
borders to tables, even there was no set one before.

Note for experts with HTML knowledge: The HTML Source (experimental) menu item
allows to edit and change the HTML source code of content of a cell.

Limitations on content editing Copy-Cut-Paste function:

o Cell formatting settings in Excel spreadsheet

o Attached objects from Wordpad (RTF documents)

e Images can be copy-paste only in ReqlFz files

o If the image/attachment cannot be copied, only file name of the preview images
are displayed.

Recommendation: Before copy-cut content from an external source, save file to have a
backup copy if the copied content is ReqlF invalid.

Properties

Properties menu gives informations about the attachments / inserted files in main
column cells. Right click on the inserted file, Properties

Heading 1
Heading 2
@ Attachment properties
Heading 3 File name:
_0f31f5d-dced-4bed-B2c1-0182845cb622/2022-06-24_PDF_Print_1_1.pdf
Heading 4
File MIME type:
Heading 5 (Custom...)
Heading 6 Custom MIME type:

image./png

¢ RegIR.ChapterName RegIFName ReqIRText
Preview file name:

_(F31F5d-dced-dbe3-Bec 1-0182845cb622/2022-06-24_PDF_Print_1_1png

—

Cancel

Right click menu in editor mode shows Properties window

HTML Source (experimental)

This function of the right click menu of content editor is recommended to expert users.
This function allows to view and change the html source code of the attribute/cell.

Note: Currently the changes will not be validated at inserting time. So be very careful at
any change!



Columns

Mass update of attributes
Update multiple rows with a specific attribute value.

The mass update function is designed to be used together with the filtering. This
way, a set of objects can be selected according to specific criteria and updated at the
same time.

The mass update function is not available for the main column

To use Mass update function first define a filter to select all the rows you want to
change. Then right-click on the column header. Select Mass update....A popup window
appears.

- — —

Ises - Kaffeeautomat_2... X ] ® RegEdit document - 2021-08-... X l

ement Type Rationale _ Fit Criterion
4 |f& Sort Ascending -
1

Dﬂﬂ UOO

Sort Descending

Hide

| Mass update...

Columns »

-aint

ReqEdit displaying the mass update menu item by right clicking the column header

string

) Mass update X

This action will modify the value of 76 rows in column
Rationale.

Change |All elements in the cument view v

All elements in the cumrent view
Selected rows
Update Cancel

Mass update popup window showing options



Mass update changes all values in the current view for the column.

To change individual cells, select multiple cells from the same column (either Ctrl + click
or Shift + click). Right-click at the column heading to trigger the mass change.

Default values

Each attribute can have a default value defined in the Document settings. Selecting an
attribute and access the “Attribute editor”.

To set back a cells default value for each attribute of a row, right-click the corresponding
cell and select the “Set default value”.

ObjectType
Info
analysis.
ents
We also
ns from Info
sers and
Heading
Attachments

Constraint

Requirement Type

Rationale Fit Criterion

Copy
Cut

Paste 3
Copy ReqlIF ID

Insert object before
Insert object after
Insert child object

Mark object as deleted

Restore soft deleted object

Purge selected object

Set default value ———

il

o O
Q

Promote

Demote

Expand IBM DOORS Table

Add link >
Add external link...

Edit external links...

Delete link..

Go to links

ReqlF Archive .reqifz files supports file attachments for objects.

Only XHTML attributes can have attachments inside .reqifz files

Image attachments:

png, bmp, jpg, gif, ico, wmf,

File attachments:

any file type is supported


https://documentation.reqteam.com/document-settings/#Attribute-types

pdf, doc, docx, xls, xIsx ...
Opening file attachments

Double-click on the file's icon. The attached file is opened by the installed applications
on the machine.

Insert file attachments

To add an attachment right-click the XHTML inline editor area and select Insert
image or Insert file

teglF.ChapterName ReqIFName ReqlF.Text

First Heading|

[0 Copy
o Cut
[] Paste
: X I Insert image...
Describe the purpose of this chapter .
Insert file...
First requirement Insert table...
Insert »
Delete »
'B| Bold
I] Htalic
'U| Underline

‘5| Strikethrough

|X*|  Superscript

X Subscript

® Textundo

M Textredo
Properties
HTML Source

ReqEdit displaying context menu, highlighted is the ‘Insert image' item
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ReqEdit displaying attachment previews of an object, contains file icons and preview images

Tables

XHTML attributes by definition can have tables. All tables are rendered inside cells.

. The coffee machine at the airport terminal:
the airpo.
s possibl... Mission: make several coffees (with different ingredients) after payment available
Name Function Values Restrictions Risk
a room - Comment
. Power management Power ON boolean [none major

1s and Terminolo — - .

) Stability control Handling float 1 rule minor
Assumptions
1ents
lirements
lirements

ReqEdit displaying tables inside XHTML attributes

To edit XHTML table structure use the inline editor right-click menu.

Save ReqlF files

If your file is a multi-document file, saving one of the documents will also save the
changes made in the other documents of the ReqIF file.

NOTE: Changes on linked documents (e.g. Images or Word, Excel) are not
detected. Make a content change to trigger update and enable saving.

Save as



Save the currently edited file as a new filename. Contents will be identical to the original
one. Can convert ReqlF into ReqlFz.

Note: Actual file is closed and the file in new saved format will be opened.
Save as encrypted file

To encrypt a file choose ReqEdit Encrypted File (*reqenc, *.reqzip) as file type then
click SAVE.

More about encryption of a file read here: RegEdit File Encryption/Decryption

Close files

RegEdit can only close saved files. If there are any unsaved changes, a notification
displays and asks to save files before closing.

Use CLOSE ALL to clean up the editor.

License activation

General overview about the license activation options. For more details, click here.
Automatic activation

Activation is automatic for trial version and for some custom-tailored versions.
Online activation

(Public environment, internet/online access with no restriction)

The License activator window appears. In the text box enter the Product key and press
the Activate button


https://documentation.reqteam.com/?p=3653
https://documentation.reqteam.com/license-management/

Public Internet

ReqEdit
License server

A

PC Product key

'

LicenseActivation.exe

Diagram of public environment with direct connection to ReqEdit License Server

Follow the Activation steps

Offline activation
(Limited environment, with restriction on internet/online access)
LicenseActivation.exe

Access to RegEdit License Server is restricted or not available. Manually activate license
for the machine where RegEdit is running.


https://documentation.reqteam.com/activation/#Online-activation

Public Internet

ReqEdit Create license for PC
License server
I v

7\ A l

1 1

1 ]

1 1

1 1

! - vac

1 1

1 1

PC Product key czv

b

LicenseActivation.exe

Offline activation with LicenseActivation.exe

Offline Activation with LicenseActivation.exe

RUS Tool


https://documentation.reqteam.com/activation/#Activate-with-LicenseActivation.exe

Public Internet

ReqEdit Create license for PC
License server ﬁ
A l A l
1 I
1 1
1 1
1 1
: RUS Tool : V2C
] . 1 \
1 1 1 I
L] I " I
1 1
I 1
PC Product key : c2v :
1 1
1 T 1
v v
RUS Tool

Offline activation with RUS tool downloaded from the ReqEdit License Server

Offline Activation with RUS tool
Network license server ACC

(Public internet access is restricted due to internal security policies, and only a local
license server is accessible)

A self-hosted licensing server is installed on the restricted network. The server holds all
the RegEdit licenses, that can be accessed from any workstation inside the company
network (no local license installation necessary).


https://documentation.reqteam.com/activation/#Activate-with-RUS-Tool

ReqgEdit

License server Public Internet
cav vac  offline
A i
T 1
1 1
1 1
1 1
1 1
1 I
1 1
! \ 4

Local network Desktop

¢ > Machine
RegEdit license

Network
License server

Restricted environment

Diagram of restricted environment with self hosted ReqEdit License Server

Setting up the Network license server

License detaching

Note: please inform REQTEAM if you plan to use detaching, so the license can be
generated for this purpose.

When users want to have a working copy of ReqEdit outside the restricted environment.
License detaching is possible by using the Detach Tool Add-on.

Detaching licenses will lock the license for a period of time for a specific machine.
Locking a license has to be done inside the restricted environment, after which it can be
disconnected from the network.


https://documentation.reqteam.com/activation/#Self-hosted-license-server-(Network-license)
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Machine
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3inuse ReqEdit license
1 detached
Desktop

Machine On the go
outside the network

ReqEdit license

Desktop

Machine
Detach license —_—

ReqEdit license

Restricted environment Detached

Diagram showing detach mechanism to work outside network license server

License detaching

Filtering, Searching and Sorting

Filtering
Filtering can be used to display only a subset of objects based on specific criteria.
Filtering is temporary, rules are not saved.

From the toolbar create filter, enable / disable current filter, delete filter can be used.


https://documentation.reqteam.com/activation/#License-detaching
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ReqEdit toolbar highlighted are the filtering icons

Filters can be constructed by the toolbar icons, then later edited or deleted.

) Filter Editor - m| X
Filter criteria
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gf ||Comment v| |Equd vl | X
|| | Effects v| |Equa v | Simple v x
T
d
Clear all criteria | “  Cancel
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Searching
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ReqEdit search bar displayed above the main content area

Search can be done in three contexts:

e Main Column: search only in ReqlF.ChapterName, ReqlF.Name, ReqlF.Text

o Entire document: all attributes

o ForeignID: search only in ReqlF.ForeignID (only if the attribute is present in the
current document)

Specification Document - Kaff... X ] ® Use Cases - Kaffeeautomat_2... X ] ® RegEdit document - 2021-08-... X
a

Find: ‘pmject '\ Previous Next Clear Search in: | Main Column v

ec...
[] match case [] Match whole word 3 of 5 matches

Main Column ObjectType Requirement Ty|

2 - Project Constraints

Heading

2.1 - Mandated Constraints

Heading

ReqEdit searching, found result displayed in green cell background

Search and Replace

Replacing values or part of values depending on the search can be done by
pressing CTRL+H enabling the replace bar

The replace function works only for the Main Column

Help

B Ok E e 58 3@

® Specification Document - Kaff... X ] ® Use Cases - Kaffeeautomat_2... X ] @® ReqgEdit document - 2021-08-... X
a

E| || : Views: All attributes (System) ~ Lo S Bd Fead

Find: ‘pmject i Previous Next Clear Search in: | Main Column
5 Spec..
P [[] Match case [] Match whole word 3 of 5 matches
ea...
Replace with: ‘ ] Replace Replace all
Main Column ObjectType Requirement Type Rationale

Officers and employees from the airport / security etc

ReqEdit displaying Search and Replace bar above main content area

Skipping a specific replacement press the Next button

Replace all will do the replacements in the contents of the Main Column then display
the total count of replacements.

Sorting columns

Columns can be sorted ascending or descending by clicking or by right clicking on the
column header. Each sort will reset the previous sorting.
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Requirements Specification Template Edition 15—March 2020 & ‘Urictesoring Comment

Hide

Mass update
Volere is the result of many years of practice, consulting, and research in requirements engineering and business analysis.
We have packaged our experience in the form of a generic requirements process, requirements training, requirements
consultancy, requirements audits, a variety of downloadable guides and articles, and this requirements template. We also
provide requirements specification-writing services.

Columns >

The first edition of the Volere Requirements Specification Template was released in 1995. Since then, organizations from all Info
over the world have saved time and money by using the template as the basis for discovering, organizing, and
communicating their requirements.

ReqEdit column sorting menu by right clicking on the column headers

Multi-column sorting
To have multiple sorting CTRL+click the column headers you want to sort. A numbered

arrow will display the sorting order. To change the ordering press CTRL+click again on
the column

Main Column 3 a4 Object.. 1w Requireme. 2w

A LAN port can be set Requirement  Constraint

Access to the machine is possible only during the operating hours
Requirement  Constraint

RegEdit multi column sorting displayed by numbered arrows in the column headers

Reset sorting

Press the delete sorting icon in the toolbar or press CTRL+D
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View Manager

What are views?

Views are visible column sets with optional custom sorting and filtering saved as presets.
The view manager is located in the toolbar icon groups on the right side.

The views are only for displaying the ReqlF contents in a more human friendly manner
for large files with lots of metadata.

The view presets are saved in the ReqlF file



Views can be exported and later imported from the local hard drive
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Backup History

Cache size: 499 MB

ReqEdit displaying the view manager popup window, highlighted is the view manager toolbar

There are two system views defined per each document which cannot be deleted:

All Attributes - show all the columns in the document

Main column - show only the main column

Wiews:

All attributes (System)

Main column (System)

reduced
reduced 2
reduced 3

View selector in the toolbar

Manage views

Comir

To be able to manage views user defined views has to be created by clicking
the Create new view icon

1ent - 2021-08-... X

View toolbar icons, selected is the Create new view icon

Views: All attributes (System)  ~

1

a
ng |




Create or edit views

Pressing the Edit view icon the view editor popup window is displayed. The toolbar icons
are:

« Rename

e Save

e Save and Apply, will show the applied view in the main content area

o Delete after confirmation the view is deleted

e Make a copy of the view by setting a new name

o Export the current view in a .view file

e Import .view files. Only existing column names are imported

e Cleanup, will leave only the visible columns in the document, a confirmation
popup lists all the views / attributes that will be removed. This operation saves the
document so a backup is highly advised.

Q) View edit - ] X
R O L B @«
Attribute Name Width Sorting Visible  Attribute ID Object Type
» I o0 [none v| O |specobjectip
Comment 300 None ~ _2982add-78a2-437f-a6f3-1f89efb...
Processed 82 None ~ _2952c1-87d8-48ca-b85c-28a689...
ReqlF.ForeignDeleted |151 None ~ O _0d3c4a8-09d1-4f34-9d1b-7cebab...
Count 80 None ~ _a521b92-4f9a-4371-9903-b752¢...
818 None w MainColumn
| ~ Y v
[] Show deleted objects
Fitering Copy fitter from editor Reset filter

View editor window

Filtering



Views can inherit filtering from the current document. Press Copy filter from editor to
save the filter into the view.

Show deleted objects filter can also be used
Toolbar
Creating new views

Clicking the Add View button will ask user for the new view name and preparea it will all
the attributes added to it

Editing views

User can edit the view in the main gui with rightclicking the column names or by opening
the View manager panel by clicking the icon to the right

Views: All attributes (System) ~ o S Se e

Comr
View manger toolbar, highlighted is the Edit view icon

Deleting views

User can delete the selected view if it's not any of the system views by clicking the
Delete View button located in the toolbar

Printing
How to print requirements?

ReqEdit supports printing the Main Column or all the visible contents of the current
document. File > Print will show the two options.

Print Main Column
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1 - Scope

1.1 - Identification

1.2 - System overview
1.3 - Document overview

y:

2 - Referenced documents

3 - Requirements

3.1 - Required states and modes
3.2 - CSCI capability requirements

3.3 - CSCI external interface requirements

' 3.3.1 - Interface identification

Print All visible columns



ReglF Feeagally

Rny[F FeongaloeedOn
FrglF FoomgmCrrssed Thru
Lat Modified O

1.1 - Identification

["RurgIF FeomgalD
FaqlF FormgaComtedln
PeqlF ForonpaCoeatedThr

Lazt Miodified Om

1.2 - System overview

FaqlF Formgall:
FeqlF FoompareamsdOn
FoeqlF ForngaCreatedThr

Last Mesdified Cm

1.3 - Document overview

1

Customize the current view with filters and sorting to prepare a custom view for the print.

Customize the output

ReqEdit offers print customization of the header, footer and cover pages. Access the File
> Print > Settings menu item for displaying the customization window.



’
ﬁ Print Settings

Header | Footer | Cover page |

Logo:

Browse

Document titleSpecification long name:

Custom tend:

Left v] Enable
| Center ~| [7] Enable
| Right = | [¥] Enable

Print customization

Settings

Expert users can fine tune ReqEdit for their specific use case, and configure lots of

ReqlF related settings

Settings | Add-ons Help

Document... F8

1=l

¢ Server...

User...

ReqEdit settings menu

Document settings
Manage ReqIF file internal settings

Attribute Types




Attributes

Document attributes

Links

Configure Main Column display settings
Server settings

RegEdit file server connection settings
Server user credentials

User settings

ReqEdit internal configuration
Interface language

Auto backup settings

Doors table display settings

Cache size

Dashboard startup

Document Settings

Read the chapter Document Settings for an in depth overview.

User settings

ReqEdit can be displayed in two languages: English and German.
To change the language, press Save and then restart ReqEdit.
Temporary files

Using ReqlF files produces temporary files like: previews, caches, ReqlF Archive
objects, etc. To clean the user space use the Delete temporary files button

Backups

When a file is saved for the first time, RegEdit automatically makes a backup copy of the
initial state of the file and also starts the timed backup process. By default, the program
creates a backup every 10 minutes until it reaches 10 backup files. After that, the oldest
backup file will be overwritten. The number of minutes and number of backup files can
be changed by the user in the User settings panel.


https://documentation.reqteam.com/document-settings/
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Backup History

Backup date: 04.01.2022 10:28:25
Fiie name: Kaffeeautomat_2 reqfz

Backup date: 04.01.2022 10:18:25
File name: Kaffeeautomat_2 reqfiz

Backup date: 04.01.2022 10:08:25
File name: Kaffeeautomat _2 reqifz

Backup date: 04.01.2022 10:08:24
File name: Kaffeeautomat_2 reqffz

Backup date: 04.01.2022 10:08:23
File name: Kaffeeautomat _2 reqifz

Backup date: 22.12.2021 12:49:18
File name: Kaffeeautomat _2 reaifz

Backup date: 22.12.2021 12:49:17
Flie name: Kaffeeautomat_2 reqifz

Backup date: 22.12.2021 12:49:16
File name: Kaffeeautomat_2 reqifz

Backup date: 22.12.2021 12:42:38
Fiie name: Kaffeeautomat_2_backup_copy regfzn

Backup History

Cachesize: 3473MB | HTML Validation: Off

ReqEdit displaying a ReqlF file, highlighted on the right side is the auto backup panel displaying available backups

The timed backup process can also be disabled by unchecking the [Create backup]

checkbox in the Settings > User panel.

By default, ReqEdit stores the backups in the Windows user folder. This is a Windows 7
location sample: C:\Users\user_name\AppData\Local\RegEdit\RegEdit\BackUpFiles

The locations of the Log and Backup folders can be changed. More information can be
found in the Program environment chapter.

Image caching

Limit the RAM memory used by ReqEdit. Default value is 500mb, but can be increased
to gain more speed.

ReqEdit uses image caching to speed up displaying XHTML contents of the ReqglF files.
If the ReqlF files are big, increasing the cache size could be a good idea.

Server settings

This requires a RegEdit Server instance and to be accessible on the internet.

Read more on the Collaborative work with ReqEdit Server

The focus of ReqEdit Server is to keep the file management effort as low as possible.

The server offers a central point where you can organize and work with ReqlF files in
ReqEdit.



Q) Server Settings X

Server settings
I Host name: https:// cloud.reqgteam.com
Path
Port: 443
| Connectiontype: (O http:// € https:// v I
Application 1D:
User name: demo
i Password: essscee Save password
Proxy server
(] Use proxy for ReqEdit server ("] Use proxy for updater and license activator
[}
i Address: Port:
User name:
Password:

Test connection Save Close

ReqEdit Server settings

Enter credentials for ReqEdit Server and press Test Connection then Save.

Once a valid configuration is saved press Connect from this window or from the toolbars
or the File menu.

File Edit View Settings Help
@b AR ED @

ReqEdit Server connection toolbar

Document Settings

Before describing the document properties, lets go through the internals of the ReqlF
files.

TLDR jump to Document properties

Attribute types


https://documentation.reqteam.com/pdf/?html#Document-Properties

Each specification document has its own set of attribute types that are used as
attributes. The list can be displayed using the menu Settings > Document.

Automatic data types for documents
Each new document will have: integer, real, date, string, xhtml and boolean attribute
types automatically created, which can be edited.

| Creation tool: ReqEdit
| Source Tool ReqEdit
Number of documents: 1
1 Conversation ID: Generate 1D
| Documents: Sheet1 Y
Display as headina: Display as description: Display as text:
| ReqlF ChapterName v~ ReglF.Name v ReglF.Text v
Atibutes  Document  Links
Related documents Long Name Data Type Last Change Description
Sheet1 Boolean BOOLEAN 01.02.2023 |5 meration
INTEGER
Sheet1 Integer IN: -2147483648 01.02.2023
AX: 2147483647
REAL
IN: -2147483648
e AX: 2147483647 002,202
ACCURACY: 3 ’
Sheet1 Date DATE 101.02.2023
String STRING 01.02.2023 Enumeration Type Values:
AX-LENGTH: 600 S -
Sheet1 Text HTML 01.02.2023 K& Value
Enumeration ENUMERATION 02.03.2023 1 0 Not Approved
0 Approved

New | Edit Delete

ReqEdit displaying list of attribute types of a specification document, highlighted is the data type column which displays the base type
and restrictions of the attributes. Selected is an enumeration type attribute and the enumeration values are displayed on the right bottom
in the Enumeration Type Values list box

Data types

Attributes in ReqlF files are constructed from underlaying data types with or without
restrictions. The usage of restrictions in the data types can make the requirement
specifications more robust by not letting invalid values to be used.

Properties of data types

Depending on data types, different properties are available. The following table
describes all available properties per data type

Long Name |Description |Min|Max |Accuracy |Enum Values




Boolean

Date

Enumeration

Integer

Real

String
XHTML

XX [X|X]|X|[X[X
XX [X|X]|X|[X[X
X
X

Boolean

Its value can be true of false. These two states are displayed by a check box on the
screen. This is an exception type, double click on the cell is not necessary for editing. Its
value can be altered by a single click.

Date

A real date can be written or set as its value. In the view mode, the cell shows the value
of the date, but in the edit mode it displays the DateTimePicker controller used for
selecting the date. This offers help for the user to select fast the exact date. The date

value can also be removed by unchecking the box in the top left corner of the date
picker.

Integer

An integer can be given as a value between previously determined limits. In case of not
giving a numeric type, the program will display an alert and the user can only continue if
a correct value is entered.

Real

The value can be a decimal number between previously determined limits. In case of not
entering a numeric type, the program will display an alert and the user can only continue
if a correct value is entered.

String

An unformatted text with a previously determined length can be entered as a value.
NOTE: The maximum allowed length of a string is 600 characters. This limitation was
imposed in order for the files to be compatible with IBM Rational DOORS.
Enumeration

Represents a list of fixed values that can be used.

Each value has a Numeric Value, a Label displayed to the user, and an
optional color in HEX or named color.



[r—

DataType  Enumeration

LongName  Enumeration_ReqlF-WF.ProductVariant Min 0
Description Max

' URI:
Accuracy 6 3

|dentifier:  _ce24f4b-d04c-4223-bd%b-a3307d8353a0

»

Enumeration values: O @ %)
NUM VALUE LABEL ~ COLOR URI
Variant 1 Blue '
1 Variant 2 .FLn:h-sia
2 'Variant 3 . -
, [L Cancel

Enumeration type editor window

XHTML

XHTML format permits formatting of text in multiple ways, similar to any text processing
application: Bold, Italic, Underline, Strikethrough, Superscript, Subscript, Unordered list,
Ordered list, Paragraph, Normal text, Heading 1 — Heading 6

In addition to text formatting tables and images can be used in the content, as well
as file attachments.

URI

The URI Represents the Resource types defined by DNG data models. All the attribute
definitions, attributes, enum values may have URI values defined.

Attributes

Using the defined attribute types, attributes can be created to be used in the document
or the objects. Each data type has its own properties shown in the following table

Long Name|Description |Read Only [ Multivalued | Default Value




Boolean
Date

Enumeration

Integer

Real

String
XHTML

XX [X|X]|X|[X[X
XX [X|X]|X|[X[X
XX | X|[X|[X]|X]|X
XX | X[X|X]|X]|X

Each data type has its own properties

Enumeration attributes
Using enumeration data types in attributes has two main use cases
Single-value enumeration

You can choose only one value from a previously determined value set. It shows the
chosen value in cell viewer mode. In the editor mode you can choose the required value
from a values list (ComboBox or DropDownList).

Besides the values of an enumeration attribute type, the user can also select the value
to remove the value of a cell.

Multivalue enumeration
You can choose multiple values from a previously determined value set. It shows the

chosen value in cell viewer mode. In the editor mode you can choose the required
values from a list by selecting each check box.



2-lime, 4-black

3-pink

4-black, 2-lime,

S-green 4-black

4-black, 3-pink,

S5-green 4-black

3-pink 3-pink
3-pink

2-lime, 2-lime

J-green

2-lime,

S-green

Multivalued enum attribute displayed as list of values with colors

Requirement Non-functional

Requirement Constraint

Requirement Constraint

Requirement Constraint

Requirement Constraint

Requirement Constraint

Single value enum attributes are displayed as text



Document Properties

Information related to a specification document is visible in the Document tab. Document

Name, description, attributes and statistics.
Statistic Information of:

e Documents in file

e Rows in selected document

o Attributes in selected document

e Attribute types in selected document
e Incoming and outgoing links

Attributes that are defined internal to the specification are also listed with the value

displayed on the right side.

Creation tool: ReqEdit
Source Tool ReqEdit

Number of documents: 1

Conversation ID: Generate ID
Documents: Test file forimport excel
Display as heading: Display as description: Display as text:
ReqlF ChapterName ReqlF.Name v ReqlF.Text
Attribute Types ~ Attibutes Document  Links
LongName: Test file for import excel
Description:
Identifier: _99a5be8-b7c0-4ddd-a373-6626510bdb 18
Last changed: 2023-03-07T12:02:05+02:00
Number of attribute types: 6 Number of outgoing links: 2
Number of attributes: 19 Number of incoming links: 2
Number of rows: 32 (0 deleted)
Long Name %;Setom Data Type Last Change Is editable
New Edit Delete
Save Cancel

ReqEdit displaying document properties

Specification types

Currently not displayed, internally will be created and used exactly as in the ReqlF

standard.



Object Attributes

List of attributes used in all objects of the selected document.

Creation tool: ReqgEdit
Source Tool ReqEdit
Number of documents: 1
Conversation ID: Generate ID
Documents: Sheet1
Display as headina: Display as description: Display as text:
ReqlF ChapterName ~  ReglF.Name v~ ReqlF.Text

Attibute Types  Aftibutes  Document  Links

Long Name %'psgom ~ Data Type Last Change Is editable Description
= ReqlFForeignD... Boolean BOOLEAN 06.03.2023 "4
L‘fﬂ RegEditModifie... Date DATE 06.03.2023 4
- ENUMERATION -
ReqIF-WF.Prod... Enumeratio... 06.03.2023 Q7
_ MULTIVALUED:
ENUMERATION URL:
ReqlIF-WFE.Type Enumeratio... 06.03.2023 4
MULTIVALUED:
ReqEdit.ExcelR... Integer INTEGER 06.03.2023 W Default Value(s)
Hierarchy ID Integer : IVNTE(VSVEVR 06.03.2023 &
=i ReqEditID Integer INTEGER 06.03.2023 &
Object ReqIF ID  Text XHTML 07.03.2023 &
‘=1 RegIF.ChapterN... Text XHTML 06.03.2023 &
=l RegIF.Text Text XHTML 06.03.2023 &
= RegIFName Text XHTML 06.03.2023 &
Comment Text XHTML 07.03.2023 @
=l ReqEditModifie... Text XHTML 06.03.2023 &
ReqIF-WF.Cust... Text XHTML 06.03.2023 &
ReqlIF.Text Text XHTML 06.03.2023 &
New Edit Delete

Save

Object Attribute management window

System attributes are displayed by a PC icon in the list, these attributes cannot be
deleted

RegEdit internal attributes

o ReqEditID — integer type, read-only attribute, internal unique ID

o RegEditModifiedOn — date type, read-only attribute, last modification date of the

object
o RegEditModifiedBy — string type, read-only attribute, stores the Windows
username who edited the object

SpecObject types

Currently not displayed, internally will be created and used exactly as in the ReqlF
standard.



Links

Are covered in the Links chapter
License Management

Automatic activation.
Activation runs automatically for trial version or for some custom-tailored versions.

On the last step of the installer the checkbox remains at default settings.

Completing the ReqEdit Setup
Wizard

Setup has finished installing ReqEdit on your computer. The
application may be launched by selecting the installed
shortcuts.

Click Finish to exit Setup.

Start LicenseActivation.exe after finishing installation, if
license can be activated automatically, RegEdit will be
started

Window Start Activation Setup

LicenseActivator.exe starts without displaying User interface. It detects .v2c file and
activates the product.

ReqEdit opens automatically.
Online activation

After installation

Note: You need to have non-restricted Internet acces, or need to configure the proxy
settings for it.


https://documentation.reqteam.com/chapter/links/

The License activator window appears. If not, run the LicenseActivator.exe in the
ReqEdit folder. In the text box enter the Product key and press the Activate button.

Public Internet

ReqEdit
License server

A

PC Product key

v

LicenseActivation.exe

Diagram of public environment with direct connection to ReqEdit License Server
A IS EE——
) License activator — X
Online Activation Offline Activation License info

© Local license:
Please enter your product key and select the approprate operation:

© New product key
() Use existing key
i (O) Update the existing product key

() Network license:

License server address:

Proxy settings Activate Cancel




License activator window

@, tivator -

Online Activation  Offline Activation License info

Information X o

Activation was successful!

License server address:

Activation done

Activation done. Run ReqgEdit.

Offline activation

This activation allows running ReqEdit when access to RegEdit License Server is
restricted or not available. Create manually a license for the machine where RegEdit is
running.

In this case there are 2 options for activation: Activation with the file
LicenseActivation.exe or Activation using the RUS Tool. Through them you can generate
a .c2v file which you need for creating the license for your PC.



Public Internet

ReqEdit Create license for PC
License server
I | 4
A A
v
PC Product key c2v vac

t '
G

Activation with LicenseActivation.exe



Public Internet

ReqEdit Create license for PC
License server
I v
A A
RUS Tool
v
PC Product key ca2v va2c
v
RUS Tool

Activation with RUS Tool

Activation with LicenseActivation.exe

Activation with RUS Tool
Activate with LicenseActivation.exe
The offline activation needs the following:
e product key (got with purchasing ReqEdit)
e machine generated .c2v file (follow the next steps)
Open ReqEdit folder and click LicenseActivation.exe in the RegEdit folder.

Pops up License activator window. Here generate C2V file


https://documentation.reqteam.com/activation/#Activate-with-LicenseActivation.exe
https://documentation.reqteam.com/activation/#Activate-with-RUS-Tool

Save the file into the suggested folder or elsewhere

Q License activator

1
Online Activation License info

License request

1. License Request {C2V) (@ First install

Generate

License activation
2. License Response (V2C)

V2C output

Generate c2v file in Offline activation

At an online workstation login with Product key at the Sentinel EMS Customer portal

https://license.regteam.com/ems/login.html

Sentinel EMS

ENTITLEMENT MANAGEMENT SYSTEM

Customer Portal Login License Update
Product Key:ﬂ ]

© 2021 Thales Group. All Rights Reserved. | Suppo

English Italiano Pyccxw Francais sasr

o Ca -~ 2 —_— -
\ sch Espafiol 342
Deutsch Espanol 332

Sentinel EMS Login

Choose Offline Activation tab. A new window appears.


https://license.reqteam.com/ems/login.html

In the Generate License window upload the saved C2V file.

Then click Generate.

Order Details
Product Key:
Customer: Botond Horvath E-mail: b.horvath@innov...
Activations: Unlimited Remaining Unlimited
Activations:
RefID 1: RefID 2:
Entitlement
Comments:
Frodue Product Lock Type
Ultimate User License 10/2021 SL-UserMode
Download RUS, a tool to generate C2V
Upload C2V
Upload C2V: | Test_offine_Activation.c2v —— | [
Comments:

Uploading the .c2v file

The Key ID. appears

Download the VC2 file

Key ID Lock Type

SL-UserMode

Activation Date

2021-12-09

V2C File

Downloading the V2C file

Go to the License Activator window and press Activate button



| Oniine Actvation License o
License request 1
1. License Request (C2V) O First install O Update

Generate

& Select location for the V2C file

& pi i 1A @l > ThisPC > Desktop v C Search Desktop el

Organize v New folder

]
4

!

©

A~
Name ¥ Date modified Type Size
v Quick access

) 66197427586066... 12/

V2C File — 3 8KB
il Desktop

& Downloads  #
= Documents
PN Pictures
@ Music
& Videos

> @ OneDrive

> [ ThisPC

> & Network

File name: v ‘ Vac file (*.v2c) v

| 0 I C |
s pen ancel

Activate offline with key

In the Browser window select V2C file

Press Open



@ License activator — X

Online Activation Offline Activation  |icense info

License request

1. License Request (C2V) © First install (O Update
Generate

C2Vfile C:\Users\Bryan\Desktop'\Test_Offline_Activation.c2v successful generated. Please upload this fil
hitps://license reqteam.com/ems/customerLogin html to activate your license
Please use your product key as login

License activation

2. License Response (V2C)

License sucessfull activated

I Close Cancel

Open ReqgEdit and start working with it.

| N " A\ |

Activate with RUS Tool

e Login to the customer page of REQTEAM license management
(https://license.reqgteam.com/ems/customerLogin.html)
o Enter your license key from your license

Sentinel EMS

ENTITLEMENT MANAGEMENT SYSTEM

Customer Portal Login License Update
Product Key:n ]

E"”I h ltaliano P ‘*"v.n." Francais &3z Deuis

Sentinel EMS login

Click on the Offline Activation Button


https://license.reqteam.com/ems/customerLogin.html

Appears Generate License window

Order Details

Product Key:

Customer: Botond Horvath E-mail: b.horvath@innov...

Activations: Unlimited Remaining Unlimited
Activations:

RefID 1: RefID 2:

Entitlement
Comments:

Products: nict

Ultimate User License 10/2021

I Download RUS, a tool to generate C2V I

Upload C2V

Upload C2V:

Comments:

Generate

Download RUS tool

Download RUS tool (RUS_OWOZQ)

Some antivirus program can delete or quarantine this file. So, keep it when the antivirus
asks for deleting or putting into quarantine.



Downloads /P Q- 9

US_OWOZQ.exe isn't comrjonly dow! @ .
ou trust RUS_OWOZQ.exe fefore you

. 2207353693334 W Delete

Open file

Keep
. 661874275 866¢€
Removed Report this file as safe
A Learn more

true G2 Copy download link

A Make sure you trust
RUS_OWOZQ.exe before you
open it
Microsoft Defender SmartScreen couldn't
verify if this file is safe because it isn't
commonly downloaded. Make sure you

trust the file you're downloading or its
source before you open it.

Name: RUS_OWOZQ.exe
Publisher; Unknown

Show less A

Keep anyway

Report this app as safe

Learn more

Keep RUS tool

1. execute RUS tool
2. select Collect Status Information and select C2V file type.
3. select Installation of new protection key



4. press Collect Information
5. save the C2V file

Malan Sy SR I R EEES——

& RUS — O

Collect Status Information | Apply License File ~ Transfer License

KUS utiiity

The RUS utility (Thales Remote Update System) is an advanced utility that enables secure,
remote updating of the license and memory data of Sentinel protection keys after they have
been deployed.

The RUS utility window consists of the following tabs:

* Collect Status Information: The parameters in this tab are used to collect information
on the current status of the licenses in the Sentinel protection key or collecting
fingerprint information. The end user specifies a name and location for the
generated C2V file. If more than one Sentinel protection key is installed, the user
selects the required key. No private customer data is induded in the C2V file

* Apply License Update: The parameters in this tab are used to apply a V2C file and
update licenses in a Sentinel protection key

* Transfer License: The parameters in this tab are used on the source computer and
recipient computer to rehost an SL key from the source computer to the recipient
computer

Yours,
REQTEAM support team

REQTEAM GmbH
Adams-lehmann-Str, 56
80797 Minchen
Deutschland

Telefon: 49 89 21548150
Fax: 49 89 21548151

E-Mzil: contact@reqtezm,.com

10:40:11:
Fingerprint retrieved.

10:44:35:
Fingerprint retrieved.

Collect information from this computer to enable:
() Update of existing protection key

l © Installation of new protection key
Collect Information

Generate c2v file




# RUS

Collect Status Information ~ Apply License File ~ Transfer License
KUDS Utliity

. Tha RIS utility fThalee Remata | Indata Quetam) ic an advanced utilihy that enahlec camwa 1
“ Save Key Status As

« = v A g » Thi. » Docu.. C Search Documents

Organize v New folder

@ Music Name Date medified

&3 Videos [] Test_Offline.c2v 12/9/2021 10:43 AM

> @ OneDrive

> [ This PC

> ‘8 Network

File name: | Test_Offline.c2v

Save as type: Update receipt file (*.c2v)

~ Hide Folders

>

10:44:35:
Fingerprint retrieved.

Collect information from this computer to enable:
(0) Update of existing protection key
© Installation of new protection key

Collect Information

Save c2v file

C2V file can be used for license related operations.
At an online workstation login with Product key at the Sentinel EMS Customer portal

Upload the C2V file to Sentimel EMS.



https://license.reqteam.com/ems/customerLogin.html

Order Details
Product Key:
Customer: Botond Horvath E-mail: b.horvath@innov...
Activations: Unlimited Remaining Unlimited
Activations:
RefID 1: ReflD 2:
Entitiement
Comments:
Eyotuct: Product Lock Type
Ultimate User License 10/2021 SL-UserMode
Download RUS, a tool to generate C2V
Upload C2V
fipload 52V Test_Offine.c2v — | [
Comments:

Upload c2v to EMS

Press Generate to generate V2C file.

Download V2C file to your PC.

Key ID Lock Type Activation Date Comments

SL-UserMode 2021-12-09

Download

V2C File

Download v2c

1. execute RUS Tool
2. select tab Apply License File and select the V2C file
3. press Apply Update to activate the license on the machine




n ] [ Product Key Details
&< - G O ntpsyi

A Rrus

Collect Status Informaton ~ Apply License e Transfer License

Apply update V2C



& pus — O o

Collect Status Information Apply License File Transfer License

10:54:45:
Applying update from file C:\Users\Bryan\Desktopy,™ " 77" "7 77T 77T UserV2C
Update written successfully,

Update File C:VYJsers'\Bryan'\Deskiop!, UserV2C i

Apply Update

Activation done

Activation done!

You can start to work with RegEdit.

Network license server ACC

A self-hosted licensing server is installed on the restricted network. The server holds all
the license pools that can be used and has to contain a current snapshot of the license
database from RegEdit License Server.



Downloads

Download haspdinst.exe for windows

Version Downloads

Sentinel ACC haspdinst.exe 8.53 | haspdinst.zip haspdinst.exe

ACC windows versions

Download aksusbd.tar for linux

Version Downloads
Sentinel ACC aksusdb.tar 8.53 | aksusbd-8.53.1.tar

ACC linux versions

Add note: please inform REQTEAM if you plan to use detaching, so the license can be
generated for this purpose.

Installing


https://cloud.reqteam.com/downloads/thales/8.53/haspdinst.zip
https://cloud.reqteam.com/downloads/thales/8.53/haspdinst.exe
https://cloud.reqteam.com/downloads/thales/8.53/aksusbd_113498-8.53.1.tar.gz

ReqgEdit

License server Public Internet
cav vac  offline
A i
T 1
1 1
1 1
1 1
1 1
1 I
1 1
! \ 4

Local network Desktop

Network ¢ > Machine

License server
RegEdit license

Restricted environment

Diagram of restricted environment with self hosted ReqgEdit License Server

NOTE: The installation needs to me made on the "future” license server.
NOTE: Windows can detect the haspdinst.exe as untrusted, Run Anyway
e Port 1947 has to be opened
e Type haspdinst -i in the command line. The installation or upgrade process is
performed automatically. A message is displayed informing you that the Sentinel
LDK Run-time Environment was successfully installed.
On windows execute the following command to start the installation:
You can find an extended manual if you run the program in Windows File Explorer.
To check the status of the installation execute the command:

The version of the "Installed Package Drivers" needs to be 8.31

To check the status of the installation execute the command



haspdinst -info

In the ReqEdit application folder you need to start the executable "Start.exe" or
"LicenseActivator.exe" depending on the version you have and insert the FQDN or IP of
your license server.

Read more on the topic here Installation guide Thales/Sentinel LDK EMS

Updating
The update of the ACC needs to be done exactly like the install.

Fist stop the windows service (press windows START then type "Services") with the
name "Sentinel LDK License Manager" and then execute

haspdinst -i
Uninstalling

To remove Sentinel license server on Windows execute

haspdinst.exe -r

if for some reason the uninstallation does not work, you can force remove with
Configuration

C2V on Windows

Go to the license server webpage http://localhost:1947 and select the "Sentinel Key"
item.

& C @ localhost:1947/ int_/devices.htm b+ 4 © » ' :

Sentinel Admin Control Center

Sentinel Keys Host Name: win-newdev

Sentinel Keys
Location Vendor KeyID  Key Type Configuration Version  Sessions Actions

Products 113498 it .
Local l113498) Reserved for New SL Key

SL 821 X Fingerpr‘n(;

Features

ACC server showing the vendor keys, download the Fingerprint

press the "Fingerprint” button and save the C2V file in the downloads folder.


https://docs.sentinel.thalesgroup.com/ldk/LDKdocs/Install/Installation%20Guide/RTE_using_Utility/haspdinst.exe%20Utility.htm
http://localhost:1047/

Step 1: Got to the customer login

page https://license.regteam.com/ems/customerLogin.html. You need to insert the
product key to login.

Sentinel EMS

ENTITLEMENT MANAGEMENT SYSTEM
Customer Portal Login License Update

Product Key:[[ ]

202 i Tha'es Group. All Rnghts Reserved | Support

glis ano Pyccxwi Francais casy Deutsch Espafiol 9%

M ®

Login Sentinel EMS

Step 2: Select "Offline Activation".
Step 3: Upload the created .c2v file.

Step 4: Click the "Generate" button and save the .v2c file to a folder you like.

Sentinel EMS Welcome | Logout | Help

ENTITLEMENT MANAGEMENT SYSTEM

Generate License X Online Activation || Offline Activation

Order Details

b.horvath@innov...
Product Key:
Customer: Botond Horvath E-mail: b.horvath@innov...
Activations: Unlimited Remaining Uniimited Uniimited
Activations:
RefID 1: RefID 2: true
Entitlement
Comments:
Products
Product Lock Type
Ultimate User License 10/2021 SL-UserMode
Download RUE, a tool to generate C2V
Upload C2V
Upload C2V: Test_Offline_Activation.c2v e
Comments:

1tinel EMS for Sentinel LDK v8.2 (Patch Version: 7/2021)

R

Upload c2v file



https://license.reqteam.com/ems/customerLogin.html

Update/Attach licenses

Step 5: Download the generated V2C file (or the V2C file received from us)

Key ID Lock Type Activation Date Comments Download

SL-UserMode 2021-12-09 V2C File

Download V2C file

Step 6: Upload to your local license server http://localhost:1947 in the menu
"Update/Attach”.

& C @ localhost:1947/_int_/checkin.htm

Sentinel Admin Control Center

Update/ANaCh License Host Name: win-newdev

Sentinel Keys

Select File |[ Select File_.. |@
File Format: a V2C, V2CP, H2R, R2H, H2H or ID file

Products

Features

Sessions

Update/Attach

Access Log

Configuration

Diagnostics

ACC server update/attach V2C license file page

Step 7: Check in in the menu "Products”, if the license was correct inserted/updated.
C2V on Linux

If you are using Linux, the procedure is a little bit more complex. You need to log in to
your license server (ACC) and click the tab "Diagnostics". Here you find a button named
"Generate ID File". After clicking this button you got an ID file to save. Please save this
file to a local drive and change the file extension to .c2v.


http://localhost:1947/

Now open this C2V file in a text editor and change the structure of the ID file, which
should look like this (characters truncated with ...):

<?xml version="1.0" encoding="UTF-8" 2>
<location>

<license manager 1id="F07reQmW9igotxo 1b4VD5kRUi4qgsA"
time="0">

<version>24.4.1.110802</version>
<hostname>safenet</hostname>

<name>SAFENET</name>

<host fingerprint type="SL-AdminMode" crc="123456789">
MXhJSY1JIQewwFkjBPbITR]kSqpKZebAq3PcANCWG =
</host fingerprint>

</license manager>

</location>

and change the file to this:

<?xml version="1.0" encoding="UTF-8" 2>
<hasp info>
<host fingerprint type="SL-AdminMode" crc="123456789">

MXhJSY1JIQewwEFkjBPObITRjkSqpKZebAg3PcANCWG
</host fingerprint>
</hasp info>

License detaching

Note: please inform REQTEAM if you plan to use detaching, so the license can be
generated for this purpose.

When users want to have a working copy of RegEdit outside the restricted environment.
License detaching is possible by using the Detach Tool Add-on.

Detaching licenses will lock the license for a period of time for a specific machine.
Locking a license has to be done inside the restricted environment, after which it can be
disconnected from the network.



Public Internet

ReqEdit
License server

-

V2C offline

Q
N
<

Local network
Desktop
Machine

O o

‘._____..__.

ReqEdit license

Network

License server Desktop

Machine

100 licenses of which:

—>
3inuse ReqEdit license
1 detached
Desktop

Machine On the go
outside the network

ReqEdit license

Desktop
Machine

Detach license —_—
ReqEdit license

Restricted environment Detached

Diagram showing detach mechanism to work outside network license server

NOTE: : To be able to use RegEdit on a workstation which leaves the company network,
you need to detach a license for it. To achieve this goal ACC must be installed on the
workstation!

Installing ACC on the workstation (jump to ACC install section)

Configuration of ACC is not needed. Detach tool will handle the license transfer
automatically.

Requirements

The RegEdit Detach tool needs to run on a Windows operating system with .Net library
(at least version 4.8 or higher) installed.

Additional the Sentinel Admin Control Center needs to be installed and configured
locally. Please ensure that a valid VLIB DLL (i.e. haspvlib_113498.dll is corresponding
for ReqEdit licenses) is installed. The file needs to be in the folder.

“C:\Program Files (x86)\Common Files\Aladdin Shared\HASP”.

About detailed requirements, read more here.


https://documentation.reqteam.com/pdf/?html#Installing
https://documentation.reqteam.com/starting-reqedit/#System-Requirements

Enable Detaching on main server

Before you detach a license, you need to make configurations on the server in order
to enable detaching on your main server

To do that you need to login on the ACC license server and select the menu
“Configuration” and select the tab “Detachable Licenses”

1. Allow Remote Access to ACC as HTTP or HTTPS

2. Set Password

Sentinel Admin Control Center

Configuration st Name winsrv-2022

Sentine! Keys
Basic Settings Users Accoss 1o Remate License Managers Access from Remote Clients Client Mentities Detachable Licarses Netwark

Products

Features

Sessions S HTTP

Update/Atiach HTTPS

Access Log

Diagnostics

ACC server configuration for HTTP or HTTPS access

3. Go to the Detachable Licensing Tab

Please activate the checkbox “Enable Detaching of Licenses”. You can determine the
maximum detach duration in days.

Additional you can set the number of licenses you want to keep on the server (to be not
detachable) in the field “Reserved Licenses”. Here you can enter either an absolute
number or a percent value. .

If you want to do different settings for your different products, you can do this by click on
the button “Per-Product Settings”.



M) BB Thaies Sentinel ACC: Configurat X | = SIS

& (&) D) localhost:1947/_int_/config_detach.htr % = 9 @

Sentinel Admin Control Center

Configuration Host Name: winsrv.2022

Sentinel Keys
Basic Settings Users  Access to Remote License Managers  Access from Remote Clients Client Identities I Detachable Licenses I Network
| S ——
Products On-Demand Detaching of Licenses
Enabled — /]
Features
Maximum DUralion ©  ee—— 14 days
Sessions
Automatic Detaching of Licenses
I B
Update/Attach Enablad =
Allowed Offiine Duration @ 2 | hours
Access Log
Common Detach Settings
Configuration Reserved Licenses © 10 but at least |0 % of total licenses
Per Product Settings Configure |
Diagnostics

@ 2021 Thales Group. Al Rights Reserved English: Espaiol Frangais ltalia * Pyccxuin Run-time Installer 8 21.116380 1

ACC Detach license tab

Configure Detach tool
The tool has to be configured on the workstation

Open Reqedit\AddOn\Lm\RegEditLm.exe.config



s Lm

“ Home Share View

« v. 4 » ThisPC > System (C:) » RegRdit » ReqEdit 217 » AddOn > Lm
Name Date modified Type
# Quick access
de-DE 58 AM
[ Desktop
apidsp_windows.dll PF o
¥ Downloads apidsp_windows_x64.dll 0/26/2( 22 PM Application exte
5| Documents config.dat 2/5/2021 2:43 PM DAT File
& Pictures hasp_net_windows.dll
Lm (] hasp_nt 2:52
L hasp_windows_113498.dIl 0/26/2021 5:23 PM
I‘ Music hasp_windows_x64_113498.dII
. haspvlib_113498.dll
# Videos
& logo 2 PNG File
@ OneDrive Q ReqEditlm 418 PM pplication
' RegqEditLm.exe.confi 1 21 2:03 PM KB
@ This PC = 2
ReqEditShared.dll 3 4:18 PM B
g¥ Network sntl_adminapi_net_windows.dll
sntl_adminapi_windows.dll 4 2 11 AM Applicat
sntl_adminapi_windows_x64.dll 4 2021 11 AM Application ext
WpfControls.dil
17 items 1 item selected 2.53 KB

RegEditLm.exe.config location in Windows Explorer

Set server address to the ACC server

serverAddress - 10.0.0.10 or the FQDN like: server.localdomain.local

<setting name="LicenseServerAddress" serializeAs="String">
<value>server.localdomain.local</value>

</setting>

Generate config.dat

regeditlm.exe -pass password -out config.dat

password - the access password for ACC server (that was set in the previous steps)
outfile - config.dat the file that will be used in the config xml

NOTE: If you want to use different out file please update the xml to use that
To use the Detach Tool please open Users Guide
License Updates

If your license is arriving the expire date or even some days before we will provide you
an update key (file ending .V2C) and you request a new one.


https://documentation.reqteam.com/license-detach-utility/

A. You do not have a license manager installed (no ACC)

You need to activate this license with your "LicenseActivation” tool from ReqEdit client.
Select offline activation and press the "Activate" button and select the V2C File to update
your license.

Online Activation Offline Activation License info

License request

1. License Request (C2V) () First install © Update

Generate

License activation
2. License Response (V2C) Activate

V2C output

Close Cancel

Update License window

At an online workstation login with Product key at the Sentinel EMS Customer portal

https://license.reqteam.com/ems/login.html

Sentinel EMS

ENTITLEMENT MANAGEMENT SYSTEM

Customer Portal Login License Update
Product Key:ﬁ ]

@ 2021 Thales Group. All Rights Reserved. | S

English Italiano Pyccxwe Francais sa3y Deutsc

Sentinel EMS Login


https://license.reqteam.com/ems/login.html

Choose Offline Activation tab. A new window appears.

In the Generate License window upload the saved C2V file.

Then click Generate.

Order Details
Product Key:
Customer: Botond Horvath E-mail: b.horvath@innov...
Activations: Unlimited Remaining Unlimited
Activations:
RefID 1: RefID 2:
Entitlement
Comments:
Froech: Product Lock Type
Ultimate User License 10/2021 SL-UserMode
Download RUS, a tool to generate C2V
Upload C2V
Upload/C2V: Test_Offiine_Activation.c2v — |
Comments:

Uploading the .c2v file

The Key ID. appears

Download the V2C file

Key ID Lock Type Activation Date ‘Comments Download

SL-UserMode 2021-12-09 V2C File

Downloading the V2C file

Go to the License Activator window and press Activate button



| Oniine Actvation License o
License request 1
1. License Request (C2V) O First install O Update

Generate

& Select location for the V2C file

& pi i 1A @l > ThisPC > Desktop v C Search Desktop el

Organize v New folder

]
4

!

©

A~
Name ¥ Date modified Type Size
v Quick access

) 66197427586066... 12/

V2C File — 3 8KB
il Desktop

& Downloads  #
= Documents
PN Pictures
@ Music
& Videos

> @ OneDrive

> [ ThisPC

> & Network

File name: v ‘ Vac file (*.v2c) v

| 0 I C |
s pen ancel

Activate offline with key

In the Browser window select V2C file

Press Open



@ License activator - X
Online Activation Offline Activation  |icense info

License request

1. License Request (C2V) © First install (O Update
Generate

C2Vfile C:\Users\Bryan\Desktop'\Test_Offline_Activation.c2v successful generated. Please upload this fil
hitps://license reqteam.com/ems/customerLogin html to activate your license

! Please use your product key as login

License activation

2. License Response (V2C)

License sucessfull activated

Close Cancel

License activator window, offline activation tab, license activation success

Open ReqgEdit and start working with it.

B. You have a license manager installed and you don't have a V2C file

Alternatively you can update automatically if you have installed a license server (Admin
Control Center in the minimum version 8.31) on the computer that holds the license. You

need to open the url https://license.regteam.com/ems/customerLogin.html on this
computer and click license update.

Sentinel EMS

ENTITLEMENT MANAGEMENT SYSTEM

Customer Portal Login License Update

Click Update Licenses to automatically check for and install any licenses that ara

available for the connacted key.
Update Licenses

© 2021 Thales Group. All Rights Reserved. | Support ﬁ

EMS Login


https://license.reqteam.com/ems/customerLogin.html

C. You have a license manager installed, but with no or restricted internet acces

Login to Sentinel EMS Customer Portal. Open the
url https://license.regteam.com/ems/customerLogin.html and enter Product Key.

Sentinel EMS

ENTITLEMENT MANAGEMENT SYSTEM

Customer Portal Login License Update
Product Key:[; ]

© 2021 Thales Group. All Rights Reserved. | S

Er.j[ sh Iigliano .[:,_.,'H. =randi euisU
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Sentinel EMS Login

e C 1) localhost:1947/_int_/devices.htm Yo o= ® :

Sentinel Admin Control Center ©Help

Sentinel Keys Host Name: winsrv-2022

| Sentinel Keys

Location Vendor KeylID Key Type Configuration Version i Actions
Products Local (11113;495?8) HASP SL AdminMode [F5J 832 [Products | [Features| [Sessions) [Centicates || & C2V |

Features

Upload the C2V file to Sentinel EMS. Press Generate for generating v2c file.


https://license.reqteam.com/ems/customerLogin.html

Order Details
Product Key:
Customer: Botond Horvath E-mail: b.horvath@innov...
Activations: Unlimited Remaining Unlimited
Activations:
RefID 1: ReflD 2:
Entitlement
Comments:
Frodet: Product Lock Type
Ultimate User License 10/2021 SL-UserMode
Download RUS, a tool to generaie C2V
Upload C2V
Upload C2V: | 7est_offine_Activation.c2v ——r | =
Comments:

EMS C2V file upload

Download the generated V2C file.

Key ID Lock Type Activation Date ‘Comments. Download _

SL-UserMode 2021-12-09 V2C File

Download V2C file

Upload the generated .v2c file to your local server ACC in the menu "Update/Attach".



< C @ localhost:1947/ int_/checkin.htm

Sentinel Admin Control Center

Update/Attach License Host Name: win-newdev

Sentinel Keys

Select File |[SelectFile_. | @

File Format: a V2C, V2CP, H2R. R2H, H2H or ID file

Products
Features
Sessions
Update/Attach
Access Log
Configuration
Diagnostics

ACC server update/attach v2c file

Transfering License

To transfer an user license from an old PC to a new PC you need the RUS tool on both
PCs.



Public Internet

{ ReqEdit License server J

RUS Tool
l DOWNLOAD l
NEW OLD
Desktop Machine Desktop Machine
—) Documents.id >
RUS Tool RUS Tool
« license.h2h <4

License transfer diagram between two machines

Download RUS Tool
You can download it from our customer area:

https://license.regteam.com/ems/customerLogin.html

For login you need to enter your product key, use the key you already used for
activation.

After login you click on Offline Activation button and download the RUS tool.


https://license.reqteam.com/ems/customerLogin.html

Order Details

Product Key:

Customer: Botond Horvath E-mail:

Activations: Unlimited Remaining
Activations:

RefID 1: ReflD 2:

Entitlement
Comments:
Products: Produict

Ultimate User License 10/2021

I Download RUS, a tool fo generate C2V I

b.horvath@innov...
Unlimited

Lock Type
SL-UserMode

Upload C2V

Upload C2V:

Comments:

Download RUS tool

Generate ID file

Generate

IF YOU USE ACC (LICENSE SERVER)

Cancel

For transfering License from a Network license server to another , you need to have a

Rehostable license.

Open ACC on the new server to generate the ID file

Go to Diagnostics of your license server and click on "Create ID file" button on the top

right of the page



Sentinel Admin Control Center

Diagnostics Host Name: win11.pc

Sentinel Keys
License Manager Version 26.0 Build 123582

Computer Name

Products Host Operating System
Features Protocols
License Storage Secure, Schema 1
Sessions Unkriown
Authorized Vendor IDs NA
Update/Attach Uptime 3 hours 50 minutes 55 seconds, local time 2022-04-05 14:11:25
Template Sets _int_de.17.0.alp,es.17.0.alp.fr.17.0.alp.it.17.0.alp ja.17.0.alp,ru.17.0.alp,zh.CN.17.0.alp
Current Template English 17 (30 September 2021 Build 1)
Access Log
Current Usage 0 logins, 0 sessions
s (0 peak i S )
Configuration Login Requests 0 (0 peak simultaneous logins)
Requests 349 local. 15 remote, 364 total
Data Volume 3,445,635 received. 5,661,447 transmitted
Errors 0 Key related. 0 in Transport
Threads 1 (7 peak), 0 regisec, 0.0 ms 90th, 0% usage
Storage 0 reqgisec, 0.0 ms 90th, 0% usage
Memory Used 8,847,649 (4.417 blocks)
Run-time Run-time Installer  8.31

Run-time Package 8.31

Generato Report

£ 2021 Thales Group. All Rights Reserved English euts spaiiol  Francais Italiar EAE — .

Generate ID file for license transfer

Save the file generated.
IF YOU DON'T USE ACC (LICENSE SERVER)

Execute the RUS tool on the new PC, where you want to have the license transferred.
Select the Transfer License tab. Please press on the [...] button to select the location
and choose a name for the Recipient Information ID file (the name of the file is not
important).

Press Collect and Save Information to generate the file. If the process was successful,
you will get a confirmation window.



¥ RUS

Collect Status Information ~ Apply License File

Collect information about the recipient computer

collect and save information about the computer.

Transfer License

To transfer (rehost) a license from one computer to another, you run the RUS program on both
computers. On each computer, select the Transfer License tab and perform the appropriate step.

Step 1: On the computer to which you want to transfer the license (the “recipient computer®),

Save redpient information to | C:\Users\tibi\Downloads\Documents.id

<&

Generate the license transfer file

Step 2: On the computer that currently contains the license (the “source computer®), select
the license to transfer, read the recipient information file and generate a license transfer file.

Key Type Key ID

Products

Read the recipient information file from

Generate the license transfer file to

Generate ID file

Copy the generated Recipient ID file to the old PC, where the active license is.



Please do not close the RUS tool on the new PC, we need it for later.
Generate license transfer file
Run the RUS tool on the OLD PC.

Select the Transfer License tab. Check if your license is transferable, it has to be listed
in the license list.

Note: If the license is not transferable you need to contact the REQTEAM support team
to initiate a manual transfer.

Note: if you use ACC you need to have Rehostable license.

Sentinel Keys Host Nams: winsrv.2022

Location Vendor Key 1D Key Type Configuration Version Sessions Actions

Loca) Behostable g 82 1 [Products] [Features | [Sessions ] [Ceriicates | [& C2V]

Rehostable license icon for ACC user

Select the license you want to transfer from the list
Select the Recipient Information ID file copied from the NEW PC.

Select the destination of the Transfer License File, by selecting the [...] button.
Press Generate License Transfer File button.

The .h2h file needs to be copied to the NEW PC.



# RUS - O X

Collect Status Information ~ Apply License File ~ Transfer License

To transfer (rehost) a license from one computer to another, you run the RUS program on both
computers. On each computer, select the Transfer License tab and perform the appropriate step.

Collect information about the recipient computer

Step 1: On the computer to which you want to transfer the license (the “recpient computer”),
collect and save information about the computer.

Save redpient information to ]

Generate the license transfer file

Step 2: On the computer that currently contains the license (the “source computer®), select
the license to transfer, read the recipient information file and generate a license transfer file.

Key Type Key ID Products
Premium Ultimate

Read the recipient information file from |C:\Users\tibi\Downloads\Wirking_PC.id \

s

Generate the license transfer file to  \Users \tibi\Downloads \Moved_license.h2h

Generate license transfer file

You can close the RUS tool on the OLD PC.



Activate license transfer file
IF YOU USE AN ACC (LICENSE SERVER)
Upload the generated H2H file in your new ACC in the menu "Update/Attach”.

Sentinel Admin Control Center

Update/Attach License Host Name: winsrv-2022

Sentinel Keys

Select File: | B ) ) Select File... |©®
File Format: V2C, V2CP, H2R, R2H, H2H or ID file

Products

Features

Sessions

Update/Attach

Access Log

Configuration

Diagnostics

Attach the h2h transfer license file

IF YOU DON'T USE ACC (LICENSE SERVER)
On the NEW PC in the RUS tool select Apply License File.
Press the [...] button to select the .h2h transfer license file and press Apply License.

The output should look similar to the screenshot.



# RUS - O X
Collect Status Information Apply License File Transfer License

Rehosted License

source_host win-newdev
recpient_hostdesktop-win10-dev
rehost_time  Fri Oct 22, 13:16:43 UTC
vendor 113498

vendor_id 113498

hasp_id 574453933

Update File |C:\Users\tibi\Downloads\Moved_license.h2h E

Apply Update

Transfer successfull

Licence update without a licence manager installed (no
ACC)

Use case:

License update in case of no license manager installed and more than one PC with
ReqEdit installed. The firm becomes the necessary .v2c files for license updating from
REQTEAM, conform the license IDs. Each .v2c file is for the PC with the same KeyID.
1. Find the KeyID info.

In File RegEdit/LicenseActivation.exe.config  change settings to ForceStart.

<setting name="ForceStart" serializeAs="String">

<value>True</value>
</setting>

Than click on Regedit / LicenseActivation.exe
On the License info Tab you can find the Key ID of the certain PC



Q License activator - D2S

Online Activation Offline Activation License info

License Info: © Build in license server () Extemal license server

Connection to build in license server was successful
aget key Information from server

Get product Information from server for the key
Feature information for products:

Get info to Product 1D:37

<hasp-info>
<hasp>
<index>1</index>
<vendomame>113458</vendomame>
<vendorid>113458</vendorid>

<haspid>321 /haspid>
<typename>HASP-SL-AdminMode </typename>
docal>127.0.0.1</local>

imware >8.32</fimware>

<sessioncount >3</sessioncount >
<disabled>0</disabled>

<sessioncount >3</sessioncount>

——d.a

License activator - license info

2. From the .v2c files that REQTEAM sent to you choose the one with the same KeyID
numbers.

3. Goto LicenseActivator and click on the button Activate.



Q.
| Oriine Activation License ifo
License request 1
1. License Request (C2V) O First install O Update

Generate

& Select location for the V2C file

& pi i 1A @l > ThisPC > Desktop v C Search Desktop el

Organize v New folder

]
4

!

©

A~
Name ¥ Date modified Type Size
v Quick access

) 66197427586066... 12/

V2C File — 3 8KB
il Desktop

& Downloads  #
= Documents
PN Pictures
@ Music
& Videos

> @ OneDrive

> [ ThisPC

> & Network

File name: v ‘ Vac file (*.v2c) v

| 0 I C |
s pen ancel

Update license process through offline activation

Choose the .v2c file for that PC.

Click Open



Q License activator — X

Online Activation Offline Activation  |icense info

License request

1. License Request (C2V) © First install (O Update

\

Generate

C2Vfile C:\Users\Bryan\Desktop\Test_Offline_Activation.c2v successful generated. Please upload this fil
hitps://license reqteam.com/ems/customerLogin html to activate your license
Please use your product key as login

B

License activation

2. License Response (V2C) Activate

License sucessfull activated

I Close Cancel
B B AR 4

Successful license updating message.

RegEdit downgrading functionality

The RegEdit Premium license can be functionally downgraded to a Basic or Reader
license. This requires the delivery of a special software which contains a special
"config.svk" file. This file determines the restriction of Premium functions to Basic or
Reader.

To obtain these deliveries please ask your RegEdit sales partner or the REQTEAM
support.

Add "config.svk" to the delivery

Create a new folder for ReqEdit.

Install RegEdit Premium in this folder.
Copy the file "config.svk" in the folder.
Make sure the user cannot edit the folder.

PonNPE

Links

What are links?

Relation between objects are called links. Each object can have incoming and outgoing
links to / from other objects.

In ReqlF files links are stored in named LinkSet definitions which basically are a group of
specific links between objects.



For example: Satisfies LinkSet has links that are between objects of use cases and
tehnical definitions

How links are displayed in ReqEdit?

If an object contains links, a link symbol and arrows indicating the link type are displayed
inside the status indicator column. The red arrow indicates an incoming link and the
green arrow indicates an outgoing link. If an object contains both types of links, both
types of arrows are dispalyed.

Main Column

&
« Introduction

User requirements

2 - Define Graphics

& 2.1 - Bound Context

L. ] Copyrow
fo Cutrow

Paste row >

2.2 - Relate / Cor,

.| CopyReqlFID

Insert row before
Insert row after

%4 Insert child row

2.3 i Show Trans Mark row as deleted

Restore soft deleted row

F'urge selected row

Set default value

il
1l

Promote

2.4 - Show Circur .
Expand IBM DOORS Table

G2 Addlink »
Add external link...

= = Edit external links...

3 - Bul Id D 1aQ & oeeteiink.

I‘Q Go to links » I & Gototarget: User requirements

2-9 Go to source: Introduction

ReqEdit displaying context menu for an object with links



Go to links

To follow a link to its destination or source, you have to perform a right click on the
object row and go to the ,Go to links” menu item. A submenu will open and dispaly the
available links. A submenu item contains a symbol for incoming or outgoing link and
according text ,,Go to source” or ,,Go to target” and also the object text (in case there is
any available) or the ReqlF ID of the source or target object.

A link can be incoming from or outgoing to an object from the same document but also
to another document. When clicking on a link in the submenu, the linked item will be
selected and displayed on the first row in the grid. If the linked object is contained in
another document, the program will automatically switch to the document’s tab and
select the linked object. If the document containing the linked object is not opened in
RegEdit, the program will ask if you want to open it.

NOTE: Currently we only support links between objects inside the same ReqlF file. If an
object contains a link to another ReqlF file, the text , The target is placed in an outer
file...” will be displayed in the links menu.

Links administration

The link administration tab can be accessed from the “Document Settings” window.



@ Document Settings

Creation tool: ReqEdit
Source Tool ReqEdit
Number of documents: 1

Conversation ID:

Documents: Test file for import excel
Display as headina: Display as description:
Req|F ChapterName ~  ReglF.Name

Attribute Types  Attributes  Document  Links

Link sets: ReqEdit Links

Identifier: _639d1d4-3db4-4272-ab 36-daadbdf ae 86F
Last change: 2023-03-07T11:57-51+02:00

Link set name: ReqEdit Links

Description: Link module created automatically by ReqEdit

Source document:  Test file for import excel
Target document: Test file for import excel

Related links:

Identifier Link name

|_b7bdfo5-f6e3-4216-b146-3c5aa7ael... |Link 1
_4fbd928-d6de-4c56-b96¢-0bf382242... |Link 2
_16b720d-8ddd-43a1-b93¢-8a577ff94... |Link 3
_07bcf53-5494-4a3e-b193-05299939... |Link 4

ReqEdit link settings window

Generate ID
Display as text:
v~ ReqlF.Text
Related link details:
Identifier: _b7bdf95f6e3-4216-b146-3c5aa7ae
Last change: 2023-03-07T11:57:51+02:00
Link name: Link 1
Description:

Source object ID: _6be2293-5238-4ed5-8eab-f5c0f 7bk
Name: Agreed

Target object ID: _aalf 7bf-5895-43b4-8095-e05edc9z
Name: Agreed
Link type ID:
Name:
Save Cancel

In this section, all link sets related to the selected document can be viewed and
administrated. You can change the link set name and description and also edit each
individual link’s name and description related to that link set.

Add links

In order to create a new link, first you have to create a “start link” by right clicking on an
object and then going to the “Add link” menu and clicking on “Start link” in the submenu.



| Copy row
o Cutrow

Paste row >
| CopyReqlFID

Insert row before
Insert row after

94 Insert child row

@ Mark row as deleted
Restore soft deleted row

Purge selected row
Set default value

Promote

(%
Il

Demote

Expand IBM DOORS Table

|2 Addlink v Start link

Add external link... End link

Edit external links... Remove start link
2 Delete link...

(_-}7 Go to links

Create link of an object

After creating the start link, an icon will appear in the status column of the source object.

The next step is choosing a target object for the link. You can do this by right clicking on
an object and selecting “End link” from the “Add link” submenu.

Next, you can add links to some other objects starting from your source object, by
repeating the last step. After you added all your links from the source object, you can
click on the “Remove start link” menu item from the “Add link” submenu.

After removing the start link, you can add a new one to another object.

External Links

ReqEdit offers you the possibility to store external links in your ReqglF document. This
can be either an OSLC or a Web URL. Please select in the row you want to link and use
the right mouse click to open the related menu and select the entry “Add external link”.
After selection, you will see this input dialog.

You can define with the long name a display name for the link. In the field URL please
enter a valid URI (including protocol prefix like http:// ). The field link type is optional, and
should be used to classify links (like derives, implements).



For the link direction, you can choose between INWARDS and OUTWARDS. The
selection has no impact on the function, it is just a semantic. The field technology
determines how the link is intended to be open. Currently all links will be opened with
your default browser.

You can add an additional description to the link as well. If you now press “Save” button,
you will see the link in the Go to links menu with the selected name. If you don’t define a
name the URI will be displayed.

If you want to edit the external link, than please select in the right click menu the entry
“Edit external links” and select the link you want to edit:

If you click on the edit button, then you will get the same dialog described before. Here
you can edit all the properties of the external link.

Please take in consideration, that this feature is not implemented currently by all
tools, that support ReqlF. This information may get lost if you import the ReqlF file
generated by ReqEdit to other tools, that not support this feature.

Delete Links

In order to delete a link, you have to right click on an object that contains one or more
links and go to the “Delete link...” menu item. After clicking it, a window containing all
links of the object will be displayed.

Only outgoing links can be deleted from an object. If you want to delete an incoming link,
you have to delete it from the source object.

For deleting outgoing links you have to select them by clicking on the checkbox at the
beginning of the rows and click on the “Delete” button afterwards.

Incoming links have a grey background and cannot be selected.
Error reporting

Crash reports

When a fatal crash happens, ReqEdit tries to collect non sensitive information about the
situation. A notification asks to send the crash report to REQTEAM ticketing system for
analysis.
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Y Error report X
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ReqgEdit has encountered a problem and needs to be closed.

Please send the emor report to the ReqEdit Support Team and we will fix the problem as soon as possible.
The emor report does not include any content from your documents, just information about the actions that
took place before the emor occumed.

Copy to clipboard Dont send

ReqEdit fatal crash popup window

Contact support

For any questions use the documentation platform https://documentation.reqgteam.com.

Or contact RegEdit Support for assistance through email to: support@reqteam.com.
Notices and Limitations

Specification document naming

Document names can only contain alphanumeric, space, period, underscore, hyphens
characters.

Logging

ReqEdit is producing a non-sensitive action log (does not contain actual values only
action names) of each opened document.

The log files can be found here %AppData%\..\Local\ReqEdit\ReqEdit\Logger

The log file is really helpful for analysis when RegEdit crashes.

OLE Objects

OLE was is a proprietary technology developed by Microsoft that allows embedding
and linking to documents and other objects.

Only ReqlF Archive .reqifz files support this feature
Import large OLE Files in RegEdit
In some cases memory limitations will limit the OLE object conversion, in this case the

OLE object will be wrapped inside an RTF file. Opening the OLE objects will only be
possible through MS Word.


https://documentation.reqteam.com/

For any OLE conversion ReqEdit needs the memory 20 times the size of the OLE object.
Import large OLE Files to DOORS

Exported files that have OLE objects larger than 40-45MB cannot be imported into IBM
DOORS that is connected to IBM DOORS server 9.5.

Preview

ReqEdit is not able to generate preview images during imports or if they are directly
added in the application. A file-type icon will be displayed instead.

Handling

Atego Requirements Synchronizer version 2.4 and IBM Rational DOORS 9.5.2. OLE
objects can be imported and opened by ReqEdit.

DOORS roundtrip

o Export always to an empty directory then archive only the contents of this
directory to a zip file

o Check if the ReqlF file and all of the OLE objects are in the root folder of the

archive

Rename the file to .reqifz

Import this file to RegEdit

Edit the file

Export the file to to IBM Rational DOORS

Import to DOORS 9.4

Extract the RegEdit exported file to an empty directory before importing to DOORS

If exports are done directly by IBM Rational DOORS, in most of the cases DOORS will
not make the preview images. Only a small broken link icon is displayed as a preview

image, but the linked OLE object still exists in the export.

Don’t delete the broken image icons, it is important for the linked OLE object.

Copy / Paste
Copy-paste from external sources will try to keep all formatting from the text.

Image or file copy-paste is partially supported. Drag & Drop of images from external
applications like browsers are not supported.

Copy and paste of complex tables may occur problems with ReqEdit.

Limitation of entire function of copy paste on Windows Servers, because of limitation of
the Internet Explorer on the server. For detailed description of limitations click here.


https://documentation.reqteam.com/windows-server-2019-2022-copy-paste-limitation/

Open and save files from ReqEdit Add-ons

The limitation can affect all ReqEdit Add-ons (Excel import, View manager, Compare,
XML Editor) where it can not open or save files from / to a network share, which is
connected with other user credentials, than the Windows current user.

For detailed description of limitations in the Excel importer Add-on click here.

Add-on for Weak-word analysis
Weak words are words that are confusing for readers and should be avoided if possible.

This tool provides a case insensitive whole word search for this purpose, optionally
writing the results back in the ReqlF file.

Analyze weak words

Start ReqEdit and open any ReqlF file. Select the specification document that needs to
be analyzed. Select Add-ons > Weak Word Analysis.

€ Weak Word Analysis Settings — O >
Analysis settings

Select dictionary Deutsch A

= it

3 Save status to attribute

i Write status Select status attribute WeakWord Analysis
2
Set value on match Found -
Set value an no match Mot found -

Write match information to attribute
Write match log Select log attribute Strong WWF W

Log o match'
Ovenwrite value

I
!
I Help Execute analysis Cancel
1

ReqEdit Weak Word Analysis tool window


https://documentation.reqteam.com/excel-importer-add-on/#Limitations

Language selector — displays the configured dictionaries from the RegEdit.exe.config
file

Write status — update a specific enumeration attribute if there is or not a match in the
dictionary

NOTE: Write status for multi value enums will add the selected value, existing
values will not be removed. This can be useful for status fields that are used for
other markings as well.

Write match log — update an XHTML attribute with the analysis result, optionally
overwriting the contents in the selected attribute

Log "no match" - write in the attribute when no match is found

& Weak word analysis result - O *

Found weak word ‘spezifiziert’ in object with the id "461091"; Matches found: 1; Note /Selution: Starkes Weakword: Deutet auf LSV Prozessthema hin, auch
Hinweis auf unklare Anforderung.

Mo weakword match for object 461052

Mo weakword match for object 461275

Found weak word ‘definiert” in object with the id '461744", Matches found: 1; Note /Solution: Starkes Weakword - solte vermieden werden, bitte andere
Formulierung wahlen.

Found weak word ‘gestelt”in object with the id '461744", Matches found: 1; Note /Solution: Stafkes Weakword: Deutet auf L5V Prozessthema hin, auch
Hinweiz auf unklare Anforderung.

Mo weakword match for object 461745

Found weak word Vereinbarung' in object with the id '461746°; Matches found: 1; Mote /Solution: Starkes Weakword: Deutet auf LSV Prozessthema hin, auch
Hirweis auf unklare Anforderung.

Mo weakword match for object 461276

Found weak word ‘definiert” in object with the id 461747 Matches found: 1; Naote /Solution: Starkes Weakword - solte vermieden werden, bitte andere
Formulierung wahlen.

Mo weakword match for object 461748

Found weak word Testzulegen'in object with the id ‘462153, Matches found: 1; Note /Salution: Starkes Weakword - solte vermieden werden, bitte andere
Formulierung wahlen.

Mo weakword match for object 462154

Found weak word *__"in object with the id '462155"; Matches found: 2; Note /Solution: Starkes Weakword - solte vermieden werden, bitte andere Formulierung
wahlen.

Found weak word ‘auszulegen’ in object with the id '462155", Matches found: 1; Note /Salution: Starkes Weakword - solte vermieden werden, bitte andere
Formulierung wahlen.

Mo weakword match for object 461745

Found weak word Testzulegen' in object with the id '462156", Matches found: 1; Note /Salution: Starkes Weakword - solte vermieden werden, bitte andere
Formulierung wahlen.

Found weak word ‘notwendigen’in object with the id "462156"; Matches found: 1; Note /Solution: Starkes Weakword - solte wermieden werden, bitte andere
Formulierung wahlen.

Mo weakword match for object 462157

~

Save log to file Close

.

RegEdit weak word analysis progress window and log

Analysis progress and log is displayed in real-time. After completion the log output can
be saved as a file with [Save log to file] button

Analysis result in ReqlF

When Write match log is enabled, the ReqlF file will be updated with the current results
of the analysis.



Main Column Strong WWF

based on Volere 2021.09.15 12:41: No weakword match for this object.
Requirements Specification Template Edition 15—March 2020

Volere is the result of many years of practice, consulting, and research in requirements 2021.09.15 12:41: found ‘also’ in main column 1 times.
engineering and business analysis. We have packaged our experience in the form of a generic Note /Solution: Strong Weakword - should be avoided,
requirements process, requirements training, requirements consultancy, requirements audits, a please choose another wording..

variety of downloadable guides and articles, and this requirements template. We also provide
requirements specification-writing services.

The first edition of the Volere Requirements Specification Template was released in 1995. Since
then, organizations from all over the world have saved time and money by using the template as
the basis for discovering, organizing, and communicating their requirements.

The Volere web site www.volere.co.uk contains articdles about the Volere techniques,

2021.09.15 12:41: No weakword match for this object.

1 - Project Drivers

2021.09.15 12:41: No weakword match for this object.

1.1 - The Purpose of the Project

Lorem ipsum dolor sit amet, consetetur sadipsang elitr, sed diam nonumy eirmod tempor
invidunt ut labore et dolore magna aliquyam erat, sed diam voluptua. At vero eos et accusam
et justo duo dolores et ea rebum. Stet clita kasd gubergren, no sea takimata sanctus est
Lorem ipsum dolor sit amet. Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam
nonumy eirmod tempor invidunt ut Iabore et dolore magna aliquyam erat, sed diam voluptua.
At vero eos et accusam et justo duo dolores et ea rebum. Stet dita kasd gubergren, no sea
takimata sanctus est Lorem ipsum dolor sit amet. Lorem ipsum dolor sit amet, consetetur
sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam
erat, sed diam voluptua. At vero eos et accusam et justo duo dolores et ea rebum. Stet clita
kasd gubergren, no sea takimata sanctus est Lorem ipsum dolor sit amet.

Weak word analysis tool result attribute on the right side

Expert knowledge

Dictionary

Dictionary file/s must be created in the ReqEdit/Dictionary folder and has to follow the
following format:
<Lowercase word><TAB><hint>

should Strong Weakword; should be avoided, please choose
another wording.

about Strong Weakword; should be avoided, please choose
another wording.

Only one word per row.

NOTE: If the hint is not present the analysis still works but the report will be empty
for it.

Dictionary config

Edit RegEdit.exe.config and set the WeakWordList to use the dictionary files

<setting name="WeakWordList" serializeAs="String">

<value>Deutsch, weakword list de.txt;English,weakword list en.txt<
/value>
</setting>




The dictionary files has to be added in the following format:
<Language selector label>,<dictionary file name in Dictionary folder>;

There must be at least one dictionary to use the tool. The dictionary should be saved in
a text file with UTF-8 encoding.

Only Main Column is used for analysis other attributes are not processed.
Dictionary contents is filtered and only unique word+hint pairs are used.

The tool is searching only for whole words in the Main Column contents.

The search is case insensitive regex search.

All text is converted to lowercase internally and matched with the lowercase weak words.

Weak word | Text Result
go | will GO TO THE office then go home |2 Found
go John goes to the office Not found

Status updates
Single value enumeration attributes will have the value from the configuration.

Multi value enumeration attributes will receive the configured values, but the previous
values will not be removed from it.

Notices and limitations

If the weak word add-on menu is not active it can have several reasons:

e You do not have the necessary license
e There are no ReqlF files opened
o ReqEdit.exe.config is not configured

The tool was tested in UTF-8 character encoding, using other encodings can produce
unintended results.

Excel importer add-on

Convert a single MS Excel file with XLSX extension to a ReqlF Archive file (.xIsx to
.reqifz)

Usage

Start the Excel Importer add-on by selecting Add-ons > Excel add-on.



£ Excel Import G O

Excel File \WINSRV-2022\Storage\Test Folder Access\Melinda\MELINDA General\Test Select Help

Sheet Configuration  Excel sheet preview
Step 1: Sheet selection Messages

SHEET 1 v
(CJ) Ignore Sheet

Step 2: Set header row

Reset messages display Open log directory
Header Row Number 1 4
Row Column Step 3: Configure attributes
Fi 2 B (1 =
ik : Column Name :;goTS:n Data type Refrence
To 39 2 |20 e - ] - —
: » Wy D | O |Integer v (1
Set value 2 ‘ Unique ID | O |integer v |1
j IF I T v : .
Step 4: Set main column (optional) t 3 - Ohject Feall 1D [_3- ~—e§t7 - ———l“dazdy e
|—‘ 4 ReqlF ChapterName ) |Text v
i | 4 5 ReqlF Text O |Ten 9
<None> 5 ReqlF.Name O |Text | Name 1
Tex | V] 7 |Comment O |t v|
|8 Formulas O |[Text v
| ot e i
Step 5: Set id field (optional) |9 RegEditID [0 |integer |20
‘ Enable round trip . 10 | ReqEditModifiedOn @] Pate _ 13'27.04,2022 174..
11 ReqEditModfied Text v | Melinda
ID Field | B O | ‘
Load config Save config Import Close
| Copyright 2022 REQTEAM GmbH Licensed for:

—

ReqEdit Excel importer add-on

Sheet Configuration tab

Step 1. Sheet selection
display the specific sheet to configure, check Ignore Sheet to skip conversion

Step 2. Set header row
select a header row that represent the attributes (table header)

Set import data range
Set the first and last cell coordinate of the converted worksheet section

e Row is row in the excel sheet (1-1048576)
e Column represents the number of column in the excel spreadsheet (A=1, B=2...
XFD=16384)



£ Excel Import - O

Excel File C:\Users\Melinda\Desktop\vegyes exceles'\Excel test file for import 15.35xlsx Select Help

Sheet Configuration  Excel sheet preview

Step 1: Sheet selection Messages

Sheet1 v
() Ignore Sheet

Step 2: Set header row

Reset messages display Open log directory
Header Row Number 1 =
BT Vi Step 3: Configure attributes
Fi 2 1 =
rom —— Column Name Ignore Data type Refrence
column
To 39 = 120 = : - — -
> 1 Hierarchy 1D [ |integer v |1
Set value 2 | Unique 1D [ |integer v |1
3 Object ReqlF ID | Text v | _cf32d3-86dd-4f.
Step 4: Set main column {optional) | iec ey :I | & 1=
o N—\ |4 ReqlF ChapterName [ |Text v
eqlF.ChapterNar - I T m—
Cpede Y 5 ReqlF Text O |Tex v
Level ID (opt.) || |v 5 | ReqlF .Name O |Text ~ | Name 1
Text :{:\leor;i;y D 7 Comment (O |Text v
Unique 1D ' .F I (] 'T Z|
ReqEditID »8 | Formulas |:| » ext
Step 5: Set id field (optional) 9 | ReqEditID [J |integer v |20
(7] Enable round trip 10 :Rquanod‘rfiedOn (J |Date v (27.04.2022 174..
— (11 ReqEditModifiedBy O |Text ~ | Melinda
D Field \ v v ' - '
Load config Save config Import Close

Step 3. Configure Attributes (center)

Column represents the number of column in the excel spreadsheet (A=1, B=2...
XFD=16384)

Name represent the Header Row Number from the Set header row section,
To ignore a column from import check the box near

Data type. Tool will try to guess the data types automatically based on the data type of
the first row of the import range.

e Boolean — true/false type values

e Integer — whole numbers

e Real — decimal numbers

o Date — date format

e String — single line text, no formatting

e Text — multi line text with formatting

e Enumeration — values can be one or more of a fixed set of values in all the rows
in a sheet. Single value if no separator is found. Multi value if separator is found [
, ; hewline ]. The conversion will combine all values found in all the rows
within a single sheet so it can be memory intensive if overused



Note: if the conversion is taking long use Integer (instead of Real ) and String
(instead of Text types)

For date type it is possible to define a default date, if date is not set in the Excel cell. To
set the Default date please edit "Excellmport.exe.config" in AddOns/Excel folder. Set the
config value "DefaultDate" to the date you want (format YYYY-MM-DD) and set the
EnableDefaultDate to "True".

Reference Shows the first data from the table
Step 4. Set main column

£ Excel Import 24 O

Excel File C:\Users\Melinda\Desktop\vegyes exceles'\Excel test file for import 15.35.xIsx Select Help

Sheet Configuration  Excel sheet preview
Step 1: Sheet selection Messages

Sheet1 v
(O] lanore Sheet

Step 2: Set header row

Reset messages display Open log directory
Header Row Number 1 B
Row Column Step 3: Configure attributes
A 2 B[ E
rom Column Name g}g: - Data type Refrence
To 39 B B : L ! b= ;
» i1 Hierarchy 1D [_) § |Integer 1
Set value |2 Unique 1D | (O |Integer |1
13 Object ReqlF ID O Text v | _cf32d ¥-86dd-4f.
Step 4: Set main column {optional) t e ey ! - s 1=
—— N*‘ |4 ReqlF ChapterName (O |Text v
eqlF.ChapterNar I T — -r
Copietiome. T 2= 5 ReqlF Text O |Ten v
Level ID (opt) || |v 6 ;F\‘quF.Name (O |Text ~ |Name 1
Text :—i:\le?:::;y D [7 | Comment | Text v |
Unique ID [+ 'F I [ HT t 3 v”
ReaEatiD 8 % omulas 9 e »
; |9 ReqEditID [J 20
() Enable round trip 110 | ReqEditModifiedOn O |Date v |27.04.2022 174..
R — I ReqEditModifiedBy (O | Text | Melinda
ID Field v - : ’ : —
Load config Save config Import Close

Set the type of ReqlF attribute of the imported excel data in the main column
e ReglF.ChapterName
e Level ID
o ReqlF.Text

Step 5. Set ID field
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Excel File \\WINSRV-2022\Storage\Test Folder Access\Melinda\MELINDA General\Test Select Help

Sheet Configuraticn  Excel sheet preview

Step 1: Sheet selection Messages
16:33:11 - Roundtrip is enabled: True
SHEET 1 Y 16:33:08 - Configuration saved to \\WINSRV-2022\Storage '\ Test Folder Access\Melinda
O lgnore Sheet \MELINDA General\Test folder Excel import\Config_Excel test file for import 25.07 xml

Step 2: Set header row

Reset messages display Open log directory
Header Rew Number 1 2
Row Colunn Step 3: Configure attributes
Fi 2 — $
o Column Name Lgor?gr:]en Data type Refrence
To 39 = (20 3 —
» Hierarchy ID J Integer v i1
Set value 2 Unique 1D [ |Integer v |1
: TR 3 Object ReqglF ID O |Text v ‘_cf32d3|-86dd-¥,
Step 4: Set main column (optional ! } — - !
‘—‘ 4 ReqlF ChapterName ] | Text v
CrepterName | | 5 | ReqlF Text O |[Tex v
None> 6 ReqlF Name O |Text ~ | Name 1
Text “ o 7 Comment O |Text v
8 Formulas [ | Text v
tep 5: Set i field (optional) 9  ReqEdtID (0 |integer |20
Enablz round trip 10 ReqEditModifiedOn O Date v 127.042022 174..
—_—m (11 ReqEditModified By O | Text v | Melinda
ID Field \ v - : - -
Load config l Save config ] Import Close
Copyright 2022 REQTEAM GmbH Licensed for:

To enable round trip, Save first config file

To enable Excel - ReqlF round trip, use Save config and save the config file on your
computer.

To reimport an Excel document you click on Load config with the saved Config file from
the previously saved.

You must select an ID field from the Excel file, if the section is active. The data type of ID
Field must be Integer.

Note: The ID cell must have unique value on each excel workbook, to be possible
automatically identification of the specific data row.

Details on the roundtrip: the activation of the Roundtrip configuration forces the
application to use the stored ReqlF-IDs in the configuration file during the reimport of a
"known" Excel file. So the resulting ReqlF file will have identical IDs for all attributes and
data rows. RegEdit ReqlF compare will be possible this way and also the import in an
external RE tool will update existing content instead of recreating it.

Not activating this optional functionality, the new ReqlF file will be generated with new
randomly generated IDs.



Configuration reuse

The tool lets the user save file conversion configurations and reuse them later. This is
done with the SAVE / LOAD CONFIG buttons.

Preview

Preview the data range of each sheet with the configured header row by pressing
the EXCEL SHEET PREVIEW tab.

Best practice

Use the preview to check import settings periodically, the list can be adjusted to show
the start or the end of the range and also the number of the preview rows.

N Excel Import — O *
Excel File C:A\Users'zhgab'\Downloads'\Financial Sample xlsx Select Help
Sheet Corfiguration  Excel sheet preview
. ) Digplay region data range
rows of the data selection as preview @® Stat () End
; ~
Row Nr Segment Courtry Product Discount Band Units Sold I‘l;ﬁ'lr?cneufactunng 5
3 Govemment Canada Cametera MNone 16185 3 2
3 Govemment Germany Cametera Mane 1341 3 2
4 Midmarket France Cametera Mone 2178 K] 1
5 Midmarket Gemany Cametera Mone 888 3 1
6 Midmarket Mexico Cametera Mone 2470 3 1
7 Govemment Germany Cametera Mane 1513 3 3
8 Midmarket Gemany Montana Mone 521 5 1
9 Channel Patners | Canada Montana MNone 2518 5 1
10 Govemment France Montana Mone 1859 5 2
11 Channel Pattrers | Germany Mantana Mane 1545 5 1
12 Midmarket Mexico Mantana Mone 2470 5 1
13 Entemprise Canada Martana Mane 26655 5 1.
14 Small Business Mexico Montana Mone 558 5 3
15 Grammeart Gaman Mrntana Mane 2146 5 7 v
< >
Load config Save corfig Impaort Close
Copyright 2021 REQTEAM GmbH Licensed for: REQTEAM GmbH, expires on: 30.09.2021

ReqEdit Excel add-on preview tab

Importing Excel to ReqlF
After the excel file is configured press IMPORT to start the conversion.
The tool will generate a reqifz file near the source xlsx file. All actions are logged.

Output files



Each conversion will overwrite any previous REQIFZ files in the original directory

All generated output is REQIFZ archive format and will be saved near the original
document.

Important Note: please check the content of the imported ReqlF file against your
original Excel! Because of the Excel format we cannot guarantee a loss free import of all
data.

Logging

All conversions are logged into the application directory /logs folder. The log files are
splitted into 10mb files and rotated when needed.

The logging uses the log4net library. Experienced users can configure the file
log4net.config to suit the logging needs. Documentation
log4net: https://logging.apache.org/log4net/release/manual/introduction.html

Limitations

Only the XLSX format is supported

Additional content will be discarded (images, charts or any other floating elements)
Marcos are not processed

Pivot tables are not supported

Some formulas are not supported (specially formulas regarding to other cell or table
references or named labels)

Merged cells will be converted to the first cell the merge starts horizontally or vertically

XML Editor add-on

ReqEdit XML Editor is optimized for ReqlF files. Supports XML validation as well as
ReqlF schema validation.

Opening the XML Editor

Select Add-ons > XML Editor


https://logging.apache.org/log4net/release/manual/introduction.html

. .
) ReqEdit XML Editor o] 0

B X Ly 3% =2 © |[i Documenttype ReqlF - @
test.reqif |
<?xml vers

0" encoding="utf-8"?2>
[ <REQ-IF xmlns="hctp://www.omy.org/spec/ReqIF/20110401/reqif.xsd" xmlns:xhtml="htcp://wwWww.w3.org/1999/Rhtml">
E <THE-HEADER>
= <REQ-IF-HEADER IDENIIFIER="_ OfbE89358-3638-4795-a567-50f013a66163">
<CREATICN-TIME>2015-03-14T17:09:12+01:00«</CREATICN-TIME>
<REQ-IF-TCOOL-ID>ReqEdit</REQ-IF-TOCL-ID>
<REQ-IF-VERSION>1.0</REQ-IF-VERSION>
«SOURCE-TCOL-ID>ReqEdic</S0URCE-TOCL-ID>

[T

0 -1 b W b

] <TITLE>RegEdit document - 14.03.2015 17:09:12</TITLE>
10 </REQ-IF-HEADER>

11| </THE-HERDER>

12 «<CORE-CONTENT>

13 E <REQ-IF-CONTENT >

14 <DATATYPES>

15 <DATATYPE-DEFINITION-BOCLERN IDENII

16 <DATATYPE-DEFINITION-DATE IDENTIIFI "2015-03-14T17:09:12+01:00" LONG-1

17 <DATATYPE-DEFINITION-INTEGER IDENII IANGE="2015-03-14T17:09:12+01:00" LOI -
4 m ] 3

FIER="_fal807f-ccla-4ac2-aTe3-5ec284fd260e" LAST-CHANGE="2015-03-14T17:09:12+01:00" LCI

Line  Col Message

Copyright © 2014-2017 REQTEAM GmbH. All rights reserved. Version: 1.0.6414 27735 .:

hqudit XML Editor add-on, displaying a single ReqlF file

The editor can display multiple ReqlF files in tabs. In the lower part of the interface is the
validation / debugger panel.

Validating ReqlF

The editor supports validation for ReqlF / RIF1.1a using the document type toolbar
section. After validation the errors will be displayed in the debugger panel.

L
Line  Col. Message
[ 46 An end tag ‘REQ-IF-TOOL-D" was found with no matching star tag,

Copyright © 2014-2017 REQTEAM GmbH. All rights reserved. Version: 1.0.6414.27735 .:

RegEdit XML Editor add-on, displaying validation errors

Export to MS Excel

File types you can export to MS Excel with ReqEdit

e ReqlF 1.0.1 to ReqlF compatibility mode
e RIF 1.1/RIF 1.1a archive format
e ReqlFz

Use case for export to MS Excel option

Use "Excel Export" if you want use an Excel file for:



o KPI determination
o statistical analysis
o not for reimport changes to ReqlF document

Due to unigue column heading ID needed for the export process, the reimported
document can present differences in Attribute names. See Result view

Export to MS Excel

1. Open the document you want to export from.

2. Set the View mode you want in the View menu. It can be predefined or newly set.
Export function will export the datas you can see on the screen by the active view
mode.

3. Open File/ Export...

Q Export Wizard X

Destination type
Select the destination file type

() Export ReqlF for other tools

Some other tools have some specialties, with this option you can export the cument ReqlF file to a compatible
format for other tools.

() Export to RIF 1_1a format

With this selection, you will get an RIF 1.1a or RIF 1.1a archive file

© Excel export for reporting

Export a ReqlF(z)file to Excel for building KPls or reporting purposes

<Back [ Next> Cancel

Export wizard

o Follow Export Wizard

e Choose Excel export for reports in the Wizard Window

e Choose name and location for excel file. The Wizard will generate automatically
the ReqlF documents name and adds 'exported’ as excel file name. It can be
modified, if needed.


https://documentation.reqteam.com/?p=2386#Result-export-view

The export of the ReqlF file will be written in a Excel sheet with the name of the visible
document. If the name is longer than 30 characters, it will be shortened to this maximum
size supported by Excel. If the user choose an existing excel file the sheet with the
exported data will be added or replaced if a sheet with the same name exists.

The message "The file XXX already exists. Do you want to replace it?" generated by the
Windows file selector, can be confirmed with "Yes"; only the tab named after the
document name will be overwritten entirely.

Note: If you want to export a file with an existing excel file name, close the file before
click Start on export to Excel.

e Check the export options boxes (optionally):

1. ReqlF formatted text export - Exporting data with formatting (only for text,
bold, underlined, strikethrough, italic) Does not support tables,
attachments, (limited support of) lists, background colour.

2. Add meta information to excel worksheet - Exporting meta info based on
the View of the document. It shows the following information in the first
rows in the excel worksheet: export date, file name, document name,
document ReqlF-ID, view name, user name)

& Export Wizard X

Export options

Select the required options

ReqlF formated text export

Should the fomatted text of the ReglF file exported to Excel. Unfortunately the most of the
formatings cannot be transmitted to excel {(e.g. Tables, Lists, Attachments inside cells). It is
recommended to export the content without any formating.

Add meta information to excel worksheet
Should be added some information to the excel worksheet (e.a file name, export date ...).

Export based on:
View name: View
Document : User Requirements

<Back | Next> Cancel

Export options

e Finish export. Log info window appear.



e Open the Excel file.

& Export Wizard X

Process successful!

Congratulation, you have successfully exported the specified file! Number display: amount (export/original) tems

Number of rows: 75 /75 + 1 Number of attributes: 8+1/9

Number of links: 079 Number of attribute types: 575

Info:

JNFORMATION: Get attributes for export A

INFORMATION: Ignore Column: CellState [System Byte[]]

INFORMATION: Export Column: SpecObject!D [System.String]

INFORMATION: Header Column: ReqlF ChapterName [System String]

INFORMATION: Text Column: ReqglF.Text [System.String]

INFORMATION: Description Column: ReqlF.Name [System.String]

INFORMATION: Export Column: Comment [System.String]

INFORMATION: Export Column: Object Type [System.String]

INFORMATION: Export Column: Requirement Type [System.String] v

<Back Cancel

Finish export window

The numbers in the final export wizard window show the amount of hidden attributes
(columns) or deleted rows in the original document.

Result export view

If you check Add meta information to the excel worksheet checkbox in the Excel export
wizard, the Excel file contains the meta datas in the first rows:

A B C D
1 Export date: 3/17/2022 15:45
2 File name: S:\Boti\Kaffeeautomat_2.reqifz
3 Document name: Kaffeeautomat_2 - User Requirements
4 Document ReqIF-ID: _1a8ffb8-eca2-423c-b266-26e94aea7398
5 View name: View
6 Username: 1BL\Bryan
7
8 RowNr Hierarchy ID Object ReqiF ID Reqif.ChapterName ReqlF.Text
9 1-#1 _33591b0-a6d5-4f2a-8fb9-da7474a8b15e based on VolereRequirements

Resulted file view with meta datas

The first 3 columns of the created Excel file contain, independent of the selected View
mode:

Row Nr Each row is numbered conform to the source specification document.




Shows the entry level of the object (text) in the source specification
Hierarchy ID |document. The number shows the chapter number it belongs and after
the hash sign (#) the entry position in the folder.

ObjectReqlF |Shows the ReqlF-ID of each object from the source specification
ID document.

New columns in the exported Excel file

These column headings are reseved for the Excel export. They are important to
identify the specifications from the Specification document. If these column names are
defined as attributes inside the ReqlF document, the attribute will be reanamed to
"ReqEdit.<<atributename>>". Ex: RowNr -> RegEdit. RowNr

The name of the tab in the created Excel file are the first 30 characters of the document
name.

If you reexport a document to existing Excel file, the final file saves the new version of
ReglF file in the sheet which has the same name. The other sheets /tabs remain the
same.

Display of formatted text:

Some elements can be displayed in Excel in a certain mode due to technical limitations:

Formating Display Description
By default any of the multi valued
Multi multi#l enumeration values will be
Enumeration | multi#2 displayed separated by a new
line.

Any of the unordered lists will be
displayed as new line separated

Unordered list | gggyz% entries with an starting dash "-"
y character for each of the list
entries
1 entrvil Any of the ordered list entries will
Ordered list 2' entry#2 be displayed with a numeric value
' ¥ and followed by a dot
Each table column inside of
Table [coll][col2] ReqlF-table row will be framed
coll][co with square bracket signs
[coll][col2] th bracket
("[ column value 1).
Attachments {"link":"image.png", Textual information about the

"type":"image/png"} linked file and mime type




{"link":"image.png",
"type":"image/png"tAlternative
text{"endlink"}

Textual information about the
linked file and mime type

Attachments
with alt text

Limitations in formatting to Excel

Note: Roundtrip Excel-ReqlF is not supported! (You can reimport this Excel file to
a ReqlF file, but you will loose information contained in the original ReqlF).

Importing

The Import add-on opens non-standard ReqlF files and imports MS Word document
files, or MS Excel spreadsheets. To import click on File / Import...

© Import Wizard X

Source type
Select the source file type

() Import ReqlF file not edited in ReqEdit into ReglF 1.0.1 format
With this selection. you wil get a ReglF 1.0.1file or archive. You can select ReqlF fie or ReqlF archive

() Rational DOORS Next Generation

With this selection. you wil get a ReqlF 1.0.1 or ReqiF 1.0.1 archive file. You can select a Rational DOORS Next
Generation compatible ReqlF or ReqlF archive file

O Import RIF 1.1a format file into ReqIF 1.0.1 format

With this selection. you will get an ReqlF 1.0.1 or ReglF 1.0.1 archive file. You can select RIF 1.1aor RIF 1.13
archive fie

() Import Word format files into ReglF 1.0.1 format
With this selection. you wil get an ReqIF 1.0.1 archive file. You can select the following Word fie types: doc.
docx and tf

O Import Excel format files into ReqlF 1.0.1 format

You can select Excel file type xdsx to convert to ReqlF. Press next and ReqEdit Excel Import Appiication will be
opened and this wizard closes

<Back Next Cancel

ReqEdit Import wizard window

RIF, ReqlF Import

Some ReqlF files are not following the format standard. RegEdit can still open these files
by converting to a compatible format. Following formats are supported:

IBM Rational DOORS compatible ReqlF file to ReqlF 1.0.1 format
Rational DOORS Next Generation

RIF 1.1a to ReqlF 1.0.1 format



The ReqEdit editor supports the ReqlF Format coming from tools that are on the market.
So the file attachments and images are stored in the archives as they are (no conversion
of any type necessary) and for formatting we are using the XHTML tags that are
designated for this purpose.

Not all tool vendors share this spirit, and they have their own kind of implementations
that need to be adapted. One of these tools, IBM Rational DOORS, uses for external file
reference an OLE wrapping around each of the files. This is ReqlF compatible, but not
the standard.

ReqEdit needs to un-wrap this OLE object to get to the original file. This is happening
during the import. RegEdit creates a new file, with all the original files inside. The
filename is kept as the original one, but has an additional suffix called “_imported” in the
name. This imported file can be edited. The linked external files can be opened with an
application for the specific file type.

In order to edit files coming from DOORS (directly or via Atego Requirement
Synchronizer) you need to execute an import, by clicking on File->Import.

NOTE: IBM Rational DOORS version. 9.5.2 and Atego Requirements Synchronizer 2.4
have been tested.

By clicking the “Import” menu item, a wizard will be opened and guide you through the
import process.

r@ Import Wizard I&

Import wizard

This wizard allows you to convert and import other file types
into RegEdit file type

Fead more about import in the documentation:
ReqEdit Documentation

Press Mext to continue

[7] Do not show me this start page at next time

<Back Mesd = ] [ Cancel

Import wizard



On the first page of the wizard you will find some information about the wizard and a link
to the documentation. By selecting the “Do not show me this start page next time” check-
box, this page will not be shown anymore on the wizard start-up.

In the next page of the wizard, the format of the file you want to import has to be
selected. The available options are “IBM Rational DOORS®© compatible ReqlF format”
and “RIF 1.1a format”.

[ ﬁ Impaort Wizard @1

Source type
Select the sounce file type

| Import IBM Rational DOORS% compatible ReqglF format file into ReqlF 1.0.1 format

With this selection, you will get an ReqlF 1.0.1 or ReqlF 1.0.1 archive file. You can select IBM
Rational DOORS2 compatible ReqglF or ReglF archive file.

| Import RIF 1.1a format file into ReqglF 1.0.1 format

With this selection, you will get an ReglF 1.0.1 or ReglF 1.0.1 archive file. You can select RIF
1.1a ar RIF 1.1a anchive file.

Mendt >

Import options

The following page lets you select the file you want to import and also the destination
path and name for your output file.



il Y
ﬁ Import Wizard u

File or path selection
Select source file and set destination file or path

Select your sources file:
[%6e. Capacity Requirements reqif Browse

Set your destination file or path:
[:%6e. Capacity Requirements_imported reqif Browse

[] Add RegEdi system attributes

Import path

After the file is imported, a confirmation page will be displayed. You can select the “Open
the imported file” check-box if you want to open the file after the wizard is closed.

rﬁ Import Wizard u

Process successfull

Congratulation, you have successfully imported the
gpecified file!

Open the imported file

Back | Finish | [ Cancel

Succesfull import



NOTE: If you import a file from RIF format, another page containing mapping tables will
be displayed after the pre-validation. This page contains tabs for each file (in case of a
RIF archive) and for each document contained in the xml files. For each document you
can set the destination attribute name for every source attribute.

rﬁ Import Wizard u

Mapping tables
Set field mapping for all documents

IMud'I_DDDDZEc?mI | Mod2_000028c8 xml | Mod3_00002825 xml

[ Mod1_HIERARCHY-ROOT |

Source Fields Destination Field -
Boolean_att Boolean_att

Date_att Date_att

Integer_att Integer_att E
Object Heading ReglIF.ChapterName

Object Identifier Object Identifier

Object Text ReqlF.Text Tl
Real_att Real_att -

<Back | Net> | | Cancel

Import Log file

MS Office Word Import

The Word Importer option imports .DOC files (Word 97-2003 type) into ReqlF.



@ Import Wizard

Import settings
With this settings you can choose what content will be imported

General options

Keep hierarchy information Import tables
Remove manual chapter numberings Import images
Combine list elements in one object Import attachments
Attribute parsing Page selection
Import attribute tables From page (min. 1) |1 s
Select table attribute format: To page (max 14) 114 -
First row ({Table heading) v

Select mapping file:

@ I Browse

<Back Next Cancel

Word Import wizard starting from v 2.19

Note: for a precise outcome, a table mapping file is needed for importing Word
files, although it is also possible without it.

Structure of the Word file
Before starting the import process

Simple structuring of the document is needed to mark headline depth which will be
converted to nested objects

H1...H5



Heading 1

Lorem ipsum dolor sit amet, cu nemore omittam eam. Pri te ipsum zril. Eam an habeg facer, quo ea nisl
consulatu. Sea gu jriure equidem forensibus, nobis utinam ridens ex pri. Quidam facete fabellas eam id,
abhorreant eloguentiam eu sea.

Heading 2
Lorem ipsum dolor sit amet, cu nemore omittam eam. Pri te ipsum zril. Eam an habeo facer, quo ea nisl
consulatu.
Heading 3
Lorem ipsum dolor sit amet, cu nemore omittam eam. Pri te ipsum zril. Eam an habeo facer, quo ea nisl
consulatu.
Heading 4
Lorem ipsum dolor sit amet, cu nemore omittam eam. Pri te ipsum zril. Eam an habeo facer, quo ea nisl
consulatu.
Heading 5
1D Heading Text Comment Integer
o001 Tahle Heading 1 Pri te ipsum zril. Coment 1 101
Eam an habeo
facer, quo ea nisl
consulatu. Sea eu
iriure equidem
forensibus, nohis
utinam ridens ex
pri.
0002 Table Heading 2 Mei cu evertitur Coment 2 102
pertinacia, graecis
deleniti ea eam.
Quas sanctus ex
pri. lus id veri
necessitatibus. An
case altera
lobortis eum.
0003 Tahle Heading 3 Coment 2 103
Id graeci ceteros
eum. Eripuit
inermis molestiae
ex nam.
Suscipiantur
concludaturque in
nam. Ea pro
nostrum

source Word file with multiple child headlines



'_TS 'D‘ e El A 95 @ | @), [Pa Views: All attributes (System)

Main Column

1 - Heading 1

Lorem ipsum dolor sit amet, cu nemore omittam eam. Pri te ipsum zril. Eam an habeo facer, guo ea nisl consulatu. Sea eu
iriure equidem forensibus, nobis utinam ridens ex pri. Quidam facete fabellas eam id, abhorreant eloguentiam eu sea.

1.1 - Heading 2

Lorem ipsum dolor sit amet, cu nemore omittam eam. Pri te ipsum zril. Eam an habeo facer, quo ea nisl consulatu.

1.1.1 - Heading 3

Lorem ipsum dolor sit amet, cu nemore omittam eam. Pri te ipsum zril. Eam an habeo facer, quo ea nisl consulatu.

1.1.1.1 - Heading 4

Lorem ipsum dolor sit amet, cu nemore omittam eam. Pri te ipsum zril. Eam an habeo facer, quo ea nisl consulatu.
1.1.1.1.1 - Heading 5

1.1.1.1.1.1 - Table Heading 1

Pri te ipsum zril. Eam an habeo facer, quo ea nisl consulatu. Sea eu iriure equidem forensibus, nobis utinam
ridens ex pri.

1.1.1.1.1.2 - Table Heading 2

Mei cu evertitur pertinacia, graecis deleniti ea eam. Quas sanctus ex pri. Ius id veri necessitatibus. An case
altera lobortis eum.

1.1.1.1.1.2 - Table Heading 2

Id graeci ceteros eum. Eripuit inermis molestiae ex nam. Suscipiantur concludaturgue in nam. Ea pro nostrum
consectetuer. Vix rebum urbanitas an, no pro volutpat consulatu delicatissimi, ferri harum noster his ne. Quo ea
odio unum eruditi, mei et ipsum ullum mucius, per in epicuri iudicabit.

resulting ReqlF with nesting

Mapping
Table mapping

To convert tabular data to objects with attributes a manual mapping is needed that will
be used throughout the document

ID | Renamed ID | integer
Heading | RegIF.ChapterName | text

Text| ReglF.Text | text
Comment | Comment | text




Integer | Integer | integer

Real | Real | real:
Date | Date | date: dd.MM.yyyy

The mapping syntax is <table column name> | <target attribute name> | <attribute
type>

Where attribute types can be

integer

text

real:<decimal separator>|decimal separator string , / . (comma or point)

date:<date format> date format supports standard date notations
enumeration NOT SUPPORTED
Mapping file

To convert Headings to objects with attributes a manual mapping is needed that will be
used throughout the document

ID | Renamed ID | integer
Heading | RegIF.ChapterName | text
Text| ReglF.Text | text

Comment | Comment | text
Integer | Integer| integer
Real | Real | real:

Date | Date | date: dd.MM.yyyy

Import .doc file

Before importing a word file please ensure it is not open in any other application, then in
ReqEdit click on the File/lmport... or Import files in the dashboard. A Wizard window
appears and leads you through the import process.

Browse for the document file and give the imported file destination. Then click Next..
Basically, the name of the ReqlFz file will be the same as the document's name plus
'imported'.



Q Import Wizard

File or path selection
Select source file and set destination file

Select your source file:
\Test Folder Access\Melinda\MELINDA General\Test folder Word impol\lmport word test text. doc Browse

Select your destination file:
er Word import\Import word test text.doc.sb-950a1176475b04kImport word test text_imported reqif4 Browse

To display the options on the next page, the selected document need to be loaded. This may take some
seconds...

<Back Next> Cancel

After selecting the source files , destination file becomes the "imported" name

In the next Window you can select the import options.



€ Import Wizard X

Import settings
With this settings you can choose what content will be imported

General options

Keep hierarchy information Import tables
Remove manual chapter numberings Import images
Combine list elements in one object Import attachments
Attribute parsing Page selection
Import attribute tables From page (min. 1) |1 -
Select table attribute format: To page fmax 14) 114 2
First row ({Table heading) v

Select mapping file:
e® | Browse

<Back Next Cancel

Word Import Wizard

General options
Keep hierarchy information will show the objects at levels based on Heading settings.

Remove manual chapter numberings option will remove the chapter numberings of
ReqlF.

Combine list elements in one object will show the whole list in one object in ReqlF.
The wizard allows the import options of tables, attributes and attachments.
Attribute parsing is possible only if a mapping file is given.

The Page selection allows selecting parts of the document to be imported. Given values
must be integers of existing page numbers of the document.

Note: If ReqEdit cannot open the document file, the page selector is not live and the
document cannot be imported.



@ Import Wizard

Import settings

With this settings you can choose what content will be imported

General options
Keep hierarchy information
Remove manual chapter numberings

Combine list elements in one row

Aty ;
Import attribute tables

Select table attribute format:
First row (Table heading)

Import tables
Import images
Import attachments

Page selection
From page {min. 1) 1

4

To page {max 11) 11 3

Select mapping file:
1port\mapping test word import Melinda td] Browse

Select the mapping file for Attribute parsing

Resulted ReqlF file after Word import

<Back Next > Cancel

The resulted ReqlF file contains 5 new Attributes:

e Page - shows the page number in the Word file where the object/row is

e Paragraph - shows the number of paragraph in the Word. For details check the
Reqedit/Systemlog/ReqEditEventLog file.

e Item number - shows the bullets or numbers of a list

o Footnote - shows the footnote related to the object in the Word file

e Comments - shows the comments related to the object in the Word file



Main Column lRqudﬂ.word.Paqe RegEdit.Word.Paragraph  RegEdit.Word.ltemLabel ReqEdit.Word.Commenrt RegEdit.Word.FootNote

- C " 2 16

Three different styles of text are used in this template:

1. [Text induded in square brackets]

oder Grenzwerte fur die Senenpraduktion nicht unter allen im

2 201
This text repi -specfic to be provided. Examples
are [document name] for the name of the template/supporting document,
and [purpose] for the purpose of the template/supporting document. Where
this text appears, insert the document-spedfic information between the
2. {Italic text in braces}
This text is guiding or explanatory in nature. It will include tailoring guidance 2 24 2,
and descriptions of the kinds of information to be included in each section.
Therefore, this text should be deleted from the template/supporting
3. Normal text
2 28 3
This is standard text that should be copied verbatim into the
template/supporting document as necessary. It represents any text that
{Page intentionally left blank. 3 a4
Template begins on the following page.} 4 46
New attributes in the ReqlFz file after importing a .doc file
ith manual chapteri
with manual chaptering on,.., ... RecEdit. . Raqed . ReqEdt.word o et ‘D Dasign’ ‘Leyiat. 3.0 Tl g
1 - ALLGEMEINE PFLICHTEN
2= Aithel 3 1 - ALLGEMEINE PFLICHTEN 1oz e o
2.1 - Technische Anforderungen
2 - Artikel 5 13
2.1 - Technische Anforderungen : 4
3 - Anlage
4 - Verfahrgn zur Prufung, ob ein Fa..
5 4.1- 1, Aiflemenes adefiies Bechtsioe erilen
1 rffie 2wecke der Einstufu 1 8 " Syt
Ananglt
4.2 - 2. Prifbedngungen fur geometns...
arfesce der v e Verorcaracg eabewa ders 44z 3kt sasabn, win
L. a) s vemdee
b
Pchankt eabdon
R 2y
6 Piaclle; suf dir die Mossing [ Lo 4 i
4.3 -3, Msung des vorderen und hint. TIPS Ao e
3.1. Defuarders Uberhanguinke e Lage sind
Fahrzeuge, Systeme, Bautede und selbststandige tachnische Einheiten X 1 e g Rechisabss nachaswliiehen
< 4.4+ 3. Maksung der Bodenfreheit missen die Anforderungen der in Anhang 11
Far e Bswertng dr ErSaSurg des Anfrterurgas 30 @esces Absat wendes s Wyl e
‘ Noerolien, Prifungen, irspektionen snd Bewertungen berdcksidvng. die von des
; endurg d 9 (2) Bei Fahrzeugen, Systemen, Bauteden und selbststandigen technischen parar o rrany
Emheien gik, dass sie diese Verordnung nsbesondere dann nicht
4.5 - 4.2, §odentreihe unter einer A... ainhakan, wenn
rendy Ot 1. 1.3) s von den Angaben in den EU-Typgenehemigungsbogen und i S S
= 4.6 - 5. Seiofshigker deren Anlagen ader von den beschreibenden Angaben i den
Pru_fbenchtan starker abwaichen, als nach dem batreffandan
Reigtinchelt bas Rechesakt 2ub3ssig ist; 1 13 3.
A R 2. 2.b) dieim Rechtsakt L

D:geﬁendeﬂ Redhtsakt erfaubten Bedingungen eingehaiten worden Opﬁoni Lists. enumel’aﬁons in one row

sind;
. 3.c) die

3  die
oder die Kommission recht in der Lage sind, eina Herstellerangabe im
Besch er den des
Rechtsakts nachzuvollziehen.
Fur die der Erfillung der nach diesem Absatz
werden ausschbeBlich die Kontrolen, Pru fungen, Inspektonen und
¢ i@ von den den 1 14
und der oder in deren Auftrag

d
durchgefuhrt wurden,

Resulted ReqlF file screenshot after some import optibn settings' -

Limitation of Word import
Currently the Word import has these limitations:

o Detection of form field, and draw (pen and marker) are not supported
e Importing files bigger as 150 MB not supported

Excel spreadsheet Import
Excel spreadsheet import can support:

e Enabling roundtrip and
o Simple import with or without hierarchy



For roundtrip enabled import click on File / Import or Add-ons / Excel Import and

choose the box Enable round trip in the Excel import wizard window.

For details on Excel Import click here.

D Excel Import 5 O X
Excel File N MELINDA General\Test |  Select | Help
Sheet Configuration  Excel sheet preview
Step 1: Sheet selection Messages
SHEET 1 v
() Ignore Sheet
Step 2: Set header row
Reset messages display Open log directory
Header Row Number 1 4
Row Column Step 3: Configure attributes
Fi 2 2N =
o Column Name ::gor;s:n Data type Refrence
To 39 24 120 = B
> Hierarchy 1D J Integer v {1
Set value 2 Unique 1D [ |integer v (1
ject ReqlF | 0O | v 86dd-4.
Step 4: Set main column (optional) ! 3 vaJEd ealb i l:| 1 = AT
‘—— —— —‘ 4 ReqlF ChapterName )] |Text v
i | 5 ReqlF Text O |Text
sNone> 6 ReqlF Name O |Text ~ | Name 1
Test § | 7 Comment O |Text v
‘ 8 Formulas O |[Text v
Step 5: Set id field (optional) |9 | ReqEditID (J |integer |20
Enable round trip 10 ReqEditModifiedOn (J |Date v 127.04.202217:4..
1 ReqEditModifiedBy O |Text v | Melinda
ID Field
Load config Save config Import Close
Copyright 2022 REQTEAM GmbH Licensed for:

Excel Import Wizard
Exporting

RIF, ReqlIF

If the files that the user edits or creates should be imported to IBM Rational DOORS
(directly or via Atego Requirement Synchronizer), an export is necessary.

After editing and before importing to DOORS, you have to do an export by clicking on
File->Export. During the export all the linked files will be wrapped in an OLE envelope.
To protect the RegEdit variant of the ReqlF file, the export function will ask the user for a
new file name, where to save the DOORS variant. This new file can be imported to IBM

Rational DOORS.

NOTE: IBM Rational DOORS version. 9.5.2 and Atego Requirements Synchronizer 2.4

have been tested.


https://documentation.reqteam.com/excel-importer-add-on/#Usage

By clicking the “Export” menu item, a wizard will be opened and guide you through the
export process.

[ ﬁ Export Wizard @1

Export wizard

This wizard allows you to export and convert ReqEdit file
type into ather one

Read maore about export in the documentation:
BegEdit Documentation

Press Next to continue

[] Do nat show me this start page at next time

<Back [ Mead > ] [ Cancel ]

On the first page of the wizard you will find some information and a link to the
documentation. By selecting the “Do not show me this start page next time” check-box,
this page will not be shown anymore on the wizard start-up.

In the next page of the wizard, the format of the file you want to export has to be
selected. The available options are “IBM Rational DOORS®© compatible ReqlF format”
and “RIF 1.1a format”.



[ @ Export Wizard e

Destination type
Select the destination file type

7! Export to IBM Rational DOORS® compatible ReqlF format
With this selection, you will get an IBM Rational DOORSE compatible ReqlF or ReglF archive file

) Export to RIF 1.1a format

With this selection, you will get an RIF 1.7a ar RIF 1.1a anchive file

The following page lets you select the destination path and name for your output file. In
case you want to export to RIF format and your file is a multi-document file, multiple .zip
files will be created at export. In this case, only the destination folder can be selected
and the file names will be assigned automatically.

. B
ﬁ Export Wizard ﬁ

Rle or path selection
Select source file and set destination file or path

Select your sources file:
[%6e. Capacity Requirements reqif Browse

Set your destination file ar path:

D:Mee. Capacity Requirements_exported reqif

Back | MNed> | | Canesl




After selecting the file paths, the wizard will convert your file and a confirmation page will
be displayed.

You can find your exported files in the destination directory you have specified on the
previous page.

[ ﬁ Export Wizard ﬁ

Process successful!

Congratulation, you have successfully exported the
specified file!

<Back [ Finizh J [ Cancel ]

NOTE: If you export a file to RIF format, another page containing mapping tables will be
displayed after you select the file paths. This page contains tabs for each file (in case of
a multi ReqlF file archive) and for each document contained in the .reqif files. For each
document you can set the destination attribute name for every source attribute.



rﬁ Export Wizard ﬁﬂ
Mapping tables
Set field mapping for all documents
| Mod1_0D0028c7 reqif | Mod2_000028c8reqf | Mod3_000028c9 reqf
(Modl
Source Fields Destination Field -
Object Heading
ReglF.Text Object Text
Boolean_att Boolean_att E
Date_att Date_att
Integer_att Integer_att
Object Identifier Object Identifier bl
Real_att Real_att -
Back | Net> | | Cancel
" o

Configuration
This document is incomplete, we are working on making it better

Thank you ) for your understanding

License Detach Utility

To be able to work outside of the restricted environment and self hosted license server,
licenses can be locked for on the go usage. Each detached (locked) license will have an
expiration period after which automatically will be restored and the PCs will not be able
to use ReqEdit anymore.

Read more about Detaching Tool setting

For detaching another license the PC has to be inside the network after which the
detachment can be done again.

Environment

ReqEdit is used inside a restricted network where the PCs cannot access RegEdit
License Server, a self hosted network license server is used. This server holds all the
license pools available to the network.

When ReqEdit has to be used outside this environment a license can be locked and
detached for on-the-go usage.


https://documentation.reqteam.com/activation/#License-detaching

NOTE: Detaching has to be done inside the restricted network before
disconnecting.

Public Internet

ReqEdit
License server

[

V2C offline

Q
N
<

Local network
Desktop
Machine

i
1
1
1
1
1
1
v -
RegEdit license
Network
—>

RIS 59

License server

Desktop
100 licenses of which: Wiachioe
3inuse ReqEdit license
1 detached
Desktop
Machine On the go
ReqEdit license outside the network
Desktop
Machine
Detach license —p
) . ReqEdit license
\ Restricted environment / Detached

Diagram showing RegEdit usage in a restricted environment where a stand-alone license server is used,
detaching a license for on the go usage

Work on-the-go
Detaching licenses from network server

Start the tool by selecting Add-ons > License Detach from the top menu

Add-ons | Hilfe

ReqEdit Lizenz Detach...
ReqEdit XML Editor... F6 T
Excel Add On

Vergleich/Merge Tool

Direktvergleich
Weak Word Analyse

Detach Tool Add-On Tab



License Detach tool add-on will be displayed. The available number of licenses will be
listed in the window (refreshed every 20 seconds).

Select the license that needs to be taken out and configure the period.

‘ @ ReqEdit License detach toal = [m]

| License detaching | Log entries

Available licenses for detach:

Product ID Product name Hasp ID Max. Detach Day Available

3T RegEdit Ultimate + WWA + HL 921010768488095201 30 18
Local server status:
Remote server status:
Last update:
Global "Max.
Detach Days':

Refresh information

Locally installed license:
Product ID Product name Remained days Will expire Hasp ID
37 ReqEdit Ultimate + WWA + HL 7 2/23/2023 10:50:22 Al  1076704778157014644

HTTPS Support
[] Enable HTTPS

Available
Available
12:50:24
30

|

| Choose language...

Return license |

Help

Copyright © 2017 REQTEAM GmbH. All rights reserved. Version: 2.20.8446.19621

Detach tool add-on window

Press Detach license to reserve a license and take it out.

Locally installed license:

Product ID Product name Remained days Will expire Hasp ID
34 ReqEdit full license for Testing 7 1/11/2022 7:23:55 AM  1097933461979628350

Detach tool displaying a detached license

RegEdit can be used on the go for the configured period, after which the license will
expire and cannot be used. Another license has to be detached again from inside the
network.

Logging




The Log entries tab displays the last 100 messages in reverse order. To get the
complete log message click on Open full log file on the bottom of the page.

Merge / Compare Addon

Tool for comparing and merging ReqlF/ReqlFz files. Can be used to compare two
versions of the same file or merge attributes from one specification to another.

Note: the Compare / Merge tool synchronize at startup the settings of RegEdit about the
HTML validation. To set the HTML Validation status in ReqEdit in the Settings/User

menu. After set the value to the desired, please restart the Compare / Merge tool to get
the settings synchronized.

@ User Settings X

Language:
English v

Please close all files before pressing the button.

Delete temporary files...

Create back up

4

Make backup every (minute): 10

4

Max. number of stored backup files perfile: |10

Attribute displayed in DOORS tables:
ReqlF ChapterName v

Maximum cache size (MB): 500

4

XHTML schema validation [] Show clipboard paste emrors
Show dashboard at startup

Save Cancel

XHTML validation in Settings/User menu in RegEdit.

The tool works in two modes:

e Direct Compare mode
Users can automatically jump to the source of the compared objects
e Standalone mode



Compare ReqlF files

The easiest way to compare two documents is to use the Direct Compare mode, follow
the steps described below.

Open the two ReqlF files for comparison, select one of the documents,Click Add-ons >
Direct Compare

L _IMpOItea.reqit/ 1est aoC U Law Worda TeXt _Iimportea.reql

ngs | Add-ons | Help
ReqEdit License Detach...
P ReqEdit XML editor... F6 rord text .
Excel Add On 2R
n ki Compare/Merge Tool
- NUNG (EU)
ardn l Direct compare |
E VE Weak Word Analysis Mai 2018
vorTro al

! GELTUNGSBERE ither die Genehmia

ReqEdit Add-ons, highlighted is the Direct Compare tool

A question window will let the user choose the pair of the document for second file as
NEW or OLD, Press YES or No to configure the comparison members

Information >

Is the second file 'Requirement_template_changed.v2. reqif’
the MEWER. version?

Yes Mo Cancel

RegEdit Compare Add-on question popup

Compare overview window will show the compare statistics, then press Compare
selected



Please select one of the documents/specifications, if you want to have a more detailed compare

ReqglF Inventory

Document #1

Docurnent/Speciﬁc:... 1

Sheet1

RegEdit Compare Add-on overview window

| Name _ Old file New file In common _Annotation
Archive | TESTFILE vers 1.reqifz fTESTFILE vers 10.reqifz

Last change date 12023.02.07 14:31:07 ;2023.02.09 12:09:57

Filename .TESTFILE Excel test file for import.reqif lTESTT-‘ILE Excel test file for import.reqif

Author [

Source tool , ReqEdit ReqEdit

ReglF tool |ReqEdit ReqEdit

VDocument creation ...  2023.02.01 15:14 2023.02.01 15:14

‘Type Definition 6 6 6
Attribute Definition 18 |18 18
Attributeset Definiti... 1 |1 1
Attributeset Definiti... ' 1 1 1
|Rows/Objects

9f69d35-89fb-de7... | Compare specificati...

Compare documents Close

A new window will let the user select additional attributes for quick comparison, and then

press OK

NOTE: main attributes are completely compared all the time, like the footer note

displays

NOTE: the additional attributes are displayed in a single column as a text message



Please select attributes, you want to compare
additionally to the main column attributes.
The result will be displayed in a separate column

Select/Deselect all attributes

ReqEdit.ExcelRowRefence
Hierarchy ID

Comment
ReqgEditModifiedOn
ReqgEditModifiedBy
ReqglF.ForeignDeleted
ReqlF-WF.CustomerStatus
ReqIF-WF.SupplierStatus
ReqgIF-WF.ProductVariant
ReqgIF-WF.Revision
ReqIF-WF.CustomerComment
ReqIF-WFE.SupplierComment
ReqlF-WFEType

LastChange

new boolean

Main column rendering Ignore main column changes
Render short description ("] Heading

Display external ID ] Short Description

Note: The program uses by default the attributes [ Text

ReglIF.ChapterName for display headings, RegIFEName
for short description and ReqlF.Text for text in the
main column.

OK Cancel

RegEdit Compare Add-on displaying additional attributes list to include in the comparison result

Display logic for additional attributes:

i.  Html attributes will be compared as HTML but displayed as a text and limited to
first 50 characters
ii.  Strings will be limited to 50 first characters
iii.  Dates will be converted to German date format
iv.  Boolean values will be displayed as text
v.  Enumerations will be displayed as a string

Render Short Description

Compares and displays the ReqlF.Name attribute (in case of DNG export this will be a
copy of ReglF.Text, and should be excluded from comparison for nicer overview)

Display External ID



Shows ReqlF.ForeignID attribute as a separate column

Ignore Main column changes

Ignores the changes made in the Main column of the Reqif/Reqifz file.
ReglF.ChapterName; ReqlF.Name; and ReqlF.Text

If the Render short description box is unchecked, the Short description box in this area

cannot be chosen.

The Comparison Window

Displays the result of the comparison in a two sided window.

Right clicking any object the ReqlF.ID and External.ID (ReqlF.ForeignID) can be copied

into the clipboard

Q) Compare Specifications

0ld: Requirement,_template recif/Requirement document

New: Requirement_template_changed v reqif/Requirement documert

- [m] X

2l Display unchanged rows

Obiex Bten Hin Colan

1 Description

1.1 Stakeholders

12 Project desription

121 Service need

122 Project purpose & Scope

123 Technical challanges/issues
124 Existing systems

2 Hardware requirements
3 Software requirements
4 Technical requirements
21 Functional requirements
411 SubSystem AlProduct Part A
412 SubSystem B/Product PartB
413 Interfaces

41 Interface to System Ext-X

414 Functional legal requirements
42 Non functional requirements
421 Design/Architecture

422 Usibility

423 Perfomance requirements

424 Support/Training

425 Non functional legal requirements

Other attributes Status

ReqEditModifiedOn. 06.04.2021 18:24
Refe

RegEditModifiedOn: 06.04.2021 18:17 Refe
Refe
Refe..

Objec

Numk FE)‘ner Main Column

122 Project purpose & Scope

Other

atrbutes AU

Unc

[We want to have a web sernvice, where our customers can book their busines frip or thi RegEditiD: 2

RegEditModi "
RegEditMod
ReqlF.Foreig

w

Unc..
ReqEditModi
Cha

Unc

ReqEdithodi
RegEditMod
ReglF Foreic

New

Unc

ReqEditiD: 2
ReqEditModi
ReqEditiodi
ReqIF Foreic

123 Technical challangesilssues
124 Existing systems (by history)
2 Hardware requirements
The software should run completely in the cloud, so we need at least 50 GB space for RegEditiD: 2
15GE for the database. Added by Tibi
21
3 Software requirements
'We need for hosting a MySQL database and a current PHP Stack,
5]
4 Technical requirements
41 Functional requirements
411 SubSystem A/Product Part A

412 SubSystem B/Product Part B
413 Interfaces

41 Interface to System Ext-X
414 Functional legal requirements
42 Non functional requirements
421 Design/Architecture
I 422 Perfomance requirements
I423 Support/Training
| B Usibility
425 Non functional legal requirements

Mov.
ReqEdithodi Cha, ..

Unc

~

Open result in browser

Close

RegEdit Comparison Add-on displaying the Comparison Window, with External ID and additional attributes

Column description

ObjectNumber

Hierarchical numbering by Headers similar to chapter structure,
optional # character shows text objects under the given chapter,
the background color suggests the type of change

External ID

Shows the contents of the ReqlF.ForeignID attribute

Main Column

side)

Displays the content of the objects with changes, green is the new
content (right side), red on is the removed or changed content (left




Displays the concatenated additional attribute changes with green

Oth.er and changed with red (on the left) see above Display logic for
attributes - .

additional attributes
Status Displays the status description: new, changed, moved from source,

moved and changed, deleted (only left), referenced

Highlight colors

Structural changes

GREEN |NEW
BLUE MOVED
ORANGE |CHANGED, CHANGED & MOVED
RED DELETED
Referenced, is the source of the moved / changed objects

Content changes

GREEN|New content

RED Removed content

Display unchanged rows

By default all content is displayed, to show only the changes uncheck the [Display
unchanged rows] checkbox at the top

Jump to source

L/ | Service need

L. | Project purpose & Scope
We want to have a web senvice, where ol

their family vacation.

customers can book their busines irip or 1.2.2 - PI'OjECt purpose & Sco pe
We want to have a web service, where our customers can
Copy ReqlF ID
Copy external ID

Ly Te‘ Open in ReqEdit [rues 1.2.3 - Technical challanges/Issues
Exi

C . | | oy B PRy Dy | MRS N-peny Sp—m—" 1

Jump to source by right-clicking an object in the comparison window, will select the object in the source document

To see the selected changed object, must change the window view.

HTML Report



Users can save the result of the comparison as a HTML report. Pressing the Open
results in browser at the bottom will save the file and open the default browser.

Specification comparison
Compare ificati i >R
Information about the compare
Date: 02.06.2021 17:28:25
Wain column attributes: ReqIF ChapterName, RealF-Name, RealF Text
Aftributes: Gomment, RegEditiD, ReqEdithodifiedOn, ReqEditModifiedBy, Req|F ForeignDeleted, RecEdit Deseription
Optional Disclamer text
Old file: Requirement_template.reqif New file: Requirement_template_changed.v2.reqif
ObjectNumber  ExternallD MainColumn Other Status ObjectNumber ExternallD MainColumn Other Status
1 Description 1 Description Unchanged
11 Stakeholders 1# The travel portal should offer customers an easy booking  ReqE New
possibiliy for their journey ReqE
06.04.2021 18:40:58
. o ReqEditModifiedsy.
12 Project desription tibi
ReqlF.ForeignDeieted:
False
121 Service need 11 Stakeholders Unchanged
122 Project purpose & Scope N _
12 Project desription Unchanged
123 Technical challanges/lssues
1.2.1 Service need Unchanged
124 RegEditModifiedOn: 06.04.2021 Referenced
Existing systems 122403 122 Project purpose & Scope Unchanged
2 Hardware 12.2%1 We want to have a web service, whera our customers can  ReqEdItiD: 23 New
requirements book their busines trip or their family vacation ReqEditModifiedOr
3 ReqlF.ForeignDeieted:
2 Software Falee
rEq'-"rements 123 Technical challanges/Issues Unchanged
a : 124 ReqEditModifiedOr:  Changed
Technical Existing systems (by history) 04.05.2021 0022:42
requirements
.| |2 Hardware requirements Unchanged | 2
W (4), @ ) ) - =
Legend: /5 NEW (4), 99 CHANGED (2), Il DELETED (0), I8 MOVED (2) CToee) (CTe—

RegEdit Compare tool generated HTML report

The HTML report is a scripted web-page with couple functions:
Highlighting objects/rows

Users clicking any row in the report will be highlighted and if possible, the pair will be
shown and also highlighted

Clicking the ObjectNumber or the row to jump to corresponding object pair. Highlighting
is similar to the comparison window.

412 SubSystem B/Product Part B

412 SubSystem B/Product Part B Unchanged
413 Interfaces

413 Interfaces Unchanged
4131 Interface to System Ext-X

N 4131 Interface to System Ext-X Unchanged

414 legal req

414 Functional legal requirements Unchanged
42 Man funstinnal

Filter change type

The number of the different types of change are shown at the bottom of the page and
can be toggled to be visible or hidden

Legend: MEW (4], CHAMWGED (2), Bl DELETED (0), B MOVED (2)



Show only changes

Show only the rows that are changed, moved, new or deleted, including the reference to
changes.

Show only changes

Mark as read

Users can track the progress of the validation of the changes by marking each row as
read with the checkbox.

ced

422 Perfomance requirements
1ced
I )
nced _
424 Usibility ReqEdit!
03.05.20
425 Non functional legal requirements

NOTE: this feature uses browser internal WebStorage mechanism, all markers are
saved to localStorage. All modern browsers have this feature but can be limited by
security policies.

Show only unread

The button will toggle the display of only the rows which are not yet marked as read
) show only unread

Settings

Customize an additional logo and optional HTML content to include in the HTML report,
open the Administration > Settings menu.



€ settingsForm — O

Compare

L L -

Change logo for output I

Please select a logo, that has
maximum width of 300px and
height of 200px size

Custom output text (HTML output):
Optional Disclamer text

eI e T T T T I I O

Save Cancel

Compare Add-on settings window

NOTE: The logo image can only replaced with another one, there must always be a logo
Print to PDF
HTML report can be saved as PDF by printing the result to a PDF document within the

browser. To get a better viewing experience set the pdf size to A3 landscape or adjust
the print scaling and enable background colors.

Notices
In IE11 or other older browsers if "Mark as read" cannot be used it will be hidden. An
ActiveX script execution popup will ask to run the scripts inside the html report. Choose

Allow Blocked Content to enable the features.

Mark as read is saved inside the browser, moving the html report will not affect the read
markings.

Tested on:

o Edge Version 91.0.864.41 (Official build) (64-bit)
e Chrome Version 91.0.4472.77 (Official Build) (64-bit)

Mark as read cannot be exported or transferred, its indented to be used only on one PC.



Standalone mode
Comparison between two unopened files in RegEdit

Note: Opened files will be locked, other applications (ex: RegEdit) will not be able
to open the files until closed

m Help
ReqEdit License Detach...
ReqEdit XML editor... F6
Excel Add On

Compare/Merge Tool

Direct compare

Weak Word Analysis

‘ Compare and Merge AddOn = O

l:l Close Close

Compare  Merge  Administration  Help

| Copyright REQTEAM GmbH 2022 HTML Validation: On
ReqEdit compare add-on in standalone mode

Open the old ReglF file on the left and the new on the right side

Press Compare in the top menu

Select the row with the files to be compared and press Compare documents
Configure comparison option and attributes for compare in the wizard window
Press Compare documents to display the result.

Click on Open result in browser or Close button depending on your choice

oh~wNE

NOTE: Closing the file will release the exclusive lock and can be used by other
applications

NOTE: In Standalone mode cannot jump directly to the changes in the file by right-
clicking on the changed cell and choosing the Open in RegEdit option

Compare limitations



e Compare works only on ReqlF files that can be opened in RegEdit

e HTML element property changes will be ignored (class, id, style) except
attachments (object data tags)

e String and HTML attributes outside of the main column will be shortened the
display to 50 characters

e Sometimes if the content comparison is too complex will highlight more new
changes than necessary, but will never miss any change

e Opened files are exclusively locked until closed (no other app can open the files)

Merge ReqlF files

Merge attributes one at a time from a ReqlF file to another ReqlF file. Can only be used
in standalone mode, meaning the files cannot be opened in other applications.

@ Compare and Merge AddOn - (m} X
Compare Merge  Administration  Help
2r Excel import\Excel test file for import new tableheading 1.reqifz D 5| Close der Excel import\Excel test file for import new tableheading.reqif =) Close
={JExcel test file for import new tableheading.regif = {JExcel test file for import new tableheading.reqif
=(_JSheet1 -- Attribute-Set(s):1 = (JSheet1 -- Attribute-Set(s): 1
={_JSheet1 Type -- Attribute(s):19 = {JSheet1 Type -- Attribute(s): 19
(JReqEdit.ExcelRowRefence [Integer] (JReqEdit.ExcelRowRefence [Integer]
(U Hierarchy identificator [Integer] L;:Hierarchv identificator [Integer]
(Junique identificator [Integer] (Junique identificator [Integer]
() Object identificator [Xhtmi] () Object identificator [Xhtmi]
(JReqIF.ChapterName [Xhtml] [JReqIF.ChapterName [Xhtml]
(JReqIF.Text [Xhtml] (JReqIF.Text [Xhtml]
OName [xhtml] {OName [Xhtml]
{JComment [Xhtmi] {JComment [Xhtml]
(JFormula [Xhtml] (JFormula [Xhtml)
Oreqgedit identificator [Integer] Oreqgedit identificator [Integer]
(OModified On [Date) (OModified On [Date)
OModified By [xhtml] OModified By [Xhtml]
{_Foreign deleted [Boolean] (_Foreign deleted [Boolean]
() Customer status [Xhtml] (JJCustomer status [Xhtml]
(_JSupplier status [Xhtmi] (_JSupplier status [Xhtmi]
(OProduct variant [Xhtmi] (OProduct variant [Xhtmi]
(CJRevision [Xhtml] (JRevision [Xhtml]
() custComm [xhtmi] (O custComm [xhtmi]
(JsuppiComm [Xhtml] (JsupplComm [xhtml]

17:33:32 INFO:File "\\WINSRV-2022\Storage\Test Folder Access\Melinda\MELINDA General\Test folder Excel import\Excel test file for import new tableheading.reqifz' is loaded
17:33:32 INFO:Prepare display for ‘Excel test file for import new tableheading.reqifz’

17:33:32 INFO:Open file night: \\WINSRV-2022\Storage\Test Folder Access\Melinda\MELINDA General\Test folder Excel import\Excel test file for import new tableheading.reqifz
17:33:28 INFO:File "\\WINSRV-2022\Storage\Test Folder Access\Melinda\MELINDA General\Test folder Excel import\Excel test file for import new tableheading 1.reqifz’ is loaded
17:33:28 INFO:Prepare display for 'Excel test file for import new tableheading 1.reqifz’

17:33:27 INFO:Open file left: \\WINSRV-2022\Storage\Test Folder Access\Melinda\MELINDA General\Test folder Excel import\Excel test file for import new tableheading 1.reqifz
17:33:00 INFO:Open ReglF files closed.

17:30:54 INFO:Prepare compare; update grid information

17:30:54 INFO:Prepare compare; update grid information

17:30:54 INFO:Content information parsed

17:30:54 INFO:Header information parsed

17:30:54 INFO-File 'C:\l Isars\Malinda\AnnDatall acal\Temn\RenMaerae\Clnne\Evral tact fila far imnart new tahleheading 1 renif’ ic Inadad

Copyright REQTEAM GmbH 2022 HTML Validation: On

Open files on each side then select the attributes that needs to be merged and
press Merge menu item in the top menu. The merge options will be displayed.



& MergeForm - O >

Specification: ReqEdit document - 2021-05-04T10_20_38

Specffication: ReqEdit document - 2021-05-04T10_20_38
ID:{_e2b212h-67e3-48d-9035-22bd12114de )

ID:{_e2b212b-67e3-4f8d-3035-22bd 12114de7)

Attribute Set:
|D:(_61d0dbaffch-48bb-ade3-05371ebcd3b)

Attribute Set:
1D:(_61ddbaffcb-48bb-ade 3-0537 1ebedi3b)

Attribute: Comment
Attribute-Type: ¥html

Attribute: Comment
Attribute-Type: ¥html

Menge direction LEFT_TO_RIGHT ~ Mr. objects to menge: 11 of 12

[] Force Update

oK Cancel

ReqgEdit merge add-on displayin the options window and the merge details

Merge direction: left to right or right to left, depending on which side of the wizard
window are the new and old files

Force update: copies also the empty values from source

After the merge the attributes will be highlighted with green, repeat the merge process
for other attributes as well

@ Compare and Merge AddOn T a X

Compare Merge Administration  Help

import\Excel test file for import new tableheading.reqifz D = Close port\Excel test file for import new tableheadinlg 1.remfz] I[L—{II Close
-

={JSheet1 Type - Attribute(s):19
(JReqEdit.ExcelRowRefence [Integer]
[JHierarchy identificator [Integer]
(Junique identificator [Integer]
[CJObject identificator [Xhtmi]
(CJReqIF.ChapterName [Xhtmli]
@ ReglF.Text [Xhtml]
[JName [xhtml]
[JComment [Xhtml]
(JFormula [Xhtml]
[Creqedit identificator [Integer]
(OModified On [Date]
[JModified By [Xhtml]
(JForeign deleted [Boolean]
() Customer status [Xhtml]
() Supplier status [Xhtml]
(JProduct variant [Xhtml]
[ e T P 1

P R

={JSheet1 Type -- Attribute(s):19
[JReqEdit.ExcelRowRefence [Integer]
[JHierarchy identificator [Integer]
[CJunique identificator [Integer]
[CJObject identificator [Xhtml]
(CJReqIF.ChapterName [Xhtmi]
@ ReqlF.Text [Xhtml]
(JName [xhtmi]
(JComment [Xhtml]
(JFormula [Xhtml]
(JJreqedit identificator [Integer)
(OModified On [Date)
(OModified By [xhtml]
(JForeign deleted [Boolean]
(Jcustomer status [Xhtml]
() supplier status [Xhtml]
(JProduct variant [Xhtml]
[ 1 Yy 7 S | |

17:39:17 DEBUG:Skip setting atribute for spec object _4b63013-381f-43d5-994b-46282242669f because the values are identical
17:39:17 DEBUG: Skip setting atribute for spec object _997a772-f198-4deb-96¢2-59754b231703 because the values are identical

17:39:17 DEBUG:Skip setting atribute for spec object

aceb336-95ac-4ec9-a010-d73e0d12dcb7 because the values are identical

17:39:16 DEBUG:Skip setting atribute for spec object _fa327ca-3e85-45c1-b4ad-fdd00a0dc612 because the values are identical
17:39:16 DEBUG:Skip setting atribute for spec object _d6a5352-09de-40fa-8841-53b47cc51832 because the values are identical
17:39:16 DEBUG: Skip setting atribute for spec object _ed9dc4d-10f6-4693-aba7-b77fd74b6ece because the values are identical
17:39:16 DEBUG:Skip setting atribute for spec object _9e4ce90-107b-4333-3a91-120cf7e8229f because the values are identical

Copyright REQTEAM GmbH 2022

Save the merge results

HTML Validation: On

Clicking the SAVE icon next to the file location will write the merged content into that file,
depending on the direction of the merge.




Data management

All files generated by the tool can be managed from the Administration menu.

() Compare and Merge AddOn

Compare  Merge | Administration | Help

’ y Settings

Open Logs
Open HTML reports

Clean HTML reports

Cleanup temp files

Compare and Merge AddOn Administration menu

Open Logs — will show the daily logs folder

Open HTML reports — will show the folder of the comparison results
Cleanup HTML reports — will delete all the comparison results
Cleanup temp files — will delete all generated files

Merge Limitations

e Only spec objects with the same ID can be merged
e Only the same type of attributes can be merged
o Opened files are exclusively locked until closed (no other app can open the files)

Logging

The application will produce a debug log containing all the performed actions Log is
saved in daily files.

Contents of log files

e Opening files
e Errors
o Attribute type mismatches
o No matches found
o No attributes selected
e Compare statistics
e Merge execution with details
o Updated values
o Skip merging causes
= identical values
= empty values



Requirement Templates

Templates for Requirement Engineering

RegEdit offers templates for different use cases between customer and supplier
according to Prostep ivip Recommendations. Please keep in mind that only ReqlF
Archives (.reqifz) supports imagesf/file attachments.

To open a template click File / New Archive ... You can select from different templates.
Template prostep ivip - All attributes

You can use this template in relation with your suppliers for request clarification for a
single product variant use case.

........

Template prostep ivip - All attributes

The template includes the necessary attributes, as

Customer status, with the options Not To Evaluate / To Evaluate / Accepted / Not
accepted / To be clarified / Proposed to discard / Discarded.

Supplier status, with the options Agreed / Not Agreed / Agreed with comment/ To be
clarified / Discard Deployed.

The attributes of this specification documents are:



https://www.prostep.org/fileadmin/downloads/Recommendation_ReqIF_V2.1_final.pdf
https://www.prostep.org/fileadmin/downloads/Recommendation_ReqIF_V2.1_final.pdf

Attibute Types  Atributes  Document  Links

Long Name Custom Type Data Type Last Change Is editable
= ReglF.ChapterName Text XHTML 15.04.2022 4
@ ReqgIlF.Name Text XHTML 15.04.2022 4
=l ReqlFText Text XHTML 15.04.2022 &
Internal Comment Text XHTML 15.04.2022 &
=i RegEditiD Integer INTEGER 15.04.2022 =)
= ReqEditModifiedOn Date DATE 15.04.2022 (=]
& ReqgEditModifiedBy String STRING 15.04.2022 =]
= ReqlF.ForeignDeleted Boolean BOOLEAN 15.04.2022 ©
ENUMERATION
ReqIF-WF.Type Type MULTIVALUED: FALSE 15.04.2022 4
ReqgIF-WF.Revision String STRING 15.04.2022 4
ENUMERATION
ReqIF-WF.CustomerStatus CustomerStatus MULTIVALUED: FALSE 15.04.2022 4
. . ENUMERATION
ReqIF-WF.SupplierStatus SupplierStatus MULTIVALUED: FALSE 15.04.2022 4
ReqIF-WF.CustomerComment Text XHTML 15.04.2022 &
ReqIF-WF.SupplierComment Text XHTML 15.04.2022 4
ReqIF-WF.ProductVariant ProductVariant ERUMERAHON 15.04.2022 &

MULTIVALUED: FALSE

Attributes added in the template prostep ivip - All attributes

Template prostep ivip - with Product variant

This template helps tracking the statuses of requests if there are more product variants.

The attributes Customer status and Supplier status have the same values as in case of
template Template prostep ivip - All attributes.
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Attibute Types  Aftributes  Document  Links

Long Name Custom Type Data Type Last Change Is editable
= ReqglIF.ChapterName Text XHTML 15.04.2022 4
@ ReqglF.Name Text XHTML 15.04.2022 4
l?i] ReqlF.Text Text XHTML 15.04.2022 4
Internal Comment Text XHTML 15.04.2022 &
&l ReqEditID Integer INTEGER 15.04.2022 (=]
&l ReqgEditModifiedOn Date DATE 15.04.2022 &
&l ReqEditModifiedBy String STRING 15.04.2022 (=]
&l ReqlIFForeignDeleted Boolean BOOLEAN 15.04.2022 (=]
ENUMERATION
ReqlF-WFEType Type MULTIVALUED: FALSE 15.04.2022 Y 4
ENUMERATION
ReqlF-WF.CustomerS... CustomerStatus MULTIVALUED: FALSE 15.04.2022 4
. - ENUMERATION
ReqlIF-WF.SupplierSta... SupplierStatus MULTIVALUED: FALSE 15.04.2022 4
ReqlF-WF.CustomerC... Text XHTML 15.04.2022 4
ReqlF-WFE.SupplierCo... Text XHTML 15.04.2022 4
ReqIF-WF.ProductVari... ProductVariant ENUMERATION 15.04.2022 &

MULTIVALUED: FALSE

Attributes added in the template prostep ivip - with Product variant

Template prostep ivip - with Revision

This template includes an attribute Revision, for use cases where they are needed. The
attributes Customer status and Supplier status have the same values as in case of
template Template prostep ivip - All attributes.
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Attibute Types  Aftributes  Document  Links

Long Name Custom Type Data Type Last Change Is editable
= RegIF.ChapterName Text XHTML 15.04.2022 4
C-i] ReqglF.Name Text XHTML 15.04.2022 4
@ ReqlFText Text XHTML 15.04.2022 4
Internal Comment Text XHTML 15.04.2022 4
=i RegEditID Integer INTEGER 15.04.2022 e
= RegEditModifiedon Date DATE 15.04.2022 =]
&l ReqEditModifiedBy String STRING 15.04.2022 (=]
=Y ReglF.ForeignDeleted Boolean BOOLEAN 15.04.2022 =]
ENUMERATION
ReqlF-WFEType Type MULTIVALUED: 15.04.2022 Y 4
FALSE
ReqIF-WF.Revision String STRING 15.04.2022 4
ENUMERATION
ReqlF-WF.CustomerStatus CustomerStatus MULTIVALUED: 15.04.2022 4
FALSE
ENUMERATION
ReqgIF-WF.SupplierStatus SupplierStatus MULTIVALUED: 15.04.2022 4
FALSE
ReqlF-WF.CustomerComment Text XHTML 15.04.2022 4
ReqIF-WF.SupplierComment Text XHTML 15.04.2022 &

Attributes added in template prostep ivip - with Revision

Template prostep ivip - simple

This template includes only the main attributes of a requirement document. The
attributes Customer status and Supplier status have the same values as in case of
template Template prostep ivip - All attributes. Attributes as Revision or Product variant
are not included.
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Attribute Types  Attributes  Document  Links

[ Long Name Custom Type Data Type Last Change Is editable
7@ RegIF.Name Text XHTML 15.04.2022 4
= ReqIFText Text XHTML 15.04.2022 &
~ Internal Comment  Text XHTML 15.04.2022 &
= RegEditiD Integer INTEGER 15.04.2022 &
El RegEditModifiedOn  Date DATE 15.04.2022 ©
= RegEditModifiedBy  Sting  STRING 15042022 @
=l RegIFForeignDelet... Boolean BOOLEAN 15.04.2022 &
RegIF-WF.Type Type R by 15.04.2022 &
RegIF-WF.Custome... CustomerStatus B 15.04.2022 &
ReqlF-WFE.Supplier... SupplierStatus EATJLE‘IMI[\E/RAﬁLIgg FALSE 15.04.2022 4
_ ReqIF-WF.Custome... Text XHTML 15.04.2022 ¥
ReqlF-WFE.Supplier... Text XHTML 15.04.2022 4

Attributes added in template prostep ivip - simple

Agile templates

We recommend to use ReqlFz (archive) for the following templates. You can add each
of the templates to a single Archive with File / Add -> New document to the current
file. So it's possible to link user stories, bugs and test cases and add images/ file
attachments.

Scrum - Backlog

This template can be used to have a list of the client's requirements. You can write
epics, user stories, or just mark text as information or heading (in the Type column).
Different colors for each status help visually the user. Each requirement can have
different status: New / Draft / Final / In Progress / Obsolete / Implemented /
Duplicate. The template includes also "Business Value" and "Definition of

Done" Columns.

@ Scrum - Backlog il - Raqkdt Client Utivate - o x

File Edn Ve

: : ] @ s-<4n e e %N Voo [ 40 stributes (System)|*] 6 i 6
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Y &
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{og documentat.
Template for Backlog documentation
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1 - Backlog

Tha program should start on windows Naw

A3 3 user of the program [ want to be able to start the program on Windaws 10. UserStory  Draft

Template Scrum - Backlog



Scrum - Buglist

This template collects and lists the bugs reported by users / customers / internal
stakeholders. The user of the template can set in the Type column Bug / Heading /
Information. The column Status can be set as New / Open / In implementation / Solved /
Not Fixed. The Column Scope can be set as Installer / GUI / Business logic / Plugins.
There are two additional attributes to add the sprint number/iteration, when a bug is
fixed, and also a Bug identifier.

@ Scrum - Buglistregf - ReqEde Chent Utimate
fle ESt View Settngs Addons  Help
BeUB % 2 [B] 8- o = Views [AR awibutes Gytem) 158 5 o 52
@ Backiog - Scrum - Backkog.re X ® Bughst - Scrum - Buglist.regi. x Test - Sorum - Tast.reqgif x|
a Main Column Description ReqEID  Type Status Scope  Internal Commanks Bug Identiher  Fixad in Sprit
emplate for BuglstTemplate d
1 - Buglist

Aate for Buglist

ription you can find at
tiori.reqream comre

1 - Buglist

2 Heading

This is a generic kst of all bugs 4 Information

The program does not show current date, John
3 B Qpen Gul th

Template Scrum - Backlog

Scrum Test

This template can be used for test documentation. The column Type can set texts as
Heading / Information / Test Suite / Test Case / Test step. The Column Status sets as
New / Draft / Final / Obsolete / Duplicate. The template includes place for Test
description and Expected results.

@ Scrum - Testreqif - RegEdit Client Ultimate

Fle  Edit Setfings  Add-ons  Help
v S 2 s [B]: 8- & = & [ Views: [ Al sttributes (System) |7 rz o= fow
@ Backlog - Scrum - Backlog.re,.. X | @ Bughst - Scrum - Buglistregi.. X © Test - Scrum - Testreqi x
2 Main Column Expected result Test Description Type Status

plate for Test documenta

- Template for Test documentation
1 - Test Program s

1.1 - GUI tests Template description you can find at bitps://documentation reqteam.comirequirement-templates

1 - Test Program

Heading
1.1 - GUI tests
These tests are designed for all the GUI elements of our program Information
Test Help menu
Open programm Test Step
Click on "Help” menu Test Step
Close program Test Step

Template Scrum - Test

RegXML to ReqlF



Simplified XML format for generating ReqlF files with RegEdit. The XML schema defines
that all XML tags MUST be UPPERCASE and all HTML tags MUST be lowercase.

ReqXML Format

The namespace defined for RegXML is http://www.reqteam.com/reqedit/data-
exchange .

Example of a RegXML file

<EXCHANGE-DATA xmlns="http://www.regteam.com/regedit/data-
exchange" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://www.regteam.com/regedit/data-exchange
file:///D:/Work/ReqEdit/RifSchemas/regedit xml/regedit xml.xsd">
<METADATA>
<DOCUMENT-TYPES>...</DOCUMENT-TYPES>

<ITEM-TYPES> ... </ITEM-TYPES>

</METADATA>
<DOCUMENTS>
<DOCUMENT>

</DOCUMENT>

</DOCUMENTS>
</EXCHANGE-DATA>

Document types - Defines attribute sets for requirement documents
Item types - Defines attribute sets for the requirement objects inside the document.

NOTE: only one item type is supported for one document (multi item type
documents are not supported)

Type definition

<ITEM-TYPE>

<ID> a23fe234-236f-45e5-b321-2342117348</1D>

<NAME>All attributes</NAME>

<ATTRIBUTES>
<ATTRIBUTE-STRING>

<NAME>RequirementsID</NAME>

</ATTRIBUTE-STRING>
<ATTRIBUTE-XHTML>

<NAME>ChapterName</NAME>
<BASETYPE>
<ID> 8a711c80-1594-48ba-b850-

4855a768e5b3</ID>
<NAME>HTML-TEXT2</NAME>
</BASETYPE>
</ATTRIBUTE-XHTML>




<ATTRIBUTE-ENUM>
<ID> 7e9%9ac904-9c20-4a97-8d73-

535cd189212e</1D>
<NAME>ObjectType</NAME>
<MULTIVALUE>false</MULTIVALUE>
<VALUES>
<VALUE ID=" 7e9ac904-9c20-4a97-8d73-
535cd189212e-Heading">Heading</VALUE>
<VALUE ID=" 7e9ac904-9c20-4a97-8d73-
535cd189212e-Information">Information</VALUE>
<VALUE ID=" 7e9ac904-9c20-4a97-8d73-
535cd189212e-Requirement">Requirement</VALUE>
</VALUES>
</ATTRIBUTE-ENUM>
</ATTRIBUTES>

In the example we defined:

e string attribute with name: RequirementID, For a single import is this enough.

e XHTML attribute with name: ChapterName.

e Single Enum attribute with name: ObjectType with values: Heading, Information,
Requirement

Document structure

One file can contain multiple documents. Each of the documents must have a reference
to the attribute set, which defines the attributes of the document itself. Even if there are
no attributes a document type reference needs to be done. Additionally, a NAME need
to be defined.

<DOCUMENTS>
<DOCUMENT>
<ID>_3_f7eO655f—2099—40fe—bfbc—08346abda405</ID>
<PARENT> 1 f7e0655£-2099-40fe-bfbc-
08346abda405</PARENT>
<NAME>FOO0O</NAME >
<DOCUMENT-TYPE-REF> a23fe234-236f-45e5-b321-
document</DOCUMENT-TYPE-REF>
<ITEMS>
<ITEM>
<ITEM-TYPE-REF> a23fe234-236f-45e5-b321-
2342117348</ITEM-TYPE-REF>
<ATTRIBUTES>
<ATTRIBUTE>
<NAME>ChapterName</NAME>
<VALUE>
<diwv
xmlns="http://www.w3.0rg/1999/xhtml">First main
chapter.<em>ss</em></div>

</VALUE>
</ATTRIBUTE>
</ATTRIBUTES>




</ITEM>

</ITEMS>
</DOCUMENT>

</DOCUMENTS>

Each of the items need to have a reference to an item type which determines the
attributes can be used in this requirement and an unique ID for later trace or structure
references . To define the attribute reference, use the NAME tag and to set the value the
VALUE tag, except the enum attributes.

Enum values always needs to be inside VALUES tag. Even if the Enum is single valued.
<VALUES><VALUE>Heading</VALUE></VALUES>

To build up a tree structure inside the document, it is possible to define parent items (tag
PARENT). The value of the tag is the unique ID of the parent item/requirement.

Attribute Types

To define an attribute, you must define a name (NAME tag). Optional you can define an
unique ID (ID tag) and a default value (DEFAULT tag). The IDs need to be unique in the
complete document and need to be of type XSD:ID (https://www.data2type.de/xml-xslt-

xslfo/xml-schema/datentypen-referenz/xs-id/)

Attribute types allowed in RegXML

Type XML Tag Notes
Boolean ATTRIBUTE-
BOOLEAN
i Optionally
Integer ﬁ\\IT_I:I';CI;I?ELéTE Minimum (Tag MIN)
Maximum (Tag MAX)
Real ATTRIBUTE-REAL
Date format:
Date ATTRIBUTE-DATE 2020-07-23723:59:59
, ATTRIBUTE- . . .
String STRING Text without any formatting or line breaks
XHTML ATTRIBUTE-XHTML |Supports line breaks, formatting or attachments
Enumeration | ATTRIBUTE-ENUM Multivalued Enums (Tag MULTIVALUE with
value true / false)

Each attribute needs to refer to a predefined attribute type. For enumerations the valid
valued need to be defined

<ATTRIBUTE-ENUM>


https://www.data2type.de/xml-xslt-xslfo/xml-schema/datentypen-referenz/xs-id/
https://www.data2type.de/xml-xslt-xslfo/xml-schema/datentypen-referenz/xs-id/

<ID> 7e9ac904-9c20-4a97-8d73-535cd189212e</ID>
<NAME>ObjectType</NAME>
<MULTIVALUE>false</MULTIVALUE>

<VALUES>

<VALUE ID=" 7e9ac904-9c20-4a97-8d73-535cd1l89212e-
Heading">Heading</VALUE>

<VALUE ID=" 7e9ac904-9c20-4a97-8d73-535cd189212e-
Information">Information</VALUE>
<VALUE ID=" 7e9ac904-9c20-4a97-8d73-535cdl89212e-
Requirement">Requirement</VALUE>
</VALUES>
</ATTRIBUTE-ENUM>

XHTML Attributes

For formatted content please use attributes of type XHTML. All content MUST be
wrapped in a div tag

<div xmlns="http://www.w3.0rg/1999/xhtml">My formatted ...

content</div>

NOTE: The div wrapping is necessary to be able to validate the XHTML content
internally.

Limitations

Please keep in mind, that RegXML is only a preformat for the ReqlF, which does not
allow all tags from XHTML. So RegXML allows only tags which are valid in ReglF, too.
So please use only the basic formatting tags (like cite, em, strong, sup, sub ..) and the
predefined heading tags (h1..h6). You can use XHTML Tables and list elements (Tags
OL and UL) as well.

In a requirement document the requirements will be linked completely, and not only
some words (like in XHTML with the A tag). Please use for tracing definition the link tag
of RegXML to reference between requirements (artefacts)

If you want to reference to external files, please do it only with the tag OBJECT and not
with IMG (which is not allowed). Attachments of a single document should be placed in a
definite subfolder (which is named like the document itself or its ID).

<object data="./attachments/Anschreiben.docx" type="application/word">
<object data="./attachments/Anschreiben.png" type="image/png">this is an
alternative text</object></object>

It is recommended to create for each of the attached files a small preview, so the
requirements engineer could have a quick impression about the content inside the file.
Previews has to have PNG format!

For more advanced users, which are already experience with XML Schema the list of
valid tags can be traced down in the XML Schema file located at ReqEdit in the



folder <<PATH to REQEDIT>>ReqEdit\RifSchemas\reqif\driver.xsd and referenced

schema files inside.

Relevant ReqlF attribute naming

If you want to use your data in Requirement Management systems or want to have a
correctly display the data in ReqEdit, please use the following naming conventions:

Attribute Name Type Description

ReqlF.ChapterName XHTML Requirements heading
ReqlF.Name XHTML Short description

ReqlF.Text XHTML Requirements text
ReqlF.ForeignDeleted BOOLEAN |Display this item as deleted if set to true
Reqlf.ForeignID INTEGER |[ID given by the source RM system
ReqlF.ForeignCreatedBy STRING |User that created this item
ReqlF.ForeignCreatedOn DATE Date the item was created
ReqlF.ForeignModifiedBy STRING |User last modified the item
LAST-CHANGE attribute of item|DATE Modification date of the item
ReqlF.ChapterNumber STRING | The chapter number

Best practices

o Please avoid defining a heading and requirements text in one item/requirement.

e Use only headings as structuring element, if its possible

o Please use long IDs (preferred UUIDs) for the unique IDs, so the chance is low to
have the same ID for two elements in your complete project.

o Don'’t use the same attribute names inside the same type definition

o Don'’t use the same value inside the same Enum definition

IBM specific SAME-AS mapping

DOORS Next support the possibility to define different attributes for different documents,
but the meaning of the attribute is identic. To avoid creating multiple instances of the
same attribute it is possible to determine a SAME-AS tag with an URL content, that says
to DNG not to create the attribute multiple times. This definition needs to be done in the
document types or item types definition of the specific attribute

<ATTRIBUTE-DATE>

<NAME>LastModified</NAME>

<SAME-AS>http://purl.org/dc/terms/modified</SAME-AS>
</ATTRIBUTE-DATE>

Updates



If you plan multiple imports of the same document for updates, it is recommended to fix
down the Attribute Ids and the referred base type. These values will be stored in the RM
system (like DOORS or Polarion) and could be later updated easily. To do so, please
define for each of the attributes a unique ID.

For Enum values (Tags VALUES) please define the valid values (Tag VALUE). The
definition of unique IDs is only necessary if you plan an update import.

Traces

It is possible to define links between the different items (not necessarily in the same
document, but in the same file). The block LINKS should follow the ATTRIBUTES tag
inside the item/requirement.

<LINKS>
<LINK-TYPE NAME="verification">
<LINK TARGET="abc" DOCUMENT-REF="REQ-g23" />
<LINK TARGET="def" DOCUMENT-REF="REQ-g23" />

</LINK-TYPE>
<LINK-TYPE NAME="satisfies">
<LINK TARGET="abcd" />
</LINK-TYPE>
</LINKS>

The reference to the document is not necessary, if the ID can be identified in the file.
The attribute TARGET holds the unique ID of the target item. The Attribute
DOCUMENT-REF is the unique ID of the document, where the item ID should be in.

Encrypt /Decrypt files

The En-/Decrypt file feature encrypts files with password. The Encrypt function supports
the following encryption formats:

File
Encrypt method extension |Encryption characteristics
type
AES-256 - WinZip and .regenc the password is re-hashed multiple times
7zip compatible
Zin compatible reqzi password is not hashed, so it could be opened
P b -reqzip in windows with the correct password

Encryption method types

Encrypt a file by SAVE AS



File name: | Test document Specifications_imported.reqenc

Save as type: |ReqEdit Encrypted File (*.reqenc, *.reqzip)

Archive ReqlF files (*.reqifz, *.zip)

~ Hide Folders

Save as window type selector displaying RegEdit Encrypted File

First open the file you want to be encrypted. To encrypt a file choose File/Save as ...
menu. Select RegEdit Encrypted File (*reqenc, *.regzip) as file type then click SAVE.

A window appears to set the password for encryption. Password has to be minimum 6

characters.

i € Encrypt File

Enter Password: Reenter Password:

------------

"] Show Password

Encryption method
Zip AES-256 v |  7zip/WinZip compatible
: Password is hashed
| [Zp

Thales/AES - Password hash is derived with PBKDF2 multiple times
File is packaged 2 times intemally to hide original filename

File Encrypt pop-up window

The encrypted file is saved in the given folder.

Decrypt a file by OPEN

To decrypt a file, open ReqEdit and from the File / Open menu select the encrypted file
with the extensions: *.regenc, *.reqzip and click Open



| €N Decrypt File X

Password

() Show password

Security Info

The file will be decrypted and opened

All changes will be done on the decrypted file

To encrypt a file: SAVE changes, then SAVE AS encrypted

Open | Cancel

Decrypt File pop-up window

A pop up window appears, where you can fill in the password given during the
encryption process. Then click Open. A confirmation message appears and after clicking
on OK the file opens.

Batch Mode Automatization
RegEdit can be used without GUI in a command line to import or export ReqlF files.
Batch mode functionality:

e Import RIF1.1a to ReqlF

e Export ReglF to RIF1.1a

e Import from MS Word (.docx) to ReqlF
e REQXML to ReqlF, read the xml format specification

Examples

Import from a RIF11a to a ReqlF file

RegEdit.exe -batch -in "D:\Workplace\Input
Folder\requirements.zip" -out "D:\Workplace\Output Folder" -

mapping "D:\ Workplace\RifToRegif.txt" -jobid "001" -logfile
"D:\Workplace\Log.txt"

Export from a ReglF to a RIF11a file

RegEdit.exe -batch —-in "D:\Workplace\Input
Folder\requirements.regifz" -out "D:\Workplace\Output Folder" -
mapping "D:\ Workplace\ReqifToRif.txt" -jobid "002" -outtype

RIFlla -logfile "D:\Workplace\Log.txt"



https://documentation.reqteam.com/reqxml-to-reqif/

RegEdit

.exe —-batch -in "D:\Workplace\Input

Folder\requirements.regifz" -out "D:\Workplace\Output Folder"

jobid "003" -outtype REQIFDNG -logfile "D:\Workplace\Log.txt"

Import from a Word .docx to a ReqlF file

RegEdit

.exe -batch -in "D:\Workplace\Input

Folder\requirements.docx" -out "D:\Workplace\Output Folder" -

mapping

"D:\ Workplace\WordToReqif.txt" -jobid "004" -logfile

"D:\Workplace\Log.txt" —-keephierarchy =
removechapternumberings —-tables —-attachments —-images
attributetable row

Import from REQXML to ReqlF file, read more here: REQXML format

RegEdit.

exe —-batch -in "D:\Workplace\Input

Folder\requirements.regxml"

-out "D:

\Workplace\Output Folder" -jobid "003"

-mapping "D:\ Workplace\RegXmltoRegIF.txt" -logfile
"D:\Workplace\Log.txt"

Parameters

General batch parameters

_batch mandatory
enable batch mode without displaying GUI
in mandatory
indicates the input file
-out mandatory
indicates the output folder
optional
- used only for ReqlF~RIF conversions
mapping |if a mapping is not specified, the default mapping of the system attributes is
used
optional
-jobid sets a custom prefix for the output file
if not set, the output file will have a datetime prefix
optional
Jogfile indicate the absolute path to the user desired logfile

if the logfile already exists, the new information will be appended
if not specified, the logs will be written to the standard RegEdit log

ReqlIF and RIF import/export parameters

outtype

indicate the output type
possible values are "RIF11a", "REQIF" or "REQIFDNG" for Rational DOORS
Next Generation compatible files
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Word import parameters

optional

will recreate the parent/child hierarchy in the Word file
based on Heading levels. If not enabled, all Headings
will be displayed on the first level

-keephierarchy

- optional
removechapternumberings |removes manual chapter numberings
optional
-tables all tables will be converted to a ReqlF compatible

(HTML) table, else all tables in the file will be ignored

optional

embedded objects (Word (rtf, doc, docx), Excel (xIs,
xlsx), Powerpoint (ppt, pptx)) in the Word document will
be imported to ReglFz file and referenced inside the
ReqlF object, else all objects in the Word file will be
ignored

-attachments

optional

embedded images (JPG, PNG, BMP) in the Word
-images document will be imported to ReqlFz file and referenced
inside the ReglF object, else all images in the Word file
will be ignored

optional

possible values “row” or “column”

the word document parser will look in the first
row/column of all tables for the values given in the
mapping file to assert if the table should be treated as an
attribute table

-attributetable

NOTE: Parameter values which contain empty spaces or special characters like
slash, backslash and others, need to be written between quotes

Mapping file
The mapping files are used to translate attribute names from RIF to ReqlF standard and
vice-versa. The mapping file is a simple .txt file with the format shown below in two

examples with IBM DOORS system attribute names and two custom attributes displayed
with red text.

Example of a RifToReqif mapping file

Absolute Number - ReqglIF.ForeignID
Created By - ReglF.ForeignCreatedBy
Created On - ReqgIF.ForeignCreatedOn
Created Thru - ReqgIF.ForeignCreatedThru

Last Modified By - ReqglF.ForeignModifiedBy
Object Heading - ReqgIF.ChapterName

Object Number - ReqIF.ChapterNumber

Object Short Text - ReqlF.Name




Object Text - ReqglF.Text
Description - ReqgIlF.Description

Customer Description - Supplier Description
Customer Status - Supplier Status

Example of a ReqifToRif mapping file

ReglF.ForeignID - Absolute Number
ReqglF.ForeignCreatedBy - Created By
ReglIF.ForeignCreatedOn - Created On
RegIF.ForeignCreatedThru - Created Thru
ReglF.ForeignModifiedBy - Last Modified By
RegIF.ChapterName - Object Heading
RegIF.ChapterNumber - Object Number
RegIF.Name - Object Short Text

ReglIF.Text - Object Text

RegIF.Description - Description

Supplier Description - Customer Description
Supplier Status - Customer Status

Example of a WordToReqif mapping file

RegIF.ForeignID integer
RegIF.ChapterName text
ReqgIF.Text text
Customer Desc Supplier Descr text
Release Date Release Date date: dd.MM.yyyy
Price Price real:

Example of a REQXML to ReqlF mapping file

Last Modified By - ReqIF.ForeignModifiedBy
Object Heading - ReqgIF.ChapterName
Object Number - ReqglIF.ChapterNumber

Object Short Text - ReqglF.Name

Object Text - ReqglF.Text

Customer Description - Supplier Description
Customer Status - Supplier Status

REQXML

This is a simplified custom XML format to speed up data exchange to ReqlF format.
Read here the REQXML documentation.

Output files
If the target type is ReqlF or ReqglF DNG, there will be only one output file (reqif or reqifz)

If the target type is single Spec RIF, there will be only one output file (xml or zip)
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If the target type is multi Spec RIF, there will be one output file for each Specification
(xml or zip); the file names will contain the names of the specifications

Logging

For each batch operation, an entry will be added to the logfile. Each entry will contain
the date and time of the operation, the input and output file(s) path and names, the
output file(s) type and the job ID.

If an error occurs during the operation, the report will include an exit code and message.
You can see the complete list of exit codes and messages below.

General Exit Codes

5 [Batch Feature ID is missing

10| Error during Conversion

20 | Mandatory Parameter "batch" is missing

21|Mandatory Parameter "in" is missing

22 |Mandatory Parameter "out" is missing

23 |Invalid output type value

24|Job id can not be empty

25| Has invalid parameter

26 [ Incompatible output type value

Input File Related Exit Codes

110|Input File is not readable or does not exist

120 | Input File has not defined type (Autodetection fails)

130 | Input File is not valid (Schema validation fails)

Output File Related Exit Codes

210|Not enough space in output folder (3*size of input file required to be free)

220 | Outputfolder is not writable

240 [ Output folder does not exist

Mapping File Related Exit Codes

310|Mapping file does not exist or is not readable




320 | Mapping file has wrong format

Log File Related Exit Codes

410|Access denied; Cannot create not existing log file on creation mode

411 | Access denied; Cannot write to existing log file on update mode

RegEdit supply chain

Use ReqEdit in your supply-chain to minimize data loss and risk factors. Give your
suppliers the possibility to use ReqlF requirements with our software.

Manufacturer Supplier
ALM System ALM System
o A A o 9 5
D Requirements Admins 'I] Requirements Admins
Export Data Import Data Import Data
o o
(J Internal Engineer {J Supplier engineer
Stable regs.
Merge back
supplier feedback .
Complete Review Requirements Save and Return
Requirements Comments ReqlF Just save changes
ReqlF q and return the reqif

Evaluation status

Internal changes
needs supplier
re-evaluation

Rebranded
Validate Data Merge .
Quality check Comments, updates O ?ocrr;?]t:’l;"F:TSqun
Create View Prepare Data

Limited view for Lock fields, filtering Handout -
i Requirements
SIS NN - E gl
review package >

=5 Ultimate Comment
Validate

2022 @ REQTEAM GmbH

ReqEdit Supply Chain solution package including ReqEdit Ultimate on the Manufacturer side and ReqEdit Supplier edition on the
Supplier side, diagram illustrates the data exchange between the participants with recommended actions

The package
ReqEdit Ultimate
Starting from 5 network licenses

Internal use within the company

All add-ons are included



RegEdit Supplier edition
Unlimited licenses
External use by suppliers

Can only fill in specific data

RegEdit supplier edition

ReqEdit can be branded and distributed to suppliers. Licensing terms and conditions can
be configured to accommodate different use cases.

Branding

The main content area of the application can display your logo image, and on the bottom
license area the company name can also be included.

€ ReqEdit Client - a
File Edit View Settings Add-ons Help
i & :

Cache size: 0 MB HTML Validation: Off Licensed for:l

ReqEdit branding areas highlighted

Licensing

Whitelabeling uses only a time limited license without locking to a specific machine.
Specific license text can be included to represent the usage terms and conditions for the
supplier.



Promoting ReqlF format

As your company grows and the requirements are more and more sophisticated,
lossless data transfers are a key factor to minimize communication errors and production
delays.

Some of the benefits of using ReqlF format include:

Structured data

Lossless data exchange

Traceability

Lossless data round trips between tools

Suppliers can participate in this data exchange easily by offering ReqEdit to them.
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